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Chapter 1. IBM Campaign overview

IBM® Campaign is a web-based Enterprise Marketing Management (EMM) solution
that enables you to design, run, and analyze direct marketing campaigns.

Marketing professionals typically use Campaign in the following ways:
v Administrators perform initial and ongoing tasks such as adjusting configuration

settings, mapping database tables, and defining custom attributes and offer
templates.

v Users create and run direct marketing campaigns.

To conduct a marketing campaign, you start by defining offers for various target
audiences. You then build a flowchart, which provides a visual representation of
the campaign logic. Part of building a flowchart involves associating offers with
target audiences.

As you design your campaigns, you can access, merge, and manipulate data from
multiple sources, including relational databases and flat files. For example, you can
select contact data from a database, merge it with customer data from a flat file,
then suppress, segment, and sample the data. To access and manipulate data,
Campaign supports the use of raw SQL, macros, and functions. However, you do
not need to know SQL to use Campaign.

After you build a flowchart and assign offers to various segments, you run the
flowchart to generate a list of contacts. To control the timing of your marketing
campaigns, you can schedule different campaigns to run at various times.

During the course of a campaign, contact history and response history are stored.
Campaign uses this history to track and analyze campaign results, so you can
refine your campaigns over time.

IBM Campaign consists of a back-end server and a web application server, plus
security, authentication, and authorization that are supplied by IBM Marketing
Platform.

Note: IBM Marketing Platform provides a common access point and user interface
for Campaign and other IBM EMM applications, plus features related to security
and configuration.

IBM Campaign concepts
There are several basic concepts that can help you understand how to use IBM
Campaign to create and manage marketing campaigns.

Campaigns

Each marketing campaign is defined by a business objective, a corporate-defined
initiative specific to your marketing plan, and a date range during which the
campaign is effective. For example, you could create a retention campaign to
deliver an offer to customers who otherwise might be lost through attrition.

© Copyright IBM Corp. 1998, 2013 1



Flowcharts

Every marketing campaign consists of one or more flowcharts. For example, a
marketing campaign might consist of a flowchart that provides offers to selected
customers and another flowchart to track responses to the offers, for reporting and
analysis.

Each flowchart makes use of one or more data sources. A data source contains
information about your customers, prospects, or products, for use in marketing
campaigns. For example, a flowchart can pull contact names and addresses from
one database and pull opt-out information from another source.

A flowchart performs a sequence of actions on your marketing data. To define the
actions, you use building blocks called processes, which you connect and configure.
These processes make up the flowchart.

To implement your campaign, you run the flowcharts. You can run each flowchart
manually, by a scheduler, or in response to some defined trigger.

Licensed users of Interact can use IBM Campaign to run real-time interactive
flowcharts that depend on the occurrence of an event. For more information on
interactive flowcharts, see the Interact User’s Guide.

Processes

Each flowchart is made up of processes, or process boxes, that are configured and
connected to perform specific tasks in a campaign or session. For example, a Select
process can select customers who you want to target, and a Merge process can
combine two distinct audience groups.

You configure and connect processes in each flowchart to achieve specific
marketing goals. For example, a flowchart can consist of processes that select
qualified recipients for a direct mail campaign, assign various offers to recipients,
then generate a mailing list. Another flowchart can track respondents to your
campaign, so you can calculate your return on investment.

Sessions

Sessions provide a way to create persistent, global data artifacts for use in all
campaigns. Each session contains at least one flowchart. Running a session
flowchart makes the outcome of the session (the data artifacts) available globally to
all campaigns.

A typical use for a session flowchart is to create strategic segments, which are
segments that can be used in multiple campaigns. For example, you can create
strategic segments for opt-ins or opt-outs, then use those segments in various
marketing campaigns.

Offers

An offer represents a single marketing message, which can be delivered in a
variety of ways. Offers are re-usable:
v in different campaigns
v at different points in time
v for different groups of people (cells) in a flowchart
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v as different "versions" (by varying the offer's parameterized attributes)

You can assign offers to target cells in flowcharts using one of the contact
processes, such as Mail List or Call List. You can track the campaign results by
capturing data about customers who received the offer and those who responded.

Cells

A cell is a list of identifiers, such as customer or prospect IDs, from your database.
You create cells by configuring and running data manipulation processes in
flowcharts. For example, a Select process can generate an output cell consisting of
males between the ages of 25 and 34.

An output cell can be used as input for other processes in the same flowchart. For
example, two Select processes can select customers from different data sources. A
downstream Merge process can then combine the results.

A cells that has an offer assigned to it is called a target cell. A target cell is a group
of homogeneous individuals, as defined by the audience level, such as individual
customers or household accounts.

For example, cells can be created for high-value customers, customers who prefer
to shop on the web, accounts with on-time payments, customers who opted to
receive email communications, or loyal repeat buyers. Each cell that you create can
be treated differently, receiving different offers or communications through
different channels.

Cells that contain IDs who are qualified to receive an offer but who are excluded
from receiving the offer for analysis purposes are called control cells. In IBM
Campaign, controls are always hold-out controls.

Getting started with IBM Campaign
Before meaningful work can be done in Campaign, some initial configuration is
required. Database tables must be mapped, data objects such as segments,
dimensions, or cubes might need to be created, and individual campaigns must be
planned and designed.

Typically, these tasks are completed with the help of an IBM consultant. After the
initial work is done, you can design and run additional campaigns yourself and
you can refine, expand, and build on initial campaigns as needed.

For information about initial and ongoing configuration and administration, see the
Campaign Installation Guide and the Campaign Administrator's Guide.

Your username and password
To access Campaign, you must have a username and password combination that
has been created for you in Marketing Platform, and also be authorized to access
Campaign.

If you do not have a valid username and password, contact your system
administrator.
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Your role and permissions
Your user name in Campaign is associated with one or more roles, such as
Reviewer, Designer, and Manager. Your administrators define roles specific to your
organization. Your roles determine the functions that you can perform in
Campaign. The object-level security implemented by your organization determines
whether you can perform those functions on specific objects. If you need to access
objects or perform tasks that your permissions do not allow, contact your system
administrator.

Security levels in Campaign
In Campaign, security settings control your ability to access functions and the
objects with which you can work.

Security in Campaign works on two levels.
v Functional - Determines the actions that you can perform on types of objects,

based on the roles that you belong to. Your organization defines these roles at
implementation. Each role has a set of permissions that are associated with it
that determine what actions a user who belongs to that role can perform. For
example, if you are a user assigned a role that is called "Administrator", you
might have permissions to map and delete system tables. If you are a user
assigned a role that is called "Reviewer", you might be denied permissions to
map and delete system tables.

v Object - Defines the object types on which you can perform your allowed
actions. In other words, even if you belong to a role that has general permissions
to edit campaigns, object-level security for Campaign can be set up so that you
cannot access campaigns that are in particular folders. For example, if you
belong to Division A, regardless of your functional roles, you can be disallowed
from accessing the contents of folders that belong to Division B.

Logging in to IBM EMM
Use this procedure to log in to IBM EMM.

Before you begin

You need the following.
v An intranet (network) connection to access your IBM EMM server.
v A supported browser installed on your computer.
v User name and password to sign in to IBM EMM.
v The URL to access IBM EMM on your network.

The URL is:

http://host.domain.com:port/unica

where

host is the machine where Marketing Platform is installed.

domain.com is the domain in which the host machine resides

port is the port number on which Marketing Platform application server is
listening.
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Note: The following procedure assumes you are logging in with an account that
has Admin access to Marketing Platform.

Procedure

Access the IBM EMM URL using your browser.
v If IBM EMM is configured to integrate with Windows Active Directory or with a

web access control platform, and you are logged in to that system, you see the
default dashboard page. Your login is complete.

v If you see the login screen, log in using the default administrator credentials. In
a single-partition environment, use asm_admin with password as the password. In
a multi-partition environment, use platform_admin with password as the
password.
A prompt asks you to change the password. You can enter the existing
password, but for good security you should choose a new one.

v If IBM EMM is configured to use SSL, you may be prompted to accept a digital
security certificate the first time you sign in. Click Yes to accept the certificate.

If your login is successful, IBM EMM displays the default dashboard page.

Results

With the default permissions assigned to Marketing Platform administrator
accounts, you can administer user accounts and security using the options listed
under the Settings menu. To perform the highest level administration tasks for
IBM EMM dashboards, you must log in as platform_admin.

To set your start page
The start page is the page that displays when you log in to IBM EMM. The default
start page is the default dashboard, but you can easily specify a different start
page.

If you do not want a dashboard page to display when you first log in to IBM
EMM, you can select a page from one of the installed IBM products as your start
page.

To set a page you are viewing as your start page, select Settings > Set current
page as home. Pages available for selection as a start page are determined by each
IBM EMM product and by your permissions in IBM EMM.

On any page you are viewing, if the Set current page as home option is enabled,
you can set the page as your start page.

IBM Campaign documentation roadmap
IBM Campaign provides documentation and help for users, administrators, and
developers.

Table 1. Get up and running

Task Documentation

View a list of new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign database IBM Campaign System Tables and Data Dictionary
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Table 1. Get up and running (continued)

Task Documentation

Install or upgrade Campaign and deploy the Campaign
web application

One of the following guides:

v IBM Campaign Installation Guide

v IBM Campaign Upgrade Guide

Implement eMessage, if you purchased eMessage v The IBM Campaign Installation and Upgrade guides
explain how to install and prepare eMessage
components in the local environment.

v The IBM eMessage Startup and Administrator's Guide
explains how to connect to the hosted messaging
resources.

Implement the IBM Cognos® reports provided with
Campaign

IBM EMM Reports Installation and Configuration Guide

Table 2. Configure and use Campaign

Task Documentation

v Adjust configuration and security settings

v Prepare Campaign for users

v Run utilities and perform maintenance

v Integrate Campaign with Digital Analytics

IBM Campaign Administrator's Guide

v Create and deploy marketing campaigns

v Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance
IBM Campaign Tuning Guide

Use Campaign macros IBM Macros for IBM EMM User's Guide

Table 3. Integrate Campaign with other products

Task Documentation

Configure eMessage offer integration. IBM Campaign Administrator's Guide

Integrate and use Campaign with Digital Analytics IBM Campaign Administrator's Guide

Integrate and use Campaign with IBM SPSS® Modeler
Advantage Marketing Edition

IBM Campaign and IBM SPSS Modeler Advantage Marketing
Edition Integration Guide

Integrate and use Campaign with Marketing Operations IBM Marketing Operations and IBM Campaign Integration
Guide

Table 4. Develop for Campaign

Task Documentation

Develop custom procedures with the API v IBM Campaign Offer API Specification

v JavaDocs in devkits\CampaignServicesAPI

Develop Java™ plug-ins or command-line executables to
add validation to Campaign

v IBM Campaign Validation PDK Guide

v JavaDocs in devkits\validation
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Table 5. Get help

Task Instructions

Open online help 1. Choose Help > Help for this page to open a
context-sensitive help topic.

2. Click the Show Navigation icon in the help window
to display the full help.

Obtain PDFs Use either of the following methods:

v Choose Help > Product Documentation to access
Campaign PDFs.

v Choose Help > All IBM EMM Suite Documentation
to access all available documentation.

v Access all documentation during the installation
process from the IBM EMM installer.

Get support Go to http://www.ibm.com/ and click Support &
downloads to access the IBM Support Portal.

Chapter 1. IBM Campaign overview 7

http://www.ibm.com/


8 IBM Campaign: User's Guide



Chapter 2. IBM Campaign integration with other IBM products

IBM Campaign optionally integrates with a number of other IBM EMM products.

For more information, see the documentation included with these applications:
v IBM Contact Optimization: Optimize contacts from a customer-centric

perspective while considering business rules and constraints.
v IBM Digital Analytics and IBM Digital Analytics for On Premises: Use web

analytics segments in IBM Campaign flowcharts.
v IBM Distributed Marketing: Support distributed, custom execution of centrally

managed campaigns.
v IBM eMessage: Construct targeted, measurable email marketing campaigns.
v IBM Interact: Retrieve personalized offers and customer profile information in

real-time to enrich the interactive experience.
v IBM Interaction History and IBM Attribution Modeler: Deliver unique insights

into cross-channel communications and customer activity by combining data
from various sources (online as well as offline) into a single repository.

v IBM Marketing Operations: Integrate the marketing resource management
features of Marketing Operations with the campaign development features of
Campaign.

v IBM SPSS Modeler Advantage Marketing Edition: Provide an automated
predictive modeling solution for database marketers.

IBM Marketing Platform provides security as well as a common access point and
user interface for Campaign and other IBM EMM applications.

IBM Cognos provides the framework for the IBM Report Packs that are provided
for various IBM EMM products.

Overview of eMessage offer integration with IBM Campaign
If your Campaign administrator enabled eMessage offer integration, Campaign
offers can be associated with eMessage assets.

When offer integration is configured:
v Cross-channel marketers can create and use the same marketing offers on

multiple channels to measure the effectiveness of offers across channels. For
example, compare email to direct mail.

v The Campaign performance reports show the sum of all contacts or responders
over all channels that were used. You can customize the reports to break out the
information by channel.

v The Campaign Detailed Offer Response Breakout report analyzes eMessage link
clicks that are associated with offers. This report lists all offers associated with a
campaign and the number of responses for each channel.

When offer integration is configured, the basic workflow for eMessage users is:
1. Use Campaign to create offer attributes, offer templates, and offers, as you

normally would, with the following exceptions:
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v Offer lists are not supported because only one offer can be associated with a
digital asset.

v You cannot use Derived Fields in eMessage offer attributes because you
cannot populate Derived Fields in eMessage. However, you can use Derived
Fields on an offer if you also target that offer over another channel.

v You can populate parameterized offer attributes with a constant value.
However, you cannot use Derived Fields for the email channel and you
cannot change values per recipient.

2. Use eMessage as you normally would, with one addition: You must associate a
Campaign offer with a digital asset in the eMessage Content Library.

3. Add the asset and its associated offer to an email communication.
4. If you want to modify the offer, open the offer Summary page in Campaign.

Click Link to IBM eMessage Digital Asset at the top of the offer Summary
page to see a list of eMessage assets that are related to the offer. Double-click
an asset to open it in the eMessage Content Library.

5. Send the mailing.
Recipients open the email and click the offer links.
eMessage receives the responses and processes them using a configurable ETL
process so that they end up in the Campaign database.
Campaign checks for updated offer and contact data at intervals that are
scheduled by your Campaign administrator. The offer and contact information
is then processed by Campaign and moved to the appropriate report tables.

6. Use the eMessage reports as you normally would. Additionally, use the
Campaign Detailed Offer Response Breakout report to analyze responses to
your offers.

The eMessage offer integration depends on an ETL process to coordinate offer and
response information between eMessage and Campaign:
v To configure Campaign for eMessage offer integration, see the Campaign

Administrator's Guide.
v To use eMessage, see the IBM eMessage User's Guide.
Related tasks:
“Viewing and editing eMessage assets that are linked to a Campaign offer” on
page 128

Overview of IBM SPSS Modeler Advantage Marketing Edition
integration with IBM Campaign

When you use IBM Campaign and IBM SPSS Modeler Advantage Marketing
Edition in an integrated environment, you can perform modeling and scoring
within your IBM Campaign flowchart.

When you create a model in IBM SPSS Modeler Advantage Marketing Edition, you
generate a modeling stream (.str file) that you can use in an IBM Campaign
flowchart. The flowchart defines your campaign logic. You can then use one or
more models to score your target audience for the campaign. You can access IBM
SPSS Modeler Advantage Marketing Edition directly from an IBM Campaign
flowchart, so you can create, edit, and select models while you are designing a
marketing campaign. You can also set up flowcharts to automate model updates
and batch scoring.
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Changes from IBM PredictiveInsight

If you previously used IBM PredictiveInsight, you will no longer be able to use the
legacy Model and Score process boxes, even in existing flowcharts. The legacy
Model and Score process boxes are unconfigured when you install IBM Campaign.
You must manually recreate the predictive models either using IBM SPSS Modeler
Advantage Marketing Edition or using the SPSS Model process box.
v Any occurrences of the Model process box must be deleted and replaced with

the SPSS Model process box.
v Any occurrences of the Score process box must be deleted and replaced with the

SPSS Score process box.

For more information, see the IBM Campaign and IBM SPSS Modeler Advantage
Marketing Edition Integration Guide.

Overview of IBM Marketing Operations integration with IBM Campaign
Campaign can be integrated with Marketing Operations to use its marketing
resource management features to create, plan, and approve campaigns.

When Campaign is integrated with Marketing Operations, many of the tasks that
were previously done in a stand-alone Campaign environment are done in
Marketing Operations. You do the following Campaign tasks in Marketing
Operations when the products are integrated.
v Working with campaigns:

– Creating campaigns
– Viewing campaigns
– Deleting campaigns
– Working with campaign summary details

v Working with Target Cell Spreadsheets
v Assigning offers to cells
v Specifying control cells
v Creating and populating custom campaign attributes
v Creating and populating custom cell attributes

These tasks are explained in the Marketing Operations and Campaign Integration
Guide.

The following tasks are done in Campaign in both stand-alone and integrated
environments:
v Creating flowcharts
v Running flowcharts
v Detailed analysis of campaigns/offers/cells
v Reporting on Campaign performance (depending on the reporting pack

installed)

If offer integration is also enabled, you do the following tasks in Marketing
Operations:
v Designing offers

– Defining offer attributes
– Creating offer templates
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v Creating, approving, publishing, editing, and retiring offers
v Organizing offers into offer lists and offer folders

About legacy campaigns
Legacy campaigns are campaigns that were created in Campaign (or Affinium
Campaign 7.x) before enabling integration between Marketing Operations and
Campaign. In an integrated environment, Campaign can be configured to access
the following types of legacy campaigns:
v Campaigns that were created in stand-alone Campaign (whether in the current

or a previous version of Campaign) before integration was enabled. These
campaigns cannot be linked to Marketing Operations projects.

v Campaigns that were created in Affinium Campaign 7.x and linked to Affinium
Plan 7.x projects. Functionality of these campaigns remains unchanged from
version 7.x of these products, based on the data mapping between attributes in
both products.

You can use Campaign to access and work with both types of legacy campaigns,
even after integration is enabled.
Related tasks:
“Navigating from a linked legacy campaign to a Marketing Operations project” on
page 23

Offer management in integrated Marketing
Operations-Campaign systems

If your IBM Campaign environment is integrated with IBM Marketing Operations,
you work with offers in one of two ways.
v If your system is configured so that offers are managed by Marketing

Operations, then you use the Offers option from the Operations menu. For
information about creating offers in this way, see the IBM Marketing Operations
and IBM Campaign Integration Guide.

v If your system is configured so that offers are managed through Campaign, then
you use the Offers option from the Campaign menu.

Ask your system administrator which offer management option is configured on
your system.

Introduction to using IBM Digital Analytics data in marketing
campaigns

If you have IBM Digital Analytics, you can define segments based on visit and
view level criteria. If you integrate IBM Digital Analytics with IBM Campaign,
those segments can be made available to Campaign for use in flowcharts.

You can then use Campaign to target those segments in marketing campaigns. This
"online segmentation" functionality provides an automated way to incorporate IBM
Digital Analytics data into your campaigns.

Campaign users who purchase and configure both eMessage and the post-click
analytics tools can also make use of IBM Digital Analytics segments. The optional
post-click analysis tools track customer behavior from the click-through of an email
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or hosted landing page and subsequent navigation through the web site (within
the same visit or session) to browse or buy. Campaign designers can use the
analytics to determine how to create follow-up campaigns.

Note: eMessage requires separate integration steps. See the documentation
provided with eMessage.
v Configuring the integration is explained in the Campaign Administrator's Guide.
v Using IBM Digital Analytics-defined segments in Campaign is explained in

“Targeting IBM Digital Analytics segments in campaigns” on page 58.
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Chapter 3. Campaign management

You can create, view, edit, delete, organize, and perform similar operations on
marketing campaigns. Each campaign is defined by its business objective,
initiative, and effective date range. A campaign always consists of at least one
flowchart, where you select recipients and assign offers.

For example, you might have a flowchart that identifies a list of prospects who
will receive one or more offers. When you run the flowchart, you generate a list of
contacts (for example, a mailing list) and the information is recorded in contact
history.

A typical campaign also has a separate flowchart that tracks responses to the
campaign. After the campaign runs, you create or update the response flowchart to
record and analyze responses to your offers.

You can add more flowcharts to a campaign as you analyze and refine your
results. More complex campaigns may consist of multiple flowcharts to manage
multiple offer streams.

Note: If Campaign is integrated with Marketing Operations, you use campaign
projects in Marketing Operations to work with campaigns. If your integrated
system is configured to access legacy campaigns, you can open them by choosing
Campaign > Campaigns and clicking the Campaign Projects folder. Legacy
campaigns are campaigns that were created in IBM Campaign before the
integration was enabled. For more information, see “Overview of IBM Marketing
Operations integration with IBM Campaign” on page 11.

Working with campaigns requires the appropriate permissions. For information
about permissions, see the Campaign Administrator's Guide.
Related tasks:
“Creating campaigns” on page 19
“Editing campaigns” on page 19

Before you begin creating campaigns
Before you begin using IBM Campaign to create marketing campaigns, there are
some important initial tasks. Some of these initial tasks, such as creating offer
templates, typically are done by administrators.

One of the most important initial tasks is to make information about your
customers and products available to Campaign. To access your user data,
Campaign needs to know which tables or files in your data source to use. To make
your data available for use in Campaign, your company's database tables and files
must be mapped into Campaign. An administrator typically performs this step. An
administrator also creates offer templates, strategic segments, and other data
objects for use in campaigns. For more information, see the Campaign
Administrator's Guide.
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After the initial objects are created and tables are mapped, you can begin creating
marketing campaigns.

Often, the first step is to design the campaign on paper or in IBM Marketing
Operations so you can determine your workflow. Identify your campaign goals,
decide what offers to make, which customers to include or exclude, and whether to
use control groups. After this initial design, you can use Campaign to create
marketing campaigns to accomplish your objectives.

Each marketing campaign is made up of one or more flowcharts. Each flowchart
performs a sequence of actions on your customer data. A flowchart consists of
interconnected process boxes, which you configure to perform the actual data
selection, manipulation, and response tracking that is required for your campaign.
Each process box performs a specific action, such as selecting customers,
segmenting them, merging data, or generating a mail list or a call list. By
configuring and connecting process boxes in a flowchart, you determine the logic
of your campaign.

Offers are created outside of a flowchart, and are assigned when you configure a
contact process box, such as a Mail List or Call List, in a flowchart. Offers can also
be assigned on the target cell spreadsheet (TCS), which provides a visual matrix of
segments and offers.

You use Campaign to define offers. You then create a flowchart where you select
customers or prospects to be contacted, assign offers to your selections, and
generate a list of contacts. When customers respond, you can use a separate
flowchart to track the campaign results.

For an example of two flowcharts that were designed for a retention campaign
using multiple channels to deliver an offer, see “Example: Multi-channel retention
campaign.”

Example: Multi-channel retention campaign
This example shows two flowcharts that were designed for a marketing campaign.

This retention campaign uses multiple channels to deliver an offer to customers
who otherwise might be lost through attrition. Two flowcharts are used:
v A contact flowchart generates lists of customers to whom the offer will be sent,

using a different channel for each segment.
v A response flowchart will track responses to the offer and make the response

data available for reporting and analysis.

Contact flowchart

This example shows a sample retention campaign contact flowchart. This flowchart
selects the eligible customers in each value segment and outputs contact lists for a
different channel for each segment.
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In the first level of the flowchart, Select processes are used to select customers in
the Gold and Platinum segments, as well as customers who opted out of
marketing communications.

In the second level, a Merge process combines the Gold and Platinum customers
and excludes customers who opted out.

Next, a Segment process divides all of the eligible customers into value tiers based
on their scores.

Finally, each customer is assigned to a list. The high-value customers are output to
a call list, so they can be contacted with the offer by phone. The medium-value
customers are output to a mail list ; they will receive a direct mail offer. The lowest
value customers will receive the offer by email.

Response flowchart

A second flowchart in this same campaign tracks responses to the direct mail,
email, and telephone offers captured by the call center and response capture
systems. The response information is compiled outside of the Campaign
application. For example, a call center might record responses in a database or flat
file. When the response information is made available to Campaign, your response
flowchart can then query the data.

The following example shows the retention campaign's response tracking
flowchart. The Response process box evaluates which responses are considered
valid, and how they are credited back to campaigns or offers. The output of the
Response process is written to several response history system tables, where the
data can be accessed for analysis using Campaign performance and profitability
reports.
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Accessing campaigns
Access marketing campaigns to view or edit them, depending on what your
permissions allow. The way that you access campaigns differs, depending on
whether Campaign is integrated with Marketing Operations.

Procedure
1. Choose Campaign > Campaigns to open the All Campaigns page.

The information on the All Campaigns page depends on how your
environment is configured.

2. Perform one of the following actions:
v For a stand-alone Campaign environment: The All Campaigns page lists all

campaigns and campaign folders for which you have at least read access.
Click the name of any campaign to open it.

v For an integrated Marketing Operations-Campaign environment: Click the
link for the Campaign Projects folder to access campaign projects that were
created in Marketing Operations. Campaigns that were created through
Marketing Operations are always accessed through campaign projects, unless
they are legacy campaigns.
The available projects depend on the default project view that is set in
Marketing Operations. You can configure this view to display all campaign
projects if wanted.

Note: The Campaign Projects folder cannot be deleted, moved, or copied.
v For an integrated Marketing Operations-Campaign environment with

access to legacy campaigns enabled: The All Campaigns page displays legacy
campaigns, which were created before the environment was integrated. Click
the name of any legacy campaign to open it. You can also use the Campaign
Projects folder link to access campaigns created through Marketing
Operations.

What to do next
v For information about campaign projects, see the IBM Marketing Operations and

IBM Campaign Integration Guide.
v For information about project views, see the IBM Marketing Operations User's

Guide.
v For information about legacy campaigns, see “About legacy campaigns” on page

12.
v For information about configuring Campaign to enable access to legacy

campaigns, see the upgrade documentation.
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Creating campaigns
Follow these instructions to create a campaign. Each marketing campaign has a
business objective, a corporate-defined initiative specific to your marketing plan,
and a date range during which the campaign is effective.

About this task

Note: If Campaign is integrated with Marketing Operations, you create campaigns
from the Operations > Projects menu. See the Marketing Operations
documentation for more information.

Procedure
1. Select Campaign > Campaigns.

The All Campaigns page displays the folders or campaigns in the current
partition.

2. Click the Add a Campaign icon .
3. Complete the Campaign Summary fields on the New Campaign page. Choose

Help > Help for this page to see explanations of each field.
4. Do one of the following actions.

v Click Save and Finish to save the campaign without adding a flowchart yet.
Use this approach if you want to do other initial steps before you create
flowcharts. For example, you can create and associate offers and strategic
segments with a campaign before you create flowcharts.

v Click Save and Add a Flowchart to immediately start creating a flowchart
for the campaign.

Related concepts:
Chapter 3, “Campaign management,” on page 15

Editing campaigns
Users with appropriate permissions can use the Campaign Summary page to edit a
campaign's details and access its flowcharts, reports, and target cell spreadsheet.
Additionally, if you have the appropriate permissions, you can perform actions
such as adding flowcharts, segments, or offers to a campaign.

Procedure
1. Choose Campaign > Campaigns.
2. On the All Campaigns page, click the name of a campaign.

The campaign opens to its Summary tab.
Alternatively, click the Edit a tab icon next to the campaign name to open a
specific tab for editing.

3. Choose Help > Help for this page to see explanations of each field on the
Summary tab.

4. You can perform many actions from the Campaign Summary page.

v To edit details about the campaign, click the Edit Summary icon in the
toolbar, and then click the Save and Finish button when you are done.
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v To add a flowchart to the campaign, click the Add a Flowchart icon
in the toolbar.

v To add or remove segments or offers, use the appropriate icons in the
toolbar.

v To edit a flowchart, click a flowchart tab and then click the Edit icon
on that tab.

v To edit the campaign's Target Cell Spreadsheet, click the Target Cells tab

then click the Edit icon .
v To access reports, click the Analysis tab.

Related concepts:
Chapter 3, “Campaign management,” on page 15

Organizing campaigns in folders
Folders provide a way to keep your campaigns organized. You can create folders
and move campaigns from one folder to another.

About this task

Folder names have character restrictions. See Appendix A, “Special characters in
IBM Campaign object names,” on page 233.

Follow the steps below to organize campaigns in folders.

Procedure
1. Choose Campaign > Campaigns.
2. Use the All Campaigns page to do any of the following operations.

Option Description

Add a folder at the top level
Click the Add a Subfolder icon .

Add a subfolder Select a folder, then click the Add a

Subfolder icon .

Edit a folder name or description Select a folder, then click the Rename icon

.

Move a folder Select a folder, select the check box next to
the folder that you want to move, then click

the Move icon .

Move a campaign Select the check box next to the campaign
that you want to move, then click the Move

icon .
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Option Description

Delete an empty folder Select the check box next to any folders that
you want to delete, click the Delete Selected

icon , then confirm the deletion.

Printing campaigns
You can print any page in a campaign by using the Print icon.

Procedure
1. Choose Campaign > Campaigns.
2. Select the tab for the campaign that you want to print.

3. Click the Print icon .

Deleting campaigns
When you delete a campaign, the campaign and all flowchart files are deleted. If
you want to keep portions of the campaign for reuse, save them as stored objects
(templates) before you delete the campaign. If you delete a campaign with
associated contact or response history records, all of the corresponding contact and
response history records are deleted.

About this task

Important: Do not delete the campaign if you want to retain the associated contact
and response history.

Procedure
1. Choose Campaign > Campaigns and locate the campaign that you want to

delete.
2. Select the check box next to the campaign that you want to delete.

3. Click the Delete this item icon .

Important: If you attempt to delete a campaign that has contact or response
history records, a warning message indicates that all corresponding contact and
response history records will be deleted. If you want to retain the
corresponding contact and response history, click Cancel.

4. Click OK to permanently delete the campaign.

Results

The selected campaign is deleted.

Note: You can also delete a campaign while you view the campaign by clicking
the Delete icon.
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How to use control groups to measure campaign results
You can purposely exclude a random sample of prospects or customers from a
marketing campaign to ensure that they do not receive the offer. After the
campaign runs, you can compare the activity of the control group against those
who received the offer, to determine the effectiveness of your campaign.

Controls are applied at the cell level. Cells that contain IDs which you purposely
exclude for analysis purposes are called control cells. When you assign offers to
cells, either in a contact process in a flowchart or in a target cell spreadsheet (TCS),
you can optionally specify one control cell for each target cell.

In Campaign, controls are always hold-out controls. In other words, they are not
contacted with an offer, even though they qualify for the offer. Contacts who
belong to control cells are not assigned any offers and are not included in contact
process output lists. Holdouts ("no-contacts") do not receive communications, but
are measured against the target group for comparison.

Campaign provides the following methods for working with control groups:
v To create control groups, use the Sample process. The Sample process provides

several options for excluding IDs (Random, Every Other X, Sequential Portions).
v To exclude control groups from offers, configure a Mail List or Call List process

in a flowchart. When you configure the process to assign offers to cells, you can
optionally exclude control groups from contact.

v If you work with a target cell spreadsheet (TCS), you can use the Control Cell
and Control Cell Code columns to identify control cells. Cells that are
designated as controls cannot be assigned offers.

v The contact history tables are populated when you run the flowchart in
production mode. The contact history identifies the members of control cells and
the offers that were withheld (not sent to controls). This information allows for
analysis and comparison of the target versus control cell for lift and ROI
calculations.

v Use the Response process in a flowchart to track control group responses
simultaneously with offer responses.

v The Campaign Performance and Offer Performance reports indicate the lift, or
difference, in response from an active target cell that received an offer.

When you plan an offer, consider whether you want to use holdout control groups
for cells that are assigned the offer. Control groups are a powerful analysis tool for
measuring campaign effectiveness.

Association of control cells to target cells
A single control cell can be used as the control for multiple target cells. However,
each target cell can have only a single control cell, where the cell is defined by its
cellID.

When a single control cell is used in multiple contact processes, you must
configure the control cell relationship for the target cell the same way in each
contact process.
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Navigating from a linked legacy campaign to a Marketing Operations
project

Legacy campaigns are campaigns that were created in IBM Campaign before
enabling integration with IBM Marketing Operations.

About this task

Follow this procedure if you are using an integrated system and you want to
access campaigns that were created prior to the integration.

Procedure
1. Select Campaign > Campaigns.

The All Campaigns page opens, displaying the folders or campaigns in the
current partition. Only legacy campaigns are listed.
To view campaigns created with the Marketing Operations-Campaign
integration enabled, click the Campaign projects folder. If there are no legacy
campaigns or legacy campaigns have not been enabled in the configuration,
this page is empty.

2. Click the name of the campaign that you previously linked to a project in
Marketing Operations or Affinium Plan.
The campaign opens to its Summary tab.

3. Click the name of the project in the Parent Items and Code field.
Marketing Operations opens, and displays the Summary tab of the linked
project.

4. To return to Campaign, click the name of the project in the Supporting Projects
and Requests field in Marketing Operations.

Related concepts:
“About legacy campaigns” on page 12
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Chapter 4. Flowchart management

IBM Campaign uses flowcharts to define campaign logic. Each flowchart in a
campaign performs a sequence of actions on data that is stored in your customer
databases or flat files.

Each marketing campaign consists of at least one flowchart. Each flowchart
consists of at least one process. You configure and then connect processes to
perform data manipulation, create contact lists, and record contact and response
tracking for your campaign.

By connecting a series of processes in a flowchart, then running that flowchart, you
define and implement your campaign.

For example, a flowchart might include a Select process, which is connected to a
Segment process, which is connected to a Call List process. The Select process can
be configured to select all customers from your database who live in the northeast.
The Segment process can segment those customers into value tiers, such as Gold,
Silver, Bronze. The Call List process assigns offers, generates a contact list for a
telemarketing campaign, and records the results in the contact history.

Note: To work with flowcharts, you must have the appropriate permissions
assigned by an administrator.

Flowchart workspace overview
The flowchart workspace provides the tools and space to design flowcharts for
marketing campaigns.

When you create or edit a flowchart, a separate flowchart window opens. You can
move or resize the flowchart window as you work.

You can open just one flowchart at a time. If you attempt to open another
flowchart while one is already open, you are prompted to save your changes. To
open two flowcharts at the same time, see “Viewing two flowcharts side-by-side”
on page 35.

Note: Pop-up blockers prevent the flowchart window from opening. Be sure to
turn off any pop-up blockers in your browser or browser add-ons.

The following figure shows a flowchart open for editing in the flowchart window.

The flowchart window consists of the following elements.
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Table 6. Flowchart window elements

Element Description

Toolbar The toolbar provides menus and options to work with flowcharts. For example:

v Click Fit Contents to resize the flowchart to fit in the workspace.

v Use the Zoom icons to zoom in and out.

v Search for a process by entering any portion of the name in the Search Process Name field.

v Save your flowchart frequently by clicking Save Changes and Continue to Edit .

v When you are done, click Save and Exit .

Rest your cursor over each icon to see what it does.

For related information, see “Adjusting flowchart appearance.”

Palette The palette at the left side of the window contains processes that you use to build your
flowchart. Drag a process from the palette to the workspace, then configure and connect
processes in the workspace.

By default, all process types are displayed. Use the category buttons (List generation,
Segmentation, Response tracking, Data preparation) to view a subset of processes by category.

Workspace The workspace is where you configure and connect processes to determine the workflow and
behavior of the flowchart.

To configure a process, double-click it.

To connect one process to another, rest the cursor over a process box until four arrows display,
then drag a connection arrow to another process box.

Right-click any process box to open a menu of options.

Right-click the workspace to see more options.

Use the panning area (the small area in the lower right corner of the workspace) to highlight the
portion of the flowchart that you want to see. This visual representation of the workspace is
useful when not all of the process boxes fit on the screen at the same time.

Related concepts:
Appendix A, “Special characters in IBM Campaign object names,” on page 233
Related tasks:
“Creating flowcharts” on page 28

Adjusting flowchart appearance
You can adjust the position and alignment of process boxes to improve the
appearance of the flowchart. All of these changes are visual. They do not affect the
flow of data. The direction of the connection lines between processes determines
the data flow.

Before you begin

This procedure assumes that you have a flowchart open for editing.
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About this task

Follow these steps to adjust the appearance of a flowchart.

Procedure

1. To reposition all processes in a flowchart, click the Change Layout icon
and select an option.
v Tree: Organizes process boxes in a tree format. Useful when each process box

has a single input.
v Organization Chart: Organizes simple flowcharts and is effective for

flowcharts with a single input from the top.
v Circular: Arranges process boxes in a radial fashion. Useful for single

connection-based flowcharts that lead to one output.
v Hierarchical: Organizes process boxes in horizontal or vertical levels so that

most links flow uniformly in the same direction. This layout often provides
the most simple and visually straightforward choice.

2. To reposition all process boxes to a horizontal or vertical layout:
a. Right-click the flowchart workspace.
b. Choose View > Horizontal / Vertical or click the Horizontal / Vertical icon

in the toolbar.
If this option causes connection lines to overlap, choose View > Angled
Connections twice to redraw the connection lines properly.

3. To align two or more process boxes, drag a selection box around at least two
processes, then use the alignment icons in the flowchart toolbar.

v To align boxes in a row: Use the Align Top icon , the Align Bottom icon

, or the Align Center (Vertical) icon .

v To align boxes in a column: Use the Align Left icon , the Align Right

icon , or the Align Center (Horizontal) icon .
If you choose an incorrect alignment, select an option from the Change Layout
menu to restore the layout. In many cases, the Hierarchical layout fixes
overlapping process boxes.
You can also select an individual process box and drag it to a new location.

Process overview
Campaign processes are the building blocks of flowcharts. The processes are visible
on the flowchart process palette at the left of the workspace.

To create a flowchart, you move process boxes from the palette to the flowchart
workspace. In the workspace, you configure and connect process boxes to build
your flowchart. Typically, each process in a flowchart takes one or more cells as
input, transforms the data, and produces one or more cells as output. A cell is a list
of identifiers of marketing message recipients, such as customer or prospect IDs.

By configuring each process, then connecting it to a subsequent process, you can
achieve the results that you want.

For example, you can use the Select process to select customers and prospects from
a database or flat file. The output of a Select process is a cell, which you can use as
input into a subsequent process. Therefore, in your flowchart you can connect the
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Select process to a Merge process to remove opt-outs from the list of IDs. Then,
you can Segment the merged list and use the Call List process to assign offers and
generate a list of contacts.

Creating flowcharts
Follow these instructions to add a flowchart to a marketing campaign. A flowchart
determines the campaign logic.

About this task

You can add a flowchart to your campaign either by creating a new one or copying
an existing one. Another way to create flowcharts is to use the template library to
save and then reuse common campaign logic and process box sequences. For more
information, read about templates. The procedure that follows explains how to
create a new flowchart.

Note: If you are creating an interactive flowchart, see the IBM Interact
documentation for information.

Procedure
1. In the campaign or session to which you want to add a flowchart, click the

Add a Flowchart icon .
The Flowchart Properties page opens.

2. Enter a name and description for the flowchart.

Note: Under Flowchart Type, Standard Batch Flowchart is the only option
unless you are a licensed user of Interact. If you installed a licensed version of
Interact, you can also select Interactive Flowchart.

3. Click Save and Edit Flowchart.
The flowchart opens in a new window, which includes the process palette on
the left, a toolbar at the top, and a blank flowchart workspace.

4. Add a process to your flowchart by dragging a process box from the palette to
the workspace.
A flowchart typically begins with one or more Select or Audience processes to
define the customers or other marketable entities with which to work.

5. Double-click a process in the workspace to configure it.

Important: Click Save Changes and Continue to Edit frequently while you
add and configure processes.

6. Connect the configured processes to determine the workflow of your campaign.
7. Click Save and Exit to close the flowchart window.
Related concepts:
“Flowchart workspace overview” on page 25
Appendix A, “Special characters in IBM Campaign object names,” on page 233
Related reference:
“List of Campaign processes” on page 47
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Flowchart design considerations
Be aware of the following considerations when you create flowcharts.
v Avoid cyclical dependencies. Be careful not to create cyclical dependencies

among processes. Consider this example of a cyclical dependency: (a) Your
flowchart contains a Select process whose output provides input to a Create Seg
process. (b) The Create Seg process generates a strategic segment as its output.
(c) You use that segment as input to the Select process. This situation results in
an error when you try to run the process.

v Applying global suppressions. If your organization uses the global suppression
feature, it is possible that a particular set of IDs might be automatically excluded
from use in target cells and campaigns. The flowchart log file indicates whether
global suppression is applied.

Test runs for flowcharts
You can conduct a test run on a flowchart or branch if you do not want to output
data or update any tables or files.

When you conduct a test run on a flowchart or a branch, be aware of the
following.
v Triggers run on completion of both test and production runs.
v Global suppression is applied when testing processes, branches, or flowcharts.
v The option Advanced Settings > Test Run Settings > Enable Output determines

whether output is generated during test runs.

Conduct test runs on processes and branches as you are building flowcharts, so
that you can troubleshoot errors as they occur. Remember to save each flowchart
before you run or test it.

Testing a flowchart
When you test a flowchart, data is not written to any tables. You can then view a
report of any errors in the flowchart.

Before you begin

Always save an edited flowchart before you test it.

Procedure
1. Open a flowchart in Edit mode.

2. Open the Run menu and select Test Run Flowchart.
The flowchart runs in test mode, so data is not written to any tables.
Each process displays a check mark if it runs successfully. If there are errors,
the process displays a red "X".

3. Use one of the Save options in the toolbar.
If you click Save and Exit before the flowchart finishes the test run, the
flowchart continues to run and is saved when it finishes. If anyone reopens the
flowchart while it is still running, any changes made to the flowchart are lost.
For this reason, always save a flowchart before you run it.
To pause the run, right-click the process box and select Run > Pause This.
To stop the run, right-click the process box and select Run > Stop This.
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4. To determine if there were any errors in the flowchart run, click the Analysis
tab and view the Campaign Flowchart Status Summary report.

Testing a flowchart branch
When you test a flowchart branch, data is not written to any tables. If the run
detects errors, you can correct any processes that have errors.

Procedure
1. On a flowchart page in Edit mode, click a process on the branch you want to

test.

2. Open the Run menu and select Test Run Selected Branch.

Results

The flowchart runs in test mode. Data is not written to any tables.

Each process that runs successfully displays a green check mark. If there are errors,
the process displays a red "X".

Flowchart validation
You can use the Validate Flowchart feature to check the validity of a flowchart at
any time except when the flowchart is running.

Validation performs the following checks for a flowchart:
v Processes in the flowchart are configured.
v Cell codes are unique in the flowchart, if the AllowDuplicateCellCodes

configuration parameter is set to No. If this parameter is set to Yes, duplicate
cell codes in flowcharts are allowed.

v Cell names are unique in the flowchart.
v Offers and offer lists that are referenced by contact processes are valid (have not

been retired or deleted). Offer lists that are referenced but are empty generate
warnings, not errors.

v Cells that were linked to a top-down entry from the target cell spreadsheet are
still connected.

The validation tool reports the first error found in the flowchart. You might need
to run the validation tool several times in succession (after correcting each
displayed error) to ensure that you have fixed all errors.

Note: A best practice is to run validation on flowcharts before doing a production
run. This is especially important if you are running scheduled flowcharts; using
batch mode; or you are not planning to actively monitor the run.

Validating flowcharts
When you validate a flowchart, each process is checked for errors. Each error that
is found displays in succession so that you can view and correct each one.

Procedure

1. On a flowchart page in Edit mode, open the Run menu and select
Validate Flowchart.
Campaign checks your flowchart.
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2. If errors exist, a message box displays the first error that was found. As you
correct each error and rerun the validation, any remaining errors display
successively.

Running flowcharts
You can choose to run an entire flowchart, a branch, or an individual process in
the flowchart. For best results, conduct test runs as you are building flowcharts, so
that you can troubleshoot errors as they occur, and be sure to save each flowchart
before you test or run it.

Important: For flowcharts containing contact processes, note that each production
run of a flowchart can generate contact history only once. To generate multiple
contacts from the same list of IDs, snapshot out the list of IDs and read from the
list for each flowchart run.

Note: Users with Administrative privileges can access the Monitoring page, which
displays all running flowcharts and their statuses, and provides controls to
suspend, resume, or stop flowchart runs.

Running a flowchart
When you run an entire flowchart, the data that it generates is saved in system
tables. After you run and save the flowchart, you can view the results of the run in
reports.

Procedure

1. If you are viewing a flowchart, open the Run menu and select Run This.

If you are editing a flowchart, open the Run menu and select Save and
Run Flowchart.

2. If the flowchart has already run, click OK on the confirmation window.
Data from the run is saved to the appropriate system tables. Each process
displays a check mark after it runs successfully. If there are errors, the process
displays a red "X".

3. Click Save and Exit (or click Save to continue editing).
You must save the flowchart after it runs to view the results of the run in any
reports. After you save the flowchart, results of repeated runs are immediately
available.

Note: If you click Save and Exit before the flowchart finishes running, the
flowchart continues to run and is saved when it finishes.

4. Click the Analysis tab and view the Campaign Flowchart Status Summary
report to determine whether there were any errors in the flowchart run.

Running a flowchart branch
When you select and run a process or a branch in a flowchart, the Run ID of the
flowchart is not incremented.

Procedure
1. On a flowchart page in Edit mode, click a process on the branch that you want

to run.

2. Open the Run menu and select Save and Run Selected Branch.
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Note: When you run only a process or a branch, if contact history records exist,
you are prompted to choose run history options before you can proceed. For
details, see “Updating contact history by doing a production run” on page 171.
Each process displays a check mark after it runs successfully. If there are errors,
the process displays a red "X".

Pausing a flowchart run
When you pause a running flowchart, branch, or process, the server stops running
but saves all of the data that was already processed.

About this task

You can pause a run to free up computing resources on the server, for example.
After you pause a run, you can continue the run or stop it.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page.

Procedure

1. On a flowchart page, open the Run menu .
2. Select Pause This.

Stopping a flowchart run
When you stop a flowchart run, the results of any currently running processes are
lost and a red "X" appears on those processes.

Procedure

1. On a flowchart page, open the Run menu .
2. Select Stop This.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page.

Continuing a stopped flowchart run
To run a flowchart from where it stopped, you can run the flowchart branch that
begins with the process where the flowchart stopped. That process is rerun along
with all downstream processes.

Procedure
1. On a flowchart page in Edit mode, click the process that has a red "X".

2. Open the Run menu and select Save and Run Selected Branch.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page. For details, see the Campaign Administrator's Guide.

Continuing a paused flowchart run
When you continue a paused run, the run resumes at the exact point at which it
stopped. For example, if a Select process was paused after processing 10 records, it
resumes by processing the 11th record.
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Procedure

1. On a flowchart page, open the Run menu .
2. Select Continue This.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page. For details, see the Campaign Administrator's Guide.

Troubleshooting runtime errors
Correctly configured processes are displayed in color (the specific color reflects the
type of process). A gray process with its name in italics has a configuration error.
To find out more information about the error, hold your mouse over the process to
display a descriptive error message.

If a flowchart stops running due to an error, the processes that were running
display a red X. Hold your mouse over the process to see an error message.

Note: If Campaign is configured so that system tables are stored in a database,
you are not viewing the flowchart, and the run stops due to a database connection
failure, the processes will not display a red X. Instead, the flowchart appears as it
did when it was last saved.

You should also consult the log file for system error information and review the
Analysis and Performance/Profitability reports for the campaign to see that the
results are what you expected.

Copying flowcharts
Copying an existing flowchart saves time because you can start with a completed
flowchart and modify it to meet your needs.

Procedure
1. View the flowchart that you want to copy.

For example, click a flowchart tab while you view its campaign.

2. Click the Copy icon .
3. In the Duplicate Flowchart dialog, select the campaign into which you want to

copy the flowchart.
4. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.

Results

The flowchart is copied to the campaign that you selected.

Process configuration settings are copied to the new flowchart. However, any
temporary files or tables that were created as a result of running the original
flowchart are not copied to the new flowchart.

If the copied flowchart includes contact processes (Mail List or Call List) with
target cells that are linked to a target cell spreadsheet, new cell codes are generated
for cells in the new flowchart so that duplicate cell codes do not occur. If the target
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cells were defined in the flowchart, and if the Auto-generate cell code option in
the contact process is off, new cell codes are NOT generated for the new flowchart.

Note: If the flowchart logic uses derived fields that reference cell codes from the
old flowchart, the logic does not carry over to the new flowchart.

Editing flowcharts
You edit a flowchart to add or remove processes or to configure the processes. You
can also edit the flowchart's name and description.

Opening a flowchart for editing
To change a flowchart, you must open it in Edit mode.

Procedure
1. Use one of the following methods to open a flowchart for editing:

v On the Campaigns page, click the Edit a tab icon next to the campaign,
and select the flowchart from the menu.

v Open the campaign, then click the flowchart tab. On the flowchart page, click
the Edit icon .
You can also press Ctrl and click the flowchart tab to open the flowchart
directly in Edit mode.

v Open the campaign's Analysis tab, click the link to the flowchart you want
to edit, then click the Edit icon .
You can also press Ctrl and click the flowchart name to open the flowchart
directly in Edit mode.

2. If you try to edit a flowchart that is already being edited by someone else,
Campaign warns you that the flowchart is open by another user.

Important: If you continue opening the flowchart, the other user's changes are
immediately and permanently lost. To prevent the loss of work, do not
continue opening the flowchart without first checking with the other user.

Editing a flowchart's properties
To change the name or description for a flowchart, you edit the flowchart's
properties.

Procedure
1. Open the flowchart for editing.

2. Click Properties in the Flowchart toolbar.
The Edit Flowchart Properties page opens.

3. Modify the flowchart name or description.

Note: Flowchart names have specific character restrictions. See Appendix A,
“Special characters in IBM Campaign object names,” on page 233.

4. Click Save Changes.
The modified flowchart details are saved.
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Viewing flowcharts in Read-Only mode
If you have View permissions for a flowchart, you can open it in Read-Only mode
to see which processes are used and how they are connected. However, you cannot
open process configuration dialogs or make any changes.

Procedure
1. Choose Campaign > Campaigns.
2. Use one of the following methods to open a flowchart.

v Click View a tab next to the campaign name, and select a flowchart from
the menu.

v Open the campaign, then click the flowchart tab.
v Open the campaign's Analysis tab, then click the name of the flowchart that

you want to view.

What to do next

If you want to see more details of the flowchart, such as how the processes are
configured, you must open the flowchart for reviewing or editing: Click the Edit
icon in the flowchart toolbar. Your permissions determine whether the flowchart
opens in review or edit mode.

Viewing two flowcharts side-by-side
Some campaign designers prefer to view two flowcharts side-by-side when
developing new flowcharts. When using Internet Explorer, you must use File >
New Session to open additional browser windows.

About this task

Do not use any other method to open multiple browser sessions. For example, do
not use a new tab; do not open another browser session from the Start menu; and
do not use File > New Window. Using these methods can confuse or corrupt
information that is displayed in Campaign.

Note: When using the method below, you cannot copy processes from one
flowchart to another. To copy configured processes across flowcharts, use the
template library options available on the right-click command menu, as explained
in “Copying processes between flowcharts” on page 54.

Procedure
1. Open Internet Explorer.
2. Log in to the IBM Enterprise Marketing Management (EMM) Suite and

navigate to a Campaign flowchart in view mode only.
3. In the browser window that you opened in Step 1, select File > New Session in

the Internet Explorer menu bar.
A new Internet Explorer instance opens.

4. In the new browser window, log in to the IBM Enterprise Marketing
Management (EMM) suite as the same or a different user, and navigate to a
Campaign flowchart in view mode only.
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Remember: You must disable any pop-up blockers in your browser or browser
add-ons, such as toolbars. Pop-up blockers prevent the flowchart window from
opening.

Reviewing flowcharts
Depending on your permissions, you might be allowed to review, but not edit,
flowcharts. Reviewing a flowchart means you can look at process configurations
and make changes, but you cannot save any changes or perform production runs.
The flowchart auto-save option is disabled and cannot be enabled. To save changes
to a flowchart, you must have Edit permissions.

About this task

If you are allowed to review but not edit flowcharts, you can verify a flowchart's
contents without inadvertently changing the flowchart.

You open a flowchart in Review mode the same way as you open a flowchart in
Edit mode. Your permissions ensure that you can only access flowcharts in Review
mode if you do not also have Edit permissions.

Follow these steps to review a flowchart.

Procedure
1. Use one of the following methods to open a flowchart:

v On the Campaigns page, Edit a tab next to the campaign, and select a
flowchart from the menu.

v Open a campaign, click the flowchart tab, then click Edit in the flowchart
toolbar.

v Open the campaign's Analysis tab, click the flowchart link, then click Edit
.

A message indicates that the flowchart is in review mode and that any changes
you make cannot be saved. The page header says "Reviewing" and only the
Cancel option is visible.

2. You can perform the following actions in Review mode:
v Save processes as a template.
v Save the flowchart as a template.
v Modify the flowchart (but you cannot save your changes).
v Perform test runs, if you have the appropriate permissions.

Important: Even in Review mode, test runs can write output and execute
triggers. Also, if you have the appropriate permissions, you can edit custom
macros and triggers in the flowchart, and thus might change the flowchart.

Deleting flowcharts
You can delete a flowchart if you decide that you no longer need it.

About this task

Deleting a flowchart permanently removes a flowchart and all of its associated
files, including the log file. If you want to retain portions of your flowchart for
reuse, save them as stored objects.
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Output files (such as files written by a Snapshot, Optimize, or a contact process)
are not deleted, and contact and response history are retained.

Use the following procedure to delete a flowchart.

Procedure
1. Open a flowchart in View mode.

2. Click the Delete Flowchart icon .

Important: If you try to delete a flowchart that is being edited by someone
else, Campaign warns you that the flowchart is open by another user. If you
continue, the other user's changes will be lost. To prevent the loss of work, do
not continue without first checking with the other user.

3. If you are sure that you want to permanently delete the flowchart, click OK to
confirm the deletion.
The flowchart and all of its associated files are deleted.

Printing flowcharts
You can print hardcopies of flowcharts from IBM Campaign.

About this task

Note: Do not use the web browser File > Print command. This procedure does not
always print flowcharts correctly.

Procedure
1. Open a flowchart in View or Edit mode.

2. Click the Print icon .

Analyzing the quality of your flowchart selections
As you create a marketing campaign flowchart, you can use flowchart cell reports
to analyze the accuracy of each process. Flowchart cell reports provide information
about which IDs are selected and how each downstream process affects the list of
selections.

Before you begin

To access cell reports, you must have permission to edit or review flowcharts and
view or export cell reports. See the IBM Campaign Administrator's Guide for
information about cell report permissions for the system-defined Administrative
Role.

About this task

Some reports examine each cell, or list of identifiers, that a data manipulation
process (Select, Merge, Segment, Sample, Audience, or Extract) generates as output.
Other reports show the flow of data throughout the flowchart, from one process to
the next. By analyzing cell data, you can refine your selections and identify
possible errors. You can also confirm that each process is producing the output that
you expect. For example, the Cell Content report shows the field values, such as
names, phone numbers, and email addresses, for each ID in the cell.
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Procedure
1. Open a flowchart in Edit mode.

2. Click Reports in the flowchart toolbar.
3. Select a report from the list to perform the appropriate action.

v “Displaying information about all cells in a flowchart (Cell List report)”
v “Profiling one characteristic of a cell (Cell Variable Profile report)”
v “Profiling two characteristics of a cell simultaneously (Cell Variable Crosstab

report)” on page 39
v “Displaying the contents of cells (Cell Content report)” on page 40
v “Analyzing cell waterfall in downstream processes (Cell Waterfall report)” on

page 41

Displaying information about all cells in a flowchart (Cell List
report)

Use the Cell List report to obtain information about all of the cells that are in the
current flowchart. The report provides information about any processes that were
run.

Procedure
1. Open a flowchart in Edit mode.

2. Click Reports in the toolbar.
The Cell Specific Reports window opens. Each cell in the flowchart corresponds
to a row in the report.
The report shows data from the last run of the flowchart. The Status column
indicates the type of flowchart run, such as Test Run or Production Run.

3. To sort the display, click a column header in the report.

4. To change the display, click Options and select one of the following
options:
v Tree View: View the flowchart cells in a folder hierarchy. The levels represent

the levels and relationships in the flowchart. Expand or collapse each level to
show or hide the items below it.
If the flowchart contains Merge processes, they are color coded throughout
the report. For example, Merge1 is red and Merge2 is blue. The child and
parent cells of each Merge process are also color coded, so you can easily
identify them no matter how the list is sorted. For example, if Merge1 is red,
the Cell ID field is red for all of the Merge1 child processes and parent
processes.

v Table View: View the flowchart cells in a table format (default).

Profiling one characteristic of a cell (Cell Variable Profile
report)

Use the Cell Variable Profile report to display data that is associated with one
variable of a specified cell. For example, you can select the Gold.out cell and
specify Age as the variable to see the age range of all clients with gold credit cards.
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About this task

The Cell Variable Profile report displays demographic information that can help
you to identify potential targets for your campaign.

Procedure
1. Open a flowchart in Edit mode.

2. Click Reports .
3. Select Cell Variable Profile from the Report to View list.
4. Select the cell that you want to profile from the Cell to Profile list.
5. Select a field from the Field list.

6. (Optional) To modify the display, click Options , then use the Report
Options window to select the following options.
v Number of Bins: IBM Campaign groups field values to create equal-sized

segments, or bins. The field values along the horizontal axis are organized
into bins. For example, if you specify four bins for Age, values might be
grouped into bins of 20-29 and 30-39, 40-49, and 50-59. If the number that
you specify is less than the number of different field values, some fields are
joined in one bin. The default maximum number of bins is 25.

v Profile By Meta Type: This option is enabled by default. This option ensures
that field values that represent dates, money, telephone numbers, and other
numeric data are correctly sorted and binned, rather than sorting on ASCII
text. For example, when you profile by meta type, dates are sorted as dates,
not as numeric values.

v View Table: View the report in a table format. Each bin is represented as a
row, with the count for each bin as a column.

v View Plot: View the report as a graph. This option is the default. Right-click
the report to access more display options.

v Show 2nd Cell: If more than one cell is available for profiling, select this
option to view a second cell in the report. The two cells are displayed side
by side in graphical format.

Profiling two characteristics of a cell simultaneously (Cell
Variable Crosstab report)

Use the Cell Variable Crosstab report to profile data from two fields
simultaneously for the specified cell. For example, you can select Age and Amount
for the Gold.out cell to see the relative amount of purchases by age for clients with
gold credit cards.

About this task

Each field that you select represents one axis of the grid. For example, you could
select Age for the X axis and Amount for the Y axis. The report divides the field
values into a number of bins along each axis. The size of the box at each
intersection represents the relative number of customer IDs that have both
attributes. For example, using Age and Amount, you can visually identify which
age groups spent the most money.

Procedure
1. Open a flowchart in Edit mode.
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2. Configure and run the process which generates the cell that you want to
profile.

3. Click Reports in the toolbar.
4. Select Cell Variable Crosstab from the Report to View list.
5. Select a cell from the Cell list.
6. Select fields (variables) to profile from the Field 1 and Field 2 lists.

7. (Optional) To modify the display, click Options , then use the Report
Options window to select the following options:
v Number of Bins: IBM Campaign groups field values along each axis to

create equal-sized segments, or bins. For example, if you specify four bins for
Age, values might be grouped into bins of 20-29 and 30-39, 40-49, and 50-59.
If the number that you specify is less than the number of different field
values, some fields are joined in one bin. The default number of bins is 10.

v Profile By Meta Type: This option is enabled by default. This option ensures
that field values that represent dates, money, telephone numbers, and other
numeric data are correctly sorted and binned, rather than sorting on ASCII
text. For example, when you profile by meta type, dates are sorted as dates,
not as numeric values.

v View Table: View the report in a table format.
v View 2-D Plot: View the report as a 2-D plot graph (the default). Right click

the report to access more display options.
v View 3-D Plot: View the report as a 3-D plot graph. Right click the report to

access more display options.
v Cell 1 Display: Specify how the cell information is displayed on the X-axis.

For certain numeric fields, you can select fields to operate on from the Value
Field menu.

v Value Field (For both Cell 1 Display and Cell 2 Display): Add a variable to
the existing variable that is being profiled. This second variable will appear
as a box within the box that represents the first variable.

Displaying the contents of cells (Cell Content report)
Use the Cell Content report to display details of the records in a cell. Using the
report options, you can display actual field values, such as the email addresses,
phone numbers, and other demographic data for each customer in the cell.

About this task

The report can display values from any table sources defined at the current
audience level. This report is useful for verifying the results of runs and to confirm
that you are selecting the intended set of contacts.

Procedure
1. Open a flowchart in Edit mode.

2. Click Reports in the toolbar.
3. Select Cell Content from the Report to View list.
4. Select a cell from the Cell To View menu.

5. (Optional) To modify the display, click Options , then specify the
following options in the Report Options window:
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v Max. number of rows to view: Change the maximum number of rows that
the report displays. The default is 100.

v Fields to View: Select fields in the Available Fields area and add them to the
Fields to View area.

v Skip Records with Duplicate IDs: Choose to skip records with duplicate
fields. This is useful if you are using non-normalized tables. This option is
disabled by default.

Note: The number of records field is limited to 10000.

Analyzing cell waterfall in downstream processes (Cell
Waterfall report)

Use the Cell Waterfall report to see how many individuals are removed with each
downstream process in your flowchart. The report provides information about the
output of each data manipulation process, so you can see how each subsequent
process affects your selections. You can then refine target counts based on viewing
the falloff that is incurred by each successive criteria.

About this task

By analyzing the falloff of audience members as cells are processed, you can refine
your selections and identify possible errors. You can also confirm that each process
is producing the output that you expect. For example, you can see how many IDs
are initially selected, then see what happens when you use a Merge process on
those results. In this way, you can see the falloff that is incurred by each successive
criteria. If your flowchart is complex and contains multiple processing paths, you
can select which path you want to analyze.

Procedure
1. Open a flowchart in Edit mode.

2. Click Reports in the flowchart window toolbar.
3. Select Cell Waterfall from the Report to View list.
4. Select the cell that you want to analyze from the Cell list.
5. If the cell is connected to multiple downstream processes, use the Path list to

indicate which path in the flowchart that you want to analyze.

Example

For more information, see the “Cell Waterfall report example.”

Cell Waterfall report example
This example shows how you can use a Cell Waterfall report to identify processes
that affect output volume. The report provides details about the output by
percentage and quantity.

This example analyzes the output from a Select process named "Gold" in a
Multi-Channel Retention campaign flowchart.
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The Cell Waterfall report for this flowchart is shown in the following figure. The
Gold cell is selected in the Cell list at the top of the report. Therefore, the report
analyzes the output from the "Gold" Select process. The Path list is not relevant in
this example because the Gold cell has only one path in this flowchart (from Gold
to Eligible). If the Gold process box provided output to other processes in the
flowchart, you could use the Path list to look at other sequences.

Each cell is identified by its Output Cell Name, plus a [Process Name] shown in
square brackets. These names were assigned on the General tab of the process
configuration dialog.
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This example report shows the following progression:
1. The IDs in the Gold cell are passed to a Merge process named Eligible.
2. You can see that some IDs were added and some were removed.
3. By looking at the flowchart, you can see that the Platinum (Select) process

added some IDs and the Opt Outs (Select) process removed some IDs.
4. The Eligible IDs (Gold and Platinum, minus Opt-Outs) are passed to a Segment

process named Value Tiers.
5. The Segment process divides the Eligible IDs into multiple contact channels.

The Total row shows how many IDs the Gold process originally selected. This row
also shows the number and percentage of Gold IDs that remain.

Printing or exporting flowchart cell reports
You can print any flowchart cell report or export it to another format.

Procedure
1. Open a flowchart.

2. Click Reports .
3. Select a report from the list and set any report-specific controls.

4. Click Print to print the report.

5. Click Export to save or open the report as a comma-separated values
(CSV) file. Assign a file name but do not include a path or extension. If you
want to include column headers in the CSV file, check Include Column Labels.
If you choose to save the file, you are prompted for a path and you have the
opportunity to change the file name.
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Chapter 5. Process configuration

Campaign uses processes in a flowchart to perform various actions on your
customer data. By adding process boxes to a flowchart, then configuring and
connecting the processes, you determine the logic for your marketing campaign.

Most processes determine how Campaign selects and manipulates IDs from your
user data. For example, you can configure a Select process to identify high-value
prospects, configure another Select process to identify medium-value prospects,
then use a Merge process to combine the two lists. Configuring a process
determines what occurs when the process runs.

There are many types of processes, and each one performs a distinct function.
Some processes are intended to be used when you implement your campaign. For
example, you use the Call List process to assign offers and generate a call list,
which you can send to a call center.

You use other processes after your campaign is deployed. For example, you use the
Track process to update Contact History after you deploy your campaign and see
who responds.

Types of processes
Campaign processes are divided into three types by function, which are
distinguished by color in the flowchart process palette.
v Data manipulation processes - blue
v Run processes - purple
v Optimization processes - green

Note: Interact, Contact Optimization, and eMessage provide additional processes
for use in campaign flowcharts. For information about those processes, see the
separate documentation for those products.

Data manipulation processes
Use data manipulation processes to select contact IDs from your data sources and
work with those IDs to create meaningful groups or target audiences.

Examples of the tasks that you can complete by using data manipulation processes
follow.
v You can select potential contacts that meet the criteria that you define, such as

repeat customers within a certain income range.
v You can merge lists to include or exclude contacts.
v You can segment customers into meaningful groups, for example by language or

gender.
v You can set up test or control groups.
v You can change the target audience for your campaign, for example from

Household to Individual.
v You can extract sets of data for additional processing to improve performance.

The following data manipulation processes are available:
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v “The Select process” on page 56
v “The Merge process” on page 61
v “The Segment process” on page 62
v “The Sample process” on page 69
v “The Audience process” on page 72
v “The Extract process” on page 82

Run processes
Once you have built your campaign to select the audience you want, you need to
output the results in a usable way using the run processes. Run processes control
the running of the flowchart and trigger actual customer contact.

Run processes control the actual execution of completed campaigns, which
includes the management and output of contact lists, the treatment of target
audiences, the tracking of responses and contacts, the logging of data, and the
scheduling of campaign or session runs.

The run processes are:
v “The Snapshot process” on page 87
v “The Schedule process” on page 89
v “The Cube process” on page 93
v “The Create Seg process” on page 95
v “The Mail List process” on page 97
v “The Call List process” on page 102

Note: The Mail List and Call List processes are also referred to as contact
processes.

Optimization processes
Use the optimization processes to help determine a campaign's effectiveness and
refine your marketing campaigns over time.

The Track and Response processes help you to track who is contacted and who
responds. In this way, you can evaluate the response to your campaigns and
modify them over time.

The Model process automates the creation of a response model that can be used to
predict responders and non-responders.

The Score process scores contacts against a data model to rate the likelihood of
each customer making a purchase or responding to an offer. Scoring accurately
identifies the best customers or prospects for a campaign. In this way, you can
determine the most effective campaign, offer, and channels.

For more information, see the following topics:
v “The Track process” on page 103
v “The Response process” on page 105
v The SPSS Model and SPSS Score processes require IBM SPSS Modeler Advantage

Marketing Edition. For information, see the IBM Campaign and IBM SPSS Modeler
Advantage Marketing Edition Integration Guide.
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List of Campaign processes
Configure and connect processes in flowcharts to accomplish your campaign goals.
Each process performs a specific operation, such as selecting, merging, or
segmenting customers.

Note: Interact, Contact Optimization, eMessage, and IBM SPSS Modeler
Advantage Marketing Edition provide additional processes for use in flowcharts.
For more information, see the documentation for those products.

Table 7. List of Campaign processes in batch flowcharts

Process Overview Instructions

“The Select process” on page 56 “Selecting a list of contacts” on page 56

“The Merge process” on page 61 “Merging and suppressing contacts” on page 61

“The Segment process” on page 62 “Segmenting data by field” on page 64

“Segmenting data with queries” on page 68

“The Sample process” on page 69 “Dividing contacts into sample groups” on page 69

“The Audience process” on page 72 “Switching and filtering audience levels” on page 75

“The Extract process” on page 82 “Extracting subsets of data for further processing and
manipulation” on page 84

“The Snapshot process” on page 87 “Taking a snapshot of data” on page 87

“The Schedule process” on page 89 “Scheduling processes in a running flowchart” on page 92

“The Cube process” on page 93 “Creating a multi-dimensional cube of attributes” on page 94

“The Create Seg process” on page
95

“Creating segments for global use in multiple campaigns” on page
95

“The Mail List process” on page 97 “Configuring contact processes (Mail List or Call List)” on page 97

“The Call List process” on page
102

“Configuring contact processes (Mail List or Call List)” on page 97

“The Track process” on page 103 “Tracking contact history” on page 104

“The Response process” on page
105

“Updating response history” on page 106

The eMessage process defines the
recipient list for an eMessage
mailing.

Requires IBM eMessage. See the eMessage User's Guide.
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Table 7. List of Campaign processes in batch flowcharts (continued)

Process Overview Instructions

The Interact List process
determines which offers the
Interact runtime server presents to
customers.

Requires IBM Interact. See the Interact User's Guide.

The Optimize process associates a
marketing campaign with a
Contact Optimization session.

Requires IBM Contact Optimization. See the Contact Optimization
User's Guide.

The SPSS Model process generates
predictive models to predict likely
responders based on past behavior.

Requires IBM SPSS Modeler Advantage Marketing Edition. See the
IBM Campaign and IBM SPSS Modeler Advantage Marketing Edition
Integration Guide.

The SPSS Score process rates the
likelihood of customers responding
to offers, to identify the best
prospects for a campaign.

Requires IBM SPSS Modeler Advantage Marketing Edition. See the
IBM Campaign and IBM SPSS Modeler Advantage Marketing Edition
Integration Guide.

Related concepts:
Appendix A, “Special characters in IBM Campaign object names,” on page 233
Related tasks:
“Creating flowcharts” on page 28

Data sources for processes
When you configure most processes in a flowchart, you must specify the source of
the data that the process will act on. The data source for a process can be one or
more incoming cells, segments, files, or tables. For example, the data source for a
Select process might be a database table where your organization stores customer
information such as Name, Address, Age, and Income.

The available tables depend on which data sources your administrator mapped.
(Mapping tables is the process of making external customer tables accessible in
IBM Campaign. Only tables that an administrator has mapped are available for
selection.)

If multiple tables have been mapped, you can select more than one table as input
to a process. For example, a Select process can take input from your company's "A"
database and "B" database. The tables that you select must have the same audience
level, such as Household or Customer.

It is common to use the output of one process as the input to a subsequent process.
For example, you might connect a Select process to a Segment process. When you
configure the Segment process, the ouput of the Select process would serve as the
input to the Segment process.

If you select multiple cells as input, all cells must have the same audience level.
For example, if two Select processes provide input to a Merge process, both Select
processes must have the same audience level. You cannot mix Household and
Customer, for example.

To specify the data source for a process, configure the process in a flowchart. In
most cases, you use the Input field on the first tab of the process configuration
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dialog. The Input field displays all of the base tables that are currently mapped in
the table catalog, along with their audience levels. The Input field also indicates
any connected (upstream) processes.

If there is an incoming cell (for example, if a Select process is connected to a
Segment process), then only tables with the same audience level as the cell are
displayed.

For more information about selecting data sources, see the instructions for
configuring each process.

Manipulating process boxes in flowcharts
Process boxes are the building blocks of flowcharts. The processes are visible on
the flowchart process palette at the left of the workspace. Each marketing
campaign consists of at least one flowchart, and each flowchart consists of
processes that are configured and connected.

About this task

To create a campaign flowchart, you drag process boxes from the palette to the
workspace. You then configure each process box to perform a specific operation,
such as selecting customers to target for a mailing. By dragging connector lines
from one box to another, you connect processes in the workspace in a logical flow
to determine the order of events.

For example, use Select processes to choose customers to target in your campaign.
Use a Merge process to combine the selections, and end with a Call List process,
which generates a list of customers to contact by phone.

You can move and delete process boxes as you experiment with different flowchart
scenarios. To confirm that your flowchart is progressing successfully, you can test
run each process as you build your flowchart. Save your flowchart frequently as
you work.

The following steps provide a high-level overview of how to build a flowchart by
adding, configuring, and connecting processes.

Procedure
1. Open a flowchart for editing.
2. Add a process to a flowchart by dragging it from the palette to the workspace.

For example, add a Select process.
3. Configure the process by double-clicking it in the palette. For example,

configure the Select process to select all high-value customers aged 25 - 34
("Gold").

4. Add and configure the next process in your flowchart. For example, add
another Select process and configure it to select all medium-value customers
aged 25 - 34 ("Silver").

5. Continue adding, configuring, and connecting processes in the flowchart to
determine the logical flow of data. For example:
a. Connect both of the Select processes ("Gold" and "Silver" customers) to a

Merge process.
b. Configure the Merge process to merge the Gold and Silver customers into a

single list.
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c. Connect the Merge process to a Mail List process.
d. When you configure the Mail List process, you assign pre-defined offers.

For example, you can assign a 10% discount to Silver customers and a 20%
discount to Gold customers.

6. Test run each process as you configure it to confirm that it produces the
expected results.

Adding processes to flowcharts
You can add a process to a flowchart by dragging a process box from the palette to
the workspace.

About this task

The procedure that follows explains how to drag processes into a flowchart. Other
methods of adding processes are to copy an existing process (right-click, copy, then
paste), or paste a template from the template library. Templates contain one or
more configured processes and connections. For more information, read about
using templates.

Follow these steps to add processes to a flowchart.

Procedure
1. Select Campaign > Campaigns.
2. Use one of the following methods to open a flowchart:

v Click the name of a campaign, then click a flowchart tab, then click the Edit
icon in the toolbar.

v Use the Edit a tab icon next to a campaign name to open a flowchart in
that campaign.

The flowchart window opens and the palette appears at the left of the
workspace.

3. Drag a process box from the palette to the flowchart. You can drop the process
box into the workspace as soon as the box turns green and displays a plus sign.

Newly added process boxes are transparent until they are configured.

Typically, the next step is to configure the process, by double-clicking it in the
workspace to open the configuration dialog.
To see a list of available actions, you can right-click a process box in the
workspace.
Configured process boxes have a solid background and border. The round
status icon is blank to indicate that the process has not yet run.
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4. Click the Save and Continue icon frequently to save your changes.

Results

As you develop the flowchart, place each subsequent box in a logical position,
such as left to right or top to bottom, and connect the boxes to indicate the flow of
data. Some processes must be connected before they are configured because they
require input from the source process.

For example, configure a Select process to select households in a specific earning
bracket, then connect it to an Audience or Merge process. Finally, you test run the
process or branch.

What to do next

See the other available topics for information about configuring, connecting, and
running processes.

Determining the status of a process
Each process box in a flowchart displays an icon to indicate its status.

Process not started (has not been run)

Process running

Process run complete

Warning

Error

Schedule process is ready to initiate any subsequent processes. (This
icon appears only on a Schedule process, after the flowchart has run.)

Paused

A process box with the process run complete icon is shown below.

Connecting processes in flowcharts
Connect processes in a flowchart to specify the direction of data flow and the order
in which the processes run. If you move processes within the workspace, existing
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connections remain and visually adjust to the new location. This visual adjustment
does not affect data flow. You affect data flow only by adding or deleting
connections.

Procedure
1. Open a campaign flowchart for editing.
2. Move your cursor over the process box that you want to connect to another

box.
Four arrows appear around the box.

3. Drag one of the arrows from the source process to the destination process.

When four arrows appear on the destination process, release the mouse button
to complete the connection.

Results

The processes are now connected. An arrow indicates the direction of data flow
(from - to). The source process will run before the destination process. Data that is
output from the source process is then available as input to the destination process.
For example, a Select process generates output, which can then serve as input to a
Segment process.

Example: process connections
The way processes are connected in a flowchart determines the flow of data.

Flowchart scheduled to run every night

The following flowchart starts with a Schedule process that is configured to run
automatically every night. The dotted lines from the Schedule process to the three
Select processes indicate a temporal dependency. The Select processes will not run
until the Schedule process finishes running. However, no data is passed from the
Schedule process to the Select processes. The solid lines between the other
processes show the flow of data. For example, the merged selections flow from the
Merge process (labeled "Exclusions") into a Segment process ("SegByScore"). The
segmented selections then flow into Mail List and Call List processes, so the offers
can be delivered by different channels.
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Appearance of connection lines

When a destination process receives data from a source process, the connection is
shown as a solid line.

When a destination process depends on a source process but does not receive data
from it, the connection is shown as a dotted line. A dotted line indicates that the
destination process cannot run successfully until the source process completes. In
this way, you can identify processes that are time-dependent on each other.

Connection lines can be angled (slanted) or straight (right angles only). The lines in
the previous example are straight.

To change line appearance, right-click in the flowchart workspace, choose View,
and check or uncheck Angled Connections.

Deleting a connection between two processes
If two processes are no longer connected, or if the direction of the data flow
between them changes, you can delete the connection.

Procedure
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. Click the connection that you want to delete.
3. Do one of the following:

v Right-click the connection, and select Delete Selected from the menu.
v Press the Delete key.

v Click the Cut icon in the flowchart window.
v Press Ctrl+X.

Results

The connection is deleted.

Copying processes within a flowchart
Copying a configured process can save time when you build campaign flowcharts.
You can paste the process elsewhere in the workspace.

Procedure
1. Within a campaign, open a flowchart for editing.
2. In the workspace, click the process that you want to copy.
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Note: To select multiple processes, you can Ctrl+Click the processes, drag a
selection box around them, or use Ctrl+A to select all the processes in the
flowchart.

3. Click the Copy icon .
You can also select Copy from the menu or press Ctrl+C.

4. Click the Paste icon .
You can also select Paste from the menu or press Ctrl+V.
A copy of the process appears in the workspace.

5. Click and drag the copied process to the desired location.

Copying processes between flowcharts
Use the template library to copy configured processes from one flowchart to
another. A template contains one or more configured processes and connections.
Copying configured process boxes can save time when you design complex
flowcharts.

About this task

Due to certain limitations, you cannot use two separate browser windows to copy
configured processes from one flowchart to another. Instead, use the following
procedure.

Procedure

The best way to copy configured processes from one flowchart to another is to use
the template library:
1. Open a flowchart for editing.
2. Select processes in the flowchart. You can use Ctrl+Click or drag a selection

box around them, or use Ctrl+A to select all of the processes in the flowchart.
3. Right-click any selected process box and select Copy to Template Library.
4. When prompted, enter a Name and Note to help you identify the template

later.
5. You can now paste the process boxes into any other flowchart, by choosing

Paste from Template Library from the right-click menu or by using Options >
Stored Templates.

6. As an alternative to using the template library, you can perform the following
steps:
a. Select one or more processes.

b. Use the Copy icon or Ctrl+C or the right-click menu to copy the
processes.

c. Close the flowchart.
d. Open another flowchart in edit mode.

e. Paste the processes by clicking the Paste icon or using Ctrl+V or the
right-click menu.

Moving processes in flowcharts
You can move any process in a flowchart by dragging the process to a different
location in the workspace. Moving a process does not affect the workflow; it only
affects the visual appearance of the flowchart.
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Before you begin

This procedure assumes that you have a flowchart open for editing.

About this task

You might want to move processes so that you can see the process boxes and
connections more clearly. In general, it is best to avoid positioning processes on top
of each other because it is harder to see the overall flow. If you have a large
flowchart with many processes, you can move the processes and then use the
zoom feature to see them all.

The position of processes in the flowchart workspace does not affect the logical
flow of data. The connections between the processes determine data flow.

Follow the steps below to move process boxes in a flowchart.

Procedure
1. In the flowchart workspace, drag a process to a new location.

Existing connections to and from the process remain, and are redrawn for the
new location.

2. Click Save.
Related tasks:
“Adjusting flowchart appearance” on page 26

Deleting processes from flowcharts
As you design and build flowcharts, you can delete processes if you decide that
you no longer need them. For example, you might add two Select processes but
then decide that you only need one of them.

Before you begin

This procedure assumes that you have a flowchart open for editing.

Procedure
1. In the flowchart workspace, right-click the process that you want to delete, and

select Delete from the menu.
You can select more than one process at the same time by holding down the
Ctrl key.

2. Click OK to confirm the deletion.

Results

The selected processes are removed from the workspace. Any connections to and
from the processes are also deleted.

Running or testing a process
To ensure that your configuration is successful and the results are what you expect,
test run each process after you configure and connect it.
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About this task

Note: When you run a process, any results from a previous run are lost.

Procedure
1. Open a flowchart for editing.
2. Click the process that you want to run.

If the process requires data from a source process, be sure that the source
process has already run successfully so that its data is available.

3. Open the Run menu in the toolbar, or right-click the process box, and
select an option:
v Test Run Selected Process: Use this option while you build your flowchart,

so you can troubleshoot errors as they occur. Test runs do not output data or
update any tables or files. (However, triggers run on completion of test runs,
and global suppression is applied.)

Tip: When you test run a data manipulation process (Select, Merge, Extract,
Audience), you can limit the number of records that are selected for output.
Use the Limit output cell size option on the Cell Size Limit tab in the
process configuration dialog.

v Save and Run Selected Process: Do a production run. The contact processes,
Mail List and Call List, write entries into Contact History. Each production
run can generate contact history only one time. Contact processes that
already ran for that production run can be rerun only if the contact history
from the current run is first deleted. Triggers run on completion of the
production run.

Note: Running only a process or a branch of a flowchart does not increment
the Run ID of a flowchart. When you run only a process or a branch, if contact
history records exist, you are prompted to choose run history options before
you can proceed. For details, see “Updating contact history by doing a
production run” on page 171.

4. When the process finishes running, click OK.

Results

The process displays a green check mark after it runs successfully. If there are
errors, the process displays a red X.

The Select process
Use the Select process to define the criteria to build lists of contacts, such as
customers, accounts, or households, from your marketing data.

Select is one of the most frequently used processes in Campaign. Most flowcharts
begin with one or more Select processes. The Select process outputs a cell that
contains a list of IDs, such as customer IDs, which can be modified and refined by
other processes.

Selecting a list of contacts
Configure a Select process to select contacts from your marketing data.
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About this task

To select contacts, you can specify all IDs in a segment or table, or you can use a
query to find just the contacts that you want. One or more Select processes can
then be used as input into another process. For example, you can select all Gold
customers, then create another selection of Silver customers. You can then use a
Merge process to create a single list of eligible contacts.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Select process from the palette to your flowchart.
4. Double-click the Select process box in the flowchart.

The Select Process Configuration dialog box opens.
5. On the Source tab, use the Input list to select a Segment or Table to provide

the data source for the process.
You can select one segment, or one or multiple tables.To select multiple tables,
select the first table from the Input list and then use the ellipsis button next to
the field.

Note: If IBM Digital Analytics is integrated with Campaign, you can select
IBM Digital Analytics segments as the input.

6. Choose one of the Select options. The option names vary, depending on the
audience level that is specified in the input data source.
v Select audience IDs: Include all rows from the segment or table that you

selected in the previous step.
v Select audience IDs with: Select IDs by specifying a query.

7. If you chose Select audience IDs with, use one of the following methods to
create a query:
v Point & Click: Click in the Field Name, Oper., and Value cells to select

values to build an expression. Use And/Or to combine expressions. This
method provides the easiest way to create a query and helps to avoid
syntax errors.

v Text Builder: Use this tool to write raw SQL or use the provided macros.
You can use the Formula Helper within Text Builder to select supplied
macros, including logical operators and string functions.

With either method, you can select fields from the Available Fields list,
including IBM Campaign Generated Fields and Derived Fields.

Note: If your query includes a table field that has the same name as a
Campaign Generated Field, you must qualify the field name. Use the
following syntax: <table_name>.<field_name>

8. If you want to limit the number of IDs generated by the process, use the Cell
Size Limit tab.

9. Use the General tab as follows.
a. Process Name: Assign a descriptive name, such as Select_Gold_Customers.

The process name is used as the box label on the flowchart. It is also used
in various dialogs and reports to identify the process.
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b. Output Cell Name: This name matches the Process Name by default. It is
used in various dialogs and reports to identify the output cell (the set of
IDs that the process retrieves).

c. (Optional) Link to Target Cell: Perform this step if your organization
pre-defines target cells in a Target Cell Spreadsheet (TCS). To associate the
pre-defined target cell with the flowchart process output, click Link to
Target Cell, then select a target cell from the spreadsheet. The Output Cell
Name and Cell Code are inherited from the TCS, and both of those field
values are shown in italics to indicate that there is a link relationship. For
more information, read about using target cell spreadsheets.

d. Cell Code: The cell code has a standard format that is determined by your
system administrator and is unique when generated. Do not change the
cell code unless you understand the implications of doing so.

e. Note: Use the Note field to explain the purpose of the Select process.
Common practice is to reference the selection criteria.

10. Click OK.
The process is now configured. You can test run the process to verify that it
returns the results you expect.

Targeting IBM Digital Analytics segments in campaigns
IBM Digital Analytics allows users to define segments based on visit and view
level criteria. When you configure a Select process in IBM Campaign, you can use
these segments as the data source.

Before you begin

The IBM Digital Analytics Segments option is available only if IBM Digital
Analytics and Campaign are integrated. Configuring the integration is explained in
the IBM Campaign Administrator's Guide

About this task

Follow the steps below to use segments exported from IBM Digital Analytics in
your campaign.

Procedure
1. Double-click a Select process in a Campaign flowchart to open the Select

Process Configuration dialog.
If the Select process contains a previously defined IBM Digital Analytics
Segment, the Input box on the Source tab shows the existing segment name.

2. Open the Input list and click IBM Digital Analytics Segments.
The IBM Digital Analytics Segment Selection dialog opens.
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3. In the IBM Digital Analytics Segment Selection dialog:
v Select a Client ID from the list to display a list of all published segments

associated with that IBM Digital Analytics client.
v The Select segment list shows the segments defined in IBM Digital

Analytics, including the Application where the segment was created, its
Type, and its Start and End Dates.

v The Description should help you determine the purpose of the segment. If
you need more information about a segment, double-click it to see the
segment expression and other information defined in IBM Digital Analytics.

v The Start Date and End Date next to each segment indicate the IBM Digital
Analytics-defined date range for finding visitors who match the segment
criteria. For example, one segment might find everyone who visited a
particular site at least 3 times between January 12, 2012 and April 12, 2012,
and another segment might find visitors from a different range of dates. The
IBM Digital Analytics-defined date range cannot be changed here. However,
you can use the Segment range date controls at the bottom of the dialog to
define a date range that falls within the range defined in IBM Digital
Analytics.

4. Select a segment in the list. If you are modifying (as opposed to creating) a
Select process, the existing segment range is displayed.

5. Use the Segment range date and calendar controls at the bottom of the dialog
to specify the date range from which you want to obtain data for the selected
segment.
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v The range that you specify must fall within the Start Date and End Date
defined for the segment in IBM Digital Analytics (shown next to each
segment in the list).

v In addition to taking the Start and End Date into account, Campaign also
considers the date constraint (if any). The date constraint is defined in IBM
Digital Analytics but does not appear in the Segment Selection dialog. The
date constraint limits the number of days' worth of data to pull for a
segment, to ensure that IBM Digital Analytics is not overloaded with
exporting a large data set.
For example, say there is a segment defined in IBM Digital Analytics with a
3-month span (Start and End Date) and a date constraint of 7 days. The date
range that you define in Campaign takes both constraints into account. If
you specify a date range outside of the 3-month span, your segment
definition cannot be saved. Likewise, if you specify a date range that exceeds
7 days, your segment definition cannot be saved.

v You can specify absolute or relative dates, as long as they fall within the IBM
Digital Analytics-defined range and date constraint.

v If you specify an absolute Start Date, you must also supply an End Date. For
example, if the IBM Digital Analytics-defined segment defines a 3-month
span, your campaign can target visitors whose information was gathered on
a single day, month, or week within that span.

v Examples of relative dates:
– If the IBM Digital Analytics-defined segment is for a 3-month span, you

can specify a relative date, such as Yesterday or Last 7 Days, to
continually find recent visitors. The campaign will run successfully until
the IBM Digital Analytics-defined End Date occurs.

– If you specify THIS MONTH, the full month of data must be available up
until the day before this relative date is used. For example, if today is
March 28, data from March 1 - March 27 must be available for the selected
segment.

– If you specify LAST MONTH; the full previous month of data must be
available. Example #1: If the IBM Digital Analytics-defined segment has a
start date of March 1 and an end date of March 31, LAST MONTH can be
used starting on April 1, up to and including April 30 (to get data for the
month of March). Example #2: If the IBM Digital Analytics-defined
segment has a start date of March 1 and an end date of March 30, LAST
MONTH cannot be used, because there is not a full month of data.
Example #3: If the IBM Digital Analytics-defined segment has a start date
of March 2 and an end date of March 31, LAST MONTH cannot be used,
because there is not a full month of data. In these cases, a message
indicates that LAST MONTH does not fall within the segment dates.
Instead, you must use absolute dates.

6. Click OK to return to the Select Process Configuration dialog.

Results

When the Select process runs, it pulls data from IBM Digital Analytics for the
segments within the specified date range and date constraint. The mapping table
used for the flowchart tells Campaign how to convert IBM Digital Analytics IDs to
Campaign Audience IDs. The Audience IDs are then available for use in
downstream processes. For technical information about how this works, see the
Campaign Administrator's Guide.
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In rare situations, when you run a flowchart, the number of IBM Digital Analytics
IDs for a selected segment might not match the number of Audience IDs found in
Campaign. For example, there might be 100 IBM Digital Analytics keys but only 95
matching IDs in Campaign. Campaign warns about this situation but continues
running the flowchart. A message is written to the log file for that flowchart,
asking you to verify that your mapped translation table contains updated records.
An administrator can resolve this situation by (re)matching the online and offline
keys according to your corporate policy and repopulating the translation table with
up-to-date data. You must re-run the flowchart after the mapped translation table
is updated.

The Merge process
Use the Merge process to specify which input cells are included and combined and
which input cells are excluded (suppressed).

In this way, you can include or exclude cells from subsequent processes in your
flowchart. For example, use the Merge process to suppress "opt-out" customers
who requested that they not receive any marketing materials.

Merging and suppressing contacts
The Merge process accepts input from multiple cells and produces one combined
output cell. When you merge cells, you can choose to include or exclude content.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.
3. Configure at least two processes whose output you want to merge. For

example, configure two Select processes.

4. Drag the Merge process from the palette to your flowchart.
5. Drag an arrow from an upstream process (for example, a Select process) to the

Merge process, to connect the boxes. You must connect from the upstream
process to the Merge process. Repeat to connect any other upstream processes
into the Merge process. See “Connecting processes in flowcharts” on page 51.

Note: All cells that provide input to the Merge process must have the same
audience level. For example, multiple Select processes must use the
Household audience.

6. Double-click the Merge process in the flowchart.
The process configuration dialog box opens. Cells from processes that are
connected to the Merge process are listed in the Input list.

7. If you want to exclude IDs from the merged output, select a cell in the Input
list and add it to the Records to Exclude list. For example, use this option to
exclude Opt Outs.

8. If you want to include IDs in the merged output, select a cell in the Input list
and add it to the Records to Include list. The IDs in the cells that you add to
this list will be combined into one list of unique IDs.

9. Specify how to merge the lists from the input cells that are in the Records to
Include list:
v Merge/Purge on Include: This option produces a list of unique IDs that

exist in at least one input cell. Duplicate IDs are included only once. This
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method uses a logical "OR" or "ANY." For example: Include customer A if
that customer is in either the Gold.out cell OR the Platinum.out cell.

v Match (AND) on Include: Include only those IDs that exist across all input
cells. This method uses a logical "AND" or "ALL." For example: Include
customer A only if that ID exists in both the Gold.out cell AND the
LoyaltyProgram.out cell. This option is useful when you want to include
customers that meet multiple criteria. If an ID does not exist in all of the
Merge process input cells, the ID is not included.

10. If you want to limit the number of IDs generated by the process, use the Cell
Size Limit tab.
See “Limiting the size of output cells” on page 146.

11. Use the General tab as follows.
a. Process Name: Assign a descriptive name. The process name is used as the

box label on the flowchart. It is also used in various dialogs and reports to
identify the process.

b. Output Cell Name: By default, this name matches the Process Name. It is
used in various dialogs and reports to identify the output cell (the set of
IDs that the process produces).

c. (Optional) Link to Target Cell: Perform this step if your organization
pre-defines target cells in a target cell spreadsheet (TCS). To associate the
flowchart process output with cells in the TCS, click Link to Target Cell,
then select a target cell from the spreadsheet. The Output Cell Name and
Cell Code are inherited from the TCS, and both of those field values are
shown in italics to indicate that there is a link relationship. For more
information, read about using target cell spreadsheets.

d. Cell Code: The cell code has a standard format that is determined by your
system administrator and is unique when generated. See “Changing the
cell code” on page 154.

e. Note: Describe the purpose or result of the process. For example, indicate
which records you are including or excluding.

12. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results you expect.

The Segment process
Use the Segment process to divide data into distinct groups, or segments. Connect
a Segment process to a contact process, such as a Call List or Mail List, to assign
treatments or offers to the segments.

For example, you can divide your customers into high-value, medium-value, and
low-value segments based on their prior purchase history. Each segment can
receive a different offer when the segment is input to a contact process. There is no
limit to the number of segments that you can create.

You can segment data in two ways: by using the distinct values in a field, or by
using a query to filter the data in a field. In addition to database table fields, you
can use derived fields to segment data. In this way, you can perform custom
grouping, to segment your customers however you want.
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Note: Segments that are created by the Segment process are not persistent across
flowcharts or sessions. To create a "permanent" segment (also called a strategic
segment), an administrator can use the Create Seg process.

Segmenting considerations
Consider the following options and guidelines when you configure a Segment
process in a campaign flowchart.

Choosing a segmenting method

You can segment by field or by query when you configure a Segment process in a
campaign flowchart.

In some cases, the same results can be achieved when segmenting either by field or
by query. For example, assume that the AcctType field in your database divides
your customer accounts into Standard, Preferred and Premier levels. Segmenting
by the AcctType field will create three segments for these account types.

You could achieve the same results using queries, but creating the segments would
require writing three separate queries. Determine the most efficient method based
on the data that you are segmenting.

Making segments mutually exclusive

You can specify that segments are mutually exclusive, meaning that each
qualifying record is guaranteed to be placed into no more than one segment. When
the segments are assigned to offers, each customer will receive only one offer.

Records are placed in the first segment whose criteria they satisfy, based on a
priority order that you define. For example, if a customer qualifies for segments 1
and 3, and segment 1 is before segment 3 in the priority order, that customer will
appear only in segment 1.

Restricting segment size

When you configure a Segment process, the default size for the number of records
per segment is Unlimited. You may want to restrict the size of the created segment
if, for example, you are performing test runs of a campaign flowchart or process.

You can limit the segment size to any positive integer. If the segment size that you
specify is less than the total number of records generated, the segment will consist
of randomly selected qualifying records.

Selecting source cells

When you configure a Segment process in a campaign flowchart, all selected cells
must be defined at the same audience level. If more than one source cell is
selected, the same segmentation is performed on each source cell.

Using segments as input to another Segment process

Segments can be used as input cells to another Segment process in a campaign
flowchart. For example, you can segment by age range, then further segment by
preferred channel.
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For this example, assume that you want to segment your customers into age
ranges. Your database contains the field AgeRange, which assigns one of six age
ranges (such as 26-30) to each customer. Segment by the AgeRange field to create six
segments.

You could then use these six segments as input to another Segment process that
further divides customers by another field or query. For example, assume that your
database contains a field called PreferredChannel, which specifies each customer's
preferred contact channel: Direct mail, telemarketing, fax, or email. Using the six
age range segments as input, you could then create a second Segment process to
segment by the PreferredChannel field. Each of the six age range segments is
further segmented into four preferred channel segments, to produce a total of 24
output segments.

Segmenting data by field
When you segment data by a field in a database table, each distinct value in the
field creates a separate segment. This option is most useful when the values in the
field correspond to the segments you want to create.

About this task

For example, assume that you want to assign a different offer to customers in each
of 10 regions. Your customer database contains a field that is called regionID,
which indicates the region to which each customer belongs. Segment by the
regionID field to create the 10 regional segments.

Follow these steps to segment data by field.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Segment process from the palette to your flowchart.
4. Connect at least one configured process as input into the Segment process.
5. Double-click the Segment process in the flowchart.

The Segment Process Configuration dialog box opens. Cells from processes
that are connected to the Segment process display in the Input list.

6. On the Segment tab, open the Input list and select the input to the Segment
process. To select multiple cells, use the ellipsis button (...) next to the Input
list.

7. Select Segment by Field and use the list to select the field that you want to
use to create the segments.
The Profile Selected Field window opens, and profiling of the selected field
automatically starts.

8. Wait for profiling to finish to ensure that all segments are properly created.
Then, click OK.
The list of segments and the # of Segments field are updated based on the
profiling results of the selected field. To reprofile the field at any time after
initially selecting it, click Profile.

9. Set the remaining configuration options:
v “Segment process: Segment tab” on page 65
v “Segment process: Extract tab” on page 66
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v “Segment process: General tab” on page 67
10. Click OK.

The process is now configured. You can test the process to verify that it
returns the results you expect.

Segment process: Segment tab
Use the Segment tab of the Segment Process Configuration dialog to indicate how
to divide incoming data into distinct groups, or segments.

The following table describes the controls on the Segment tab of the Segment
Process Configuration dialog.

Table 8. Segment tab

Control Description

Input Specifies the input to the Segment process. The drop-down
list contains all output cells from any process connected to
the Segment process. Select Multiple Cells if you want to
select more than one input.

Segment by field Specifies a field to use for segmenting data. The data is
segmented using the distinct values that exist for the
selected field. Each distinct value in the field will create a
separate segment.

Profile button Opens the Profile Selected Field window, which calculates
the values and distributions of records in the selected field.
Active only when segmenting by field.

Derived Fields button Opens the Create Derived Field window. Active only
when segmenting by field.

Segment by Query Segments data based on a query that you create.

# of Segments Specifies the number of segments to create. Active only
when segmenting by query. By default, three segments are
created, with default names "Segment1," "Segment2," and
"Segment3."

When segmenting by field: The # of Segments field is
updated based on the profiling results of the selected field.

Mutually Exclusive Segments Specifies whether the segment is to be mutually exclusive
(that is, each qualifying record is guaranteed to fall into no
more than one segment).

Create Extract tables Indicates whether the segment should create Extract tables
for each output cell. Selecting this option ensures that
Campaign can provide a later process with the information
necessary to keep track of duplicate target audiences across
segments.

Selecting this check box enables the options on the Extract
tab.

This check box is disabled if Mutually Exclusive Segments
is selected.
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Table 8. Segment tab (continued)

Control Description

Segment Name Lists all segments by name. By default, three segments are
created, with default names "Segment1," "Segment2," and
"Segment3."

When segmenting by field: Segment names are updated
based on the profiling results of the selected field. For
example, if you are segmenting on a field called
"Acct_Status" which has two distinct values "A" and "B",
two segments are created, named "Acct_Status_A" and
"Acct_Status_B."

Max. Size Maximum number of records allowed in each segment.

Size Number of records that meet the criteria for the segment.
Before the process is run, this number defaults to the total
number of records in the output cell.

Query Query that defines the criteria for this segment. Appears
only when segmenting by query.

Up 1, Down 1 Reorder the selected segment. Segments are processed in
the order listed in the table.

New Segment button Opens the New Segment window. Active only when
segmenting by query.

Edit button Opens the Edit Segment window for editing the selected
segment.

Remove Removes the selected segment. When a segment is
removed, the # of Segments field updates automatically.

Do Not Run Subsequent
Processes For Empty
Segments

Prevents processes downstream from this process from
running for empty segments.

Segment process: Extract tab
Use the Extract tab of the Segment Process Configuration dialog to select fields to
extract. In this way, you allow the output from the Segment process to be
accessible as input to Mail List or Call List processes in a flowchart.

The following table describes the fields, buttons, and controls on the Extract tab.

Table 9. Extract tab

Field Description

Target Data Source Location to which the output from this process is written.
The Campaign Server and any other data sources to which
you are connected are available from the Target Data
Source drop-down list.

Candidate Fields List of fields available to extract, including field name and
data type, based on your input data source.

If your input source is a landing page in eMessage, each
field name is an attribute of the landing page. If the
attribute contains special characters or spaces, it is
converted to a valid field name. Data types of all landing
page attributes are listed as text.
Note: Schema object names are limited to 30 characters.
Restrict your attribute names to 30 characters or less to
produce valid column names for extracted output.
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Table 9. Extract tab (continued)

Field Description

Fields to Extract Fields that you selected to extract from the Candidate
Fields list. The Output Name defaults to the field name in
the Fields to Extract column.

Profile button Opens the Profile Selected Field window, which calculates
the values and distributions of records in the selected field.
Active only when a field name is selected in the Candidate
Fields list.

Derived Fields button Opens the Create Derived Field window.

More button Opens the Advanced Settings window, which includes the
option to skip duplicate records and to specify
howCampaign identifies duplicates.

Segment process: General tab
Use the General tab of the Segment Process Configuration dialog to modify the
Process Name, Output Cell names, or Cell Codes, or enter a Note about the
process.

For more information, see these topics:
v “Changing the cell name” on page 153
v “Resetting the cell name” on page 154
v “To copy and paste all cells in the grid” on page 155
v “Changing the cell code” on page 154

Segment process: New Segment and Edit Segment controls
The following table describes the controls on the New Segment and Edit Segment
dialog boxes. You access these dialog boxes when configuring a Segment process.

Note: The New Segment dialog box can be accessed only when you are
segmenting by query. When you segment by field, only the Name and Max. Size
fields can be accessed on the Edit Segment dialog box.

Table 10. New Segment and Edit Segment dialog box controls

Control Description

Name Name of the segment.

Max. Size Maximum number of records that are allowed in the
segment.

Select Based On Specifies a data source on which to base your query.

Select All data source type Includes all the IDs from the data source in the Input
drop-down list.

Select data source type with Provides access to the functions for creating a query to
select only certain IDs based on criteria you define.

Advanced button Opens the Advanced tab, which provides the following
options:

v Use Raw SQL: Use a raw SQL query to segment data.

v Use Query Scope from Input Cell: Available only if a
source cell to this Segment process uses a query. Select
the check box to have the source cell's query combined
(using "AND") with the current selection criteria.

Derived Fields button Opens the Create Derived Field window.
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Table 10. New Segment and Edit Segment dialog box controls (continued)

Control Description

Query text box and buttons For information about using the query text box and related
fields and buttons, see "Creating queries in processes" in
the IBM Campaign Administrator's Guide.

Segmenting data with queries
You can segment data based on the results of a query that you create. This option
is most useful when it is necessary to filter the data in a field to create the required
segments.

About this task

For example, assume that you want to divide your customers into high-value
(more than $500), medium-value ($250-$500), and low-value (under $250) segments
that are based on their purchase history over the last year. The PurchaseHistory
field in your customer database stores the total dollar amount of each customer's
purchases. Use a separate query to create each segment, selecting records with
values in the PurchaseHistory field that meet the criteria of the segment.

Note: You can also use raw SQL to segment data.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Segment process from the palette to your flowchart.
4. Connect one or more configured processes as input into the Segment process.
5. Double-click the Segment process in the flowchart.

The Segment Process Configuration dialog box opens. Cells from processes
that are connected to the Segment process display in the Input list.

6. On the Segment tab, open the Input list and select the input to the Segment
process. To select multiple cells, use the ellipsis button next to the Input list.

7. Select Segment by Query.
8. Determine the number of segments that you want to create, and enter that

number in the # of Segments field.
9. To construct a query for each segment, select the segment and click Edit to

access the Edit Segment window. For details, see “Segment process: New
Segment and Edit Segment controls” on page 67.

10. Set the remaining configuration options:
v “Segment process: Segment tab” on page 65
v “Segment process: Extract tab” on page 66
v “Segment process: General tab” on page 67

11. Click OK.
The process is now configured. You can test run the process to verify that it
returns the results you expect.
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The Sample process
Use the Sample process to divide contacts into groups. The classic use of sampling
is to establish target and control groups that you can use to measure the
effectiveness of your marketing campaign.

Dividing contacts into sample groups
To create target and control groups, use the Sample process. There are several
sampling methods: Random creates statistically valid control groups or test sets.
Every Other X allocates every other record to a sample group. Sequential Portions
allocates a number of records into subsequent samples.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Sample process from the palette to your flowchart.
4. Connect at least one configured process (such as a Select process) as input to

the Sample process box.
5. Double-click the Sample process in the flowchart.

The process configuration dialog appears.
6. Use the Input list to select the cells that you want to sample. The list includes

all output cells from any process connected to the Sample process. To use
more than one source cell, select the Multiple Cells option. If more than one
source cell is selected, the same sampling is performed on each source cell.

Note: All selected cells must be defined at the same audience level, such as
Household or Customer.

7. Use the # of Samples/Output Cells field to specify how many samples to
create for each input cell. By default, three samples are created for each input
cell, with default names Sample1, Sample2 and Sample3.

8. To change the default sample names, double-click a sample in the Output
Name column, then type a new name. You can use any combination of letters,
numbers, and spaces. Do not use periods (.) or slashes (/ or \).

Important: If you change the name of a sample, you must update all
subsequent processes that use this sample as an input cell. Changing a sample
name might unconfigure subsequent connected processes. In general, you
should edit the names of samples before connecting subsequent processes.

9. Use one of the following methods to define the sample size:
v To divide records up by percentages: Select Specify Size By %, then

double-click the Size field to indicate the percentage of records to use for
each sample. Use the Max Size field if you want to limit the size of the
sample. The default is Unlimited. Repeat for each sample listed in the
Output Name column, or use the All Remaining check box to assign all
remaining records to that sample. You can select All Remaining for only
one output cell.

v To specify the number of records for each sample size: Select Specify Size
By # Records, then double-click the Max Size field to specify the maximum
number of records to allocate to the first sample group. Specify the Max
Size for the next sample in the Output Name column or use the All
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Remaining check box to assign all remaining records to that sample. You
can select All Remaining for only one output cell.
(Optional) Click Sample Size Calculator, then use the calculator to
determine the optimal sample size. Ccopy the value from the Min. Sample
Size field in the calculator, click Done to close the calculator, then paste the
value into the Max. Size field for Specify Size By # Records.

10. Ensure that each sample in the Output Name list has a Size defined or has
All Remaining checked.

11. In the Sampling Method section, specify how to build the samples:
v Random Sample: Use this option to create statistically valid control groups

or test sets. This option randomly assigns records to sample groups using a
random number generator based on the specified seed. Seeds are explained
later in these steps.

v Every Other X: This option puts the first record into the first sample, the
second record into the second sample, up to the number of samples
specified. This process repeats, until all records are allocated to a sample
group. To use this option, you must specify the Ordered By options to
determine how records are sorted into groups. The Ordered By options are
explained later in these steps.

v Sequential Portions: This option allocates the first N records into the first
sample, the next set of records in the second sample, and so on. This option
is useful for creating groups based on the top decile (or some other size)
based on some sorted field (for example, cumulative purchases or model
scores). To use this option, you must specify the Ordered By options to
determine how records are sorted into groups. The Ordered By options are
explained later in these steps.

12. If you selected Random Sample, in most cases you can accept the default
seed.
In rare cases, you may want to click Pick to randomly generate a new seed
value, or enter a numeric value in the Seed field. Examples of when you
might need to use a new seed value are:
v You have exactly the same number of records in the same sequence and if

you use the same seed value, records are created into the same samples
each time.

v The random sample produces undesired results (for example, all males are
being allocated to one group and all females to another).

13. If you selected Every Other X or Sequential Portions, you must specify a sort
order to determine how records will be allocated to sample groups:
a. Select an Ordered By field from the drop-down list or use a derived field

by clicking Derived Fields.
b. Select Ascending to sort numeric fields in increasing order (low to high)

and sort alphabetic fields in alphabetical order. If you choose Descending,
the sort order is reversed.

14. Click the General tab if you want to modify the default Process Name and
Output Cell Names. By default, output cell names consist of the process name
followed by the sample name and a digit. You can accept the defaultCell
Codes or uncheck the Auto Generate Cell Code box and assign codes
manually. Enter a Note to clearly describe the purpose of the Sample process.

15. Click OK.
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Results

The process is configured and enabled in the flowchart. You can test run the
process to verify that it returns the results you expect.

About the sample size calculator
Campaign provides a sample size calculator to help determine the statistical
significance of sample sizes in evaluating campaign results.

There are two ways to specify the level of accuracy that you want. You can enter
an error bound and compute the minimum sample size needed, or you can enter a
minimum sample size and compute the error bound that will result. Results are
reported at the 95% confidence level.

Determining the appropriate sample size
The sample size calculator determines the minimum number of contacts to include
in your sample, based on what you consider to be an acceptable margin of error.
Results are reported at a 95% confidence level.

About this task

Determining the appropriate sample size is important when your goal is to make
inferences about a group of people based on a sample. In general, a larger sample
size produces a smaller margin of error. Use the sample size calculator to either
compute the sample size needed for a particular error bound, or to determine the
error bound for different sample sizes.

Procedure
1. On the Sample tab of the Sample process configuration dialog, click Sample

Size Calculator.
The Sample Size Calculator opens.

2. For Response Rate Estimate, enter your best guess for the Minimum and
Maximum response rates that you expect from your marketing campaign.
These two values must be percentages between 0% and 100%. The lower the
expected response rate, the larger the sample size must be to achieve the same
level of accuracy for the measured response rate.

3. If you are not using a predictive model, select No Model under Modeling
Estimate.

4. If you are using a predictive model, select Model Performance, then enter
percentages for the File Depth and Cumulative Gain.
To obtain these values:
a. Open the Evaluate reports in IBM SPSS Modeler Advantage Marketing

Edition, and open the Testing partition.
b. Select the Gains tab, and display the information as a Table.
c. Use a value from the first column (Segment) of the table as the File Depth,

to indicate the percentage of customers that you intend to contact.
d. Use the corresponding value from the last column (Cumulative Gain) of the

table as the Cumulative Gain.
The calculator uses this information to determine the number of samples
that you need to use, based on the expected response rate and modeling
performance.

5. Use either approach:
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v To determine the minimum sample size based on the margin of error that
you are willing to accept: Enter a value of 0% to 100% in the Error Bound (+
or -) field to indicate the percentage margin of error that you are willing to
accept for this sample. Then click Compute Sample Size. The Min. Sample
Size field indicates the smallest sample that will meet the specified error
bound. A smaller Error Bound percentage requires a larger sample size.
Conversely, a larger Error Bound requires a smaller sample size. For
example, a 3% Error Bound requires a larger sample size than if you allow
for a 10% Error Bound.

v To determine the margin of error that will result from a specific sample size:
Enter a value in the Min. Sample Size field to indicate the sample size that
you plan to use, then click Compute Error Bound. Based on the results, you
can decide whether to increase or decrease the sample size. Larger sample
sizes result in smaller Error Bounds. If the resulting Error Bound is too high,
use a larger sample size.

6. After you determine the optimal sample size:
a. Copy the value from the Min. Sample Size field.
b. Click Done to close the calculator.
c. Confirm that Specify Size By # Records is selected.
d. Paste the value into the Max. Size field in the Sample process box.

The Audience process
Audience levels define the target entity that you want to work with, such as
account, customer, household, product, or business division. Use the Audience
process in a flowchart to switch between audience levels or to filter out IDs by
audience level.

Audience levels are defined by an administrator during the table mapping process.
When you use the Audience process in a flowchart, you can specify which
audience levels you want to target in your campaign. For example, you can
configure the Audience process to:
v Select one customer per household based on some business rule (for example,

oldest male or the person with the highest account balance);
v Select all accounts belonging to a particular set of customers;
v Select all accounts with a negative balance belonging to a particular set of

customers;
v Select all households with individuals holding checking accounts;
v Select customers with three or more purchases within a specified time-frame.

The Audience process can select from any defined table(s), so you can use it as a
top-level process in your flowchart to initially select data.

To use the Audience process, you must work with tables for which multiple
audience levels are defined. These levels, defined within a single table, provide a
relationship to "translate" from one level to another.
v One key is defined as the "primary" or "default" key for the table. (This key

represents the audience used most frequently for this data source.) The default
level associated with a table is specified during the table mapping process. For
more information about mapping tables, see the Campaign Administrator's Guide.

v The other keys are "alternate" keys that are available for switching audience
levels.
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After you switch audience levels, Campaign displays only those tables whose
default key is defined at the same audience level. If you work at different audience
levels on a regular basis, you might need to map the same table more than once
within Campaign, each time with a different primary/default key.

Audience levels
Audience levels are defined by IBM Campaign administrators to represent different
potential targets of campaigns, such as account, customer, household, product, or
business division.

Audience levels are often, but not always, organized hierarchically. Here are some
examples of hierarchical audience levels that are commonly found in customer
marketing databases:
v Household > Customer > Account
v Company > Division > Customer > Product

Your organization can define and use an unlimited number of audience levels. If
you are using multiple audience levels (for example, customer and household), it is
important to understand how to use the Audience process to best accomplish your
business objectives.

Audience levels are created and maintained by an administrator. Moving from one
audience level to another requires that all of the audience levels that you use have
keys defined within the same table. This provides a "look up" mechanism to switch
from one level to another.

Audience levels are global, and are attached to each mapped base table. Thus,
when a flowchart is loaded, the audience levels are loaded along with the table
mappings within that flowchart.

If you have permissions to map tables in IBM Campaign, you can map a new table
to one or more existing audience levels, but you cannot create new audience levels.
Only users with the appropriate permissions, usually system administrators, can
create audience levels.

In the Audience process, you specify an input audience level and an output
audience level. The input and output audience levels can be the same (for example,
Customer) or different (for example, Customer and Household). Use the Audience
process to stay within the same audience level, or to switch audience levels.

Householding
Householding is a general term that means reducing the number of members in the
current audience level by scoping using another audience level.

One of the most common examples of householding is to identify a single
individual to target within each household. You might select one individual per
household according to a marketing business rule such as:
v The individual with the greatest dollar value across all accounts;
v The individual with the most purchases in a particular product category;
v The individual with the greatest tenure; or
v The youngest male over 18 within the household.
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You can use the Audience process to change audience levels and filter IDs
according to user-specified criteria.

When to switch audience levels
Some complex campaigns require processing at different audience levels to arrive
at the list of final target entities. This can involve starting at one audience level,
performing some computations and taking this output, then moving to another
audience level, and performing other computations.

For example, you might want to support complex suppressions at different levels.
As a result, in a data model where there is a one-to-many or many-to-many
relationship between customers and accounts, a marketing analyst might want to
build a campaign that does the following:
v Eliminates all accounts of customers that satisfy certain criteria (for example,

eliminate any account that is in default);
v Eliminates particular accounts that satisfy certain criteria (for example, eliminate

all the low-profitability accounts).

In this example, the campaign might start at the customer level, perform
customer-level suppressions (suppress accounts in default), switch to the account
level, apply account-level suppressions (suppress low-profitability accounts), and
then switch back to the customer level to obtain the final contact information.

Example: Audience process
This example shows how to configure an Audience process in a flowchart.

The following figure shows a configured Audience process.

The process is configured as follows:
v The selected input audience level is Customer; it is the default audience level of

the DEMO_ACCOUNT table (this audience level is displayed to the right of the Input
field).

v The output audience level is the same: Customer as defined in the DEMO_ACCOUNT
table. The DEMO_ACCOUNT table has two other audience levels defined: Branch and
HouseHold .
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v The process is configured to choose one Customer Entry per HouseHold based
on the maximum of the field HIGHEST_ACC_IND.

Example: Filtering records
This example explains how to use filtering in an Audience process in a flowchart.

When you configure an Audience process to select IDs based on a count, or a
statistical function ( MaxOf, MedianOf, MinOf) or Any One, the Filter button
becomes available. When you click Filter, the Specify Selection Criteria window
appears, which allows you to enter a query expression to specify which records
will be used in the Based On calculation.

Note: The filtering criteria is applied before the Based On calculation is
performed, allowing you to remove records from consideration.

For example, you might want to constrain the date range over which an operation
is performed. To use only purchase transactions over the last year, you can enter a
filter query expression such as:
CURRENT_JULIAN() - DATE(PURCH_DATE) <= 365

Then, if you are computing a Based On calculation that chooses the sum of the
Amount field, only the amounts from transactions within the last year are summed
together.

Switching and filtering audience levels
Configure an Audience process to switch between audience levels or to filter out
IDs by a specific audience level.

Before you begin

To use the Audience process, you must work with tables for which multiple
audience levels are defined.

About this task

The options that are available in the Audience process configuration dialog depend
on various choices that you can make:
v Whether the input and output audience levels are the same or different
v Whether the audience level values are normalized in these tables
v Whether there are multiple audience levels defined for the selected tables

For this reason, not all of the options described below are available for all pairs of
input and output table selections.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Audience process from the palette to your flowchart.
The Audience process can select from any defined tables, so you can use it as
a top-level process in your flowchart to initially select data. You can also use a
process such as Select or Merge to provide input to the Audience process.

4. Double-click the Audience process in the flowchart.
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5. On the Source tab, open the Input list and specify the data source for the
process. You can select a Segment, a Table, or the output cell from any process
that is providing input to the Audience process.
The audience level for the selected input is displayed next to the Input field.
If there is no input, the audience level is shown as not selected.

Tip: Notice that the Select options indicate the input audience level. For
example, if the audience level is Customer, you can select One Entry per
Customer. If the audience level is Household, you can select One Entry per
Household.

6. Select an output audience level from the Choose Audience list.

Note: If you do not see the expected audience level, you can try remapping a
table.
The Select options now reflect both the input and the output audience levels.
For example, if your input is Household and your output is Customer, the
Select options are labeled All Customer ID Entries, Some Customer ID
Entries, One Customer ID Entry per Household ID.

7. Use the Select and Filter options to specify how to select records. The
available options depend on whether you are selecting All IDs (in which case
filtering is not allowed), switching levels, or staying at the same level. For
details on how to select and filter based on whether you are switching
audience levels, see:
v Using the same input and output audience levels

v Using different input and output audience levels

8. Use the Cell Size Limit tab if you want to limit the number of IDs generated
by the process. This can be useful for test runs.

9. Use the General tab as follows.
a. Process Name: Assign a descriptive name to identify the process in the

flowchart and in various dialogs and reports.
b. Output Cell Name: This name matches the Process Name by default. It is

used in various dialogs and reports to identify the output cell (the set of
IDs that the process produces).

c. (Optional) Link to Target Cell: Perform this step if your organization
pre-defines target cells in a target cell spreadsheet (TCS). To associate the
pre-defined target cell with the flowchart process output, click Link to
Target Cell, then select a target cell from the spreadsheet. The Output Cell
Name and Cell Code are inherited from the TCS, and both of those field
values are shown in italics to indicate that there is a link relationship. For
more information, read about using target cell spreadsheets.

d. Cell Code: The cell code has a standard format that is determined by your
system administrator and is unique when generated. See “Changing the
cell code” on page 154.

e. Note: Describe the purpose or result of the process, such as Contact one
individual per household.

10. Click OK.
The process is now configured. You can test run the process to verify that it
returns the results that you expect.
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Options that are available when using the same input and output
audience levels
When the input and output audience levels are the same in an Audience process of
a flowchart, you can use the following selections to identify the audience.

The Select options vary depending on the relationship of the selected input and
output (Choose Audience) audience levels. Options that are not meaningful are
disabled.

Note: The name of the selected audience level is used in the Select option labels.
For example, if the input audience level is Customer, the One Entry per option
appears as One Customer Entry per.

The Select options include:

One Per One member of the input/output audience level,
scoped by another audience level.

For example: One customer per household.

See “Selecting one <Input/Output Audience> entry per
<Different Audience>.”

Some Per Some members of the input/output audience level,
scoped by another audience level.

For example: All customers in the household with
above average purchases.

See “Selecting some <Audience> records per <Different
Audience>” on page 78.

For Each Select members if the number of members at the
selected audience level satisfies some condition.

For example: Number of accounts > 1, or number of
purchases > 3.

See “Selecting entries for each entry at that audience
level” on page 79.

Selecting one <Input/Output Audience> entry per <Different Audience>:

Choose this option if the input and output audience levels are the same, but a
different audience level is used to scope the output.

About this task

An example is to select the one customer in each household who has the oldest
account. (Input audience level is customer, output audience level is customer,
scoping by Household level, using MinOf(BaseInfo.AcctStartDt) to select.) Specify
a business rule to indicate how the single entity is selected (for example, the
minimum, maximum, or median of some field), or else choose Any One (in this
case, no field choices are available).

Procedure

1. In the Audience process, select an input source for Input. Select the same
audience level for the output audience.
The relevant Select options become available.
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2. Select the One Entry per option.
3. Select an audience level from the list.

All alternate defined audience levels (other than the input audience) appear in
the list.

4. Choose a value from the Based On list:
v Any One eliminates the need to pick a Based On value
v MaxOf returns the maximum value of the selected field
v MedianOf returns the median value of the selected field
v MinOf returns the minimum value of the selected field
Each of these functions will return exactly one member from the input audience
level. If more than one entry is tied at the maximum, minimum, or median
value, the first encountered entry is returned.

5. If you selected a Based On criterion other than Any One, select a field on
which the function operates. This list includes all the fields from the table
selected in the Choose Audience field, and any mapped dimension tables.
Expand a table by clicking the " + " sign. Created derived fields are listed at the
bottom.
For example, to select the account holder from each household with the highest
account balance, you would select MaxOf for the Based On criteria and
Acct_Balance from the list of table fields.
You can also create or select derived fields by clicking Derived Fields.

6. (Optional) If you selected a count to be based on, the Filter button becomes
available.
Use the Filter function to reduce the number the IDs that will be available to
the Based On calculation. For example, you might want to select customers
based on their average account balance in the last 6 months, but prior to doing
that, you would want to filter out all customers whose accounts are inactive.
To filter records before performing the Based On computation, click Filter. The
Specify Selection Criteria window appears. You can enter a query expression to
specify which records will be used in the Based On calculation. The filtering
criteria is applied before performing the Based On calculation, thereby
allowing you to remove records from consideration.

7. Click OK to save your query and close the Specify Selection Criteria window.
8. Continue configuring the Audience process by completing the fields on the

remaining tabs.

Selecting some <Audience> records per <Different Audience>:

This selection indicates that there are multiple entries per audience.

About this task

In this situation, the input and output audience levels are the same, but a different
audience level is used to scope the output. For example, select all customers within
each household who have made purchases over $100 (Input audience level is
customer, output audience level is customer, scoping by Household level, using
Maximum Purchase Value>$100.)

In addition to creating a query, the Based On criterion also supports keywords
allowing the functional equivalent of a GROUPBY macro function to be performed.
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Procedure

1. Select an input source for Input and the same audience level for the output
audience in the Audience process. The relevant Select options become available.

2. Select the Some Entries per... option. A list appears next to the selected option.
3. Select an audience level from the list. All alternate defined audience levels

(other than the input audience) appear in the list.
4. Click in the Based On field to enter a query. The Specify Selection Criteria

window opens.
5. Enter or build a valid query expression, then click OK to save it and close the

Specify Selection Criteria window.
6. Continue configuring the process by completing the fields on the remaining

tabs.

Selecting entries for each entry at that audience level:

This selection indicates that there are multiple selections from multiple audience
levels.

About this task

Select this option if the number of members at the selected audience levels satisfies
some condition (for example, Number of Accounts > 1 or Number of Purchases > 3
).

Note: This option is available only if the input audience level is not normalized
(that is, the record ID is not unique in the selected Choose Level table), and the
input and output levels are the same. It is the only option available if no alternate
keys have been defined for your output audience table.

Procedure

1. Select an input source for Inputand the same audience level for the output
audience in the Audience process.
The relevant Select options become available.

2. Select the For Each option.

Note: This option is available only if the input audience level is not
normalized (that is, the record ID is not unique in the selected Choose Level
table).
A list appears next to the selected option.

3. Choose a Based On selection.
If the table you select under Choose Audience (that is, the output audience) is
not normalized, there might be duplication in your results. You can use a Based
On method for Campaign to use when selecting records, to avoid duplication.
(For example, if your results might include more than one individual in the
same household, you can use Based On to select only one individual from that
household, based on the criterion you configure in this feature.)
You must select one of the Based On methods, either Count or Condition:
v Specify a Count to use in Based On:
This option lets you select the <Input Audience Level> ID, where the number
of occurrences of the <Input Audience Level> ID satisfies the specified
condition.
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To toggle between different relationships (<,<=,>,>=,=), click the operator
button repeatedly until the desired relation is displayed.
-- OR --
v Specify a Condition to use in Based On:
Click in the text box to the right of Condition.
The Specify Selection Criteria window appears.
Enter or build a valid query expression, then click OK to save your entry and
close the Specify Selection Criteria window.

4. (Optional) If you selected a count to be based on, Filter becomes available.
Use the Filter function to reduce the number the IDs that will be available to
the Based On calculation. For example, you might want to select customer IDs
based on their average account balance in the last six months, but before doing
that, you would want to filter out all customers whose accounts are inactive.
To filter records before performing the Based On computation, click Filter. The
Specify Selection Criteria window appears. You can enter a query expression to
specify which records will be used in the Based On calculation. The filtering
criteria is applied before performing the Based On calculation, allowing you to
remove records from consideration.

5. Click OK to save your query and close the Specify Selection Criteria window.
6. Continue configuring the process by completing the fields on the remaining

tabs.

Options that are available when using different input and output
audience levels
When the input and output audience levels are different in an Audience process of
a flowchart, you can use the following selections to identify the audience.

Note: The name of the selected audience level is used in the Select option labels.
For example, if the input audience level is Customer, the One Entry per option
appears as One Customer Entry per. In the following sections, this dynamically
changing portion of the option text is indicated with <Input/Output Audience>
where appropriate.

The Select options include:

All Select all members of the input audience level, scoped
by another audience level. For example: All customers
per household.

See “Selecting all <Output Audience Level> entries” on
page 81.

Some Select some members of the output audience level,
keeping only those IDs that satisfy a specified
condition. For example: All customers aged 18 or over
within a household.

See “Selecting some <Different Output Audience Level>
entries” on page 81

One Per Select exactly one output audience record for each input
audience record. For example: One customer per
household.

See “Selecting one <Output Audience> per <Different
Input Audience>” on page 81.
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Selecting all <Output Audience Level> entries:

Select this option to switch to the output audience level without performing any
filtering. For example, you can select all customers in a household or all accounts
belonging to a customer.

About this task

This option creates an output cell with all output audience level entries associated
with the input IDs. It switches audience levels without applying any selection or
filtering criteria.

If you change from a primary audience level to another audience level, you will no
longer be able to use derived fields in downstream processes.

Procedure

1. Select an input source for Input and a different output audience for Choose
Audience.
The Select options become available.

2. Select All <Output Audience Level> Entries.
3. Click OK.

Selecting some <Different Output Audience Level> entries:

Select this option to switch from the input audience level to a different output
audience level, keeping only those IDs that satisfy a specified condition. For
example, you could select all customers aged 18 or over within a household, or
select all accounts of a customer with positive balances.

Procedure

1. Select an input source for Input and a different output audience for Choose
Audience.
The Select options become available.

2. Click to select Some <Output Audience Level> Entries.
The Based On field becomes available.

3. Click in the Based On field to enter a query.
The Specify Selection Criteria window appears. The Based On criteria allows
you to enter a query expression to limit the output audience level entries
selected.

4. Enter or build a valid query expression, then click OK to save the query and
close the Specify Selection Criteria window.

5. Click OK to close the Audience process configuration dialog, saving your
entries.

Selecting one <Output Audience> per <Different Input Audience>:

Select this option to choose exactly one output audience record for each input
audience record (for example, to choose one email address per customer).
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About this task

You must specify a business rule to indicate how the single entity should be
selected (min/max/median of some field) or choose Any One (in this case, no
field choices are available).

This option is available only if the input audience level is not normalized (that is,
the record ID is not unique in the selected Choose Level table).

In addition to creating a query, the Based Oncriterion also supports keywords
allowing the functional equivalent of a GROUPBY macro function to be performed.

Procedure

1. Select an input source for Input and an output audience for the Audience
process.
The Select options become available.

2. Select One <Output Audience Level> per <Input Audience Level>.
3. Select a value from the Based On drop-down list.

(Field selection, using the drop-down list to the right, becomes inactive when
you select Any One. If this is your selection, skip to step 5.)

4. Select a field in the next drop-down list to which the Based On function
relates:
a. Click in the Based On text box.

The Select Field window appears. All fields from the table selected in the
Choose Audience drop-down list appear, including any mapped dimension
tables.
You can expand a table by clicking the "+" sign. Created derived fields are
listed at the bottom.

b. Select a field and click OK.
c. (Optional) Create derived fields by clicking Derived Fields.

5. (Optional) To filter records before performing the Based On computation, use
Filter.

6. Click OK.

The Extract process
Use the Extract process to select fields from one table and write them out to
another table for subsequent processing. The Extract process is designed to pare
down a large amount of data to a manageable size for subsequent operations,
resulting in vast performance improvements.

The Extract process can take input from a cell, single table, strategic segment,
optimized list (Contact Optimization only), or eMessage landing page (eMessage
only). If you select a strategic segment as input, you must join it to a table before
you can extract fields.

If you use several Extract processes in a series, only the fields in the final Extract
process are written out.

If you use several Extract processes in parallel (in different branches in the same
flowchart), they behave the same as persistent derived fields:
v The extracted fields attach to the inbound cell
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v The extracted fields are calculated before query execution in that process
v Multiple extracted fields are available in subsequent processes
v When extracted fields are sent to a contact process:

– If an extracted field is not defined for a cell, its value = NULL
– If a single ID is in more than one cell, one row is output for each cell

v When extracted fields are sent to a Segment or Decision process, the extracted
field must exist in all selected input cells for it to be used in segmenting by
query.

Extracted tables

Data is extracted as either a binary file on the Campaign server or as a table with a
UAC_EX prefix.

Extract tables are not deleted at the end of a flowchart run. An extract table
persists so that users can continue to access it to perform operations such as
profiling its fields.

An extract table is deleted only when you delete its associated Extract process,
flowchart, campaign, or session.

Note: To conserve space, system administrators can periodically delete tables with
a UAC_EX prefix. However, if these tables are removed, you must rerun the
affected Extract processes before you rerun flowcharts or profile fields in the
now-missing tables. Otherwise, Campaign generates "Table Not Found" errors.

Example: Extracting transaction data
This example explains how to use the Extract process to obtain data about
purchase transactions.

Assume that you designed a campaign to perform selections or calculations based
on the last three months of purchase transactions for all non-delinquent customers
(approximately 90% of your customer base), resulting in 4 Gb of data.

Even if IBM Campaign created a temporary table for these customers, joining it
back to the purchase transaction table would entail pulling over approximately
90% of the 4 Gb rows (and discarding all transactions except for the last three
months) to execute a GROUPBY macro, for example.

Instead, you can configure an Extract process (placed at the purchase transaction
level) to pull out all transactions within the last three months, put them into a
table in the database, and then subsequently run multiple GROUPBY macros and
other calculations against it (for example, min/max and average).

Prerequisites for extracting data from eMessage landing
pages

Several prerequisites must be met before you can configure an Extract process to
accept input from eMessage landing pages.
v eMessage must be installed, running, and enabled.
v eMessage landing pages must be appropriately configured.
v The mailing must be executed and responses from mailing recipients must be

received.
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For more information about eMessage landing pages, see the eMessage User's Guide.

Extracting subsets of data for further processing and
manipulation

Use the Extract process to pare down a large amount of data to a manageable size
for subsequent operations, resulting in performance improvements.

The procedure for configuring the Extract process differs depending on whether
you are extracting data from a cell, table, or strategic segment or from an eMessage
landing page.

To extract data from an optimized list, see the Contact Optimization User's Guide.

Extracting data from a cell, table, or strategic segment
Follow this procedure to obtain data from an input cell, such as a Select process, a
single table, or a strategic segment. In this way, you can pare down a large amount
of data to a manageable size for subsequent operations, resulting in improved
performance.

Procedure
1. Within a campaign, open a flowchart for editing.

2. Drag the Extract process from the palette to your flowchart.
3. Double-click the Extract process in the flowchart.

The process configuration dialog opens.
4. On the Source tab, select an input cell, a single table, or a strategic segment

from the Input list. If you select a strategic segment, associate it with a table
by selecting a table from the Select Based On list.

5. Specify the records to use as input:
v Choose Select All Records to include all records from the input data

source.
v Choose Select Records With to select records by doing a query.

6. If you chose Select Records With, create a query by using one of the
following methods.

Note: For complete instructions, see Chapter 6, “Using queries to select data,”
on page 115.
v Point & Click: Click in the Field Name, Oper., and Value cells to select

values to build an expression. Use And/Or to combine expressions. This
method provides the easiest way to create a query and helps to avoid
syntax errors.

v Text Builder: Use this tool to write raw SQL or use the provided macros.
You can use the Formula Helper within Text Builder to select supplied
macros, including logical operators and string functions.

With either method, you can select fields from the Available Fields list, which
includes IBM Campaign Generated Fields and Derived Fields.

Note: If your query includes a table field that has the same name as a
Campaign Generated Field, you must qualify the field name. Use the
following syntax: <table_name>.<field_name>

7. On the Extract tab, use the Target Data Source field to select an output
location:
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v To store the data in binary format, select IBM Campaign Server.
v To store the data in a uniquely named table with a UAC_EX prefix, select an

available database.
8. On the Extract tab, select fields from the list of Candidate Fields and add

them to the Fields to Extract list. Use the controls to remove or reorder fields.
For information about using the Extract tab, see “Extract tab reference” on
page 87.

9. Optionally, use the Cell Size Limit tab to limit the number of IDs generated
by the process. See “Limiting the size of output cells” on page 146.

10. Optionally, use the Dimension tab to add existing dimension tables to the
extract table and specify the key fields to join on. The extract table becomes a
base table for the selected dimension tables and can be used in downstream
processes.

11. Use the General tab as follows.
a. Process Name: The process name is used as the box label on the flowchart.

It is also used in various dialogs and reports to identify the process.
b. Output Cell Name: This name matches the Process Name by default. It is

used in dialogs and reports to identify the output cell (the set of IDs that
the process retrieves).

c. (Optional) Link to Target Cell: Perform this step if your organization
pre-defines target cells in a target cell spreadsheet (TCS). To associate the
pre-defined target cell with the flowchart process output, click Link to
Target Cell, then select a cell from the spreadsheet. The Output Cell Name
and Cell Code are inherited from the TCS, and both of those field values
are shown in italics to indicate that there is a link relationship. For more
information, read about using target cell spreadsheets.

d. Cell Code: The cell code has a standard format that is determined by your
system administrator and is unique when generated. See “Changing the
cell code” on page 154.

e. Note: Describe the purpose or result of the process. Common practice is to
reference the selection criteria.

12. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results you expect.

Extracting data from an eMessage landing page
You can use the Extract process in a flowchart to extract data from an eMessage
landing page. The Extract process selects fields from one table and writes them out
to another table for subsequent processing.

Before you begin

Ensure that your IBM environment meets the requirements before attempting to
extract eMessage landing page data. For more information, see “Prerequisites for
extracting data from eMessage landing pages” on page 83.

Procedure
1. In a flowchart in Edit mode, double-click the Extract process in the flowchart

workspace.
The process configuration dialog appears.
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2. On the Source tab, select eMessage Landing Pages.
3. In the popup window, select an eMessage landing page as input.

Note: You can select only one eMessage landing page as input to an Extract
process. To extract data from more than one landing page, configure multiple
Extract processes.

4. If there is more than one audience level available for the landing page, select
the appropriate audience level from the drop-down list. If there is only one
audience level available, it is automatically selected.

5. Click OK.
6. On the Extract tab, select an output location.

v To store the data in binary format, select IBM Campaign Server.
v To store the data in a uniquely named table with a UAC_EX prefix, select an

available database.
7. Select fields to extract from the list of Candidate Fields.

v Click Add to add selected fields to the list of Fields to Extract.
v To remove fields from the list of Fields to Extract, select them and click

Remove.
v Use the Up 1 and Down 1 buttons to change the order of fields in the Fields

to Extract list.
v To change the default output name of a field to extract, select the field in the

Fields to Extract list, click the name in the Output Name column, then enter
the new name.

For information about the fields on the Extract tab, see “Extract tab reference”
on page 87.

8. Perform any of the following optional tasks:
v Add a derived field to the list of candidate fields. See “Derived fields” on

page 189
v Specify that duplicate IDs are excluded from the output. See “Skipping

duplicate IDs in process output” on page 112.
v Limit the size of the output cell (that is, limit the number of IDs generated

by the process). See “Limiting the size of output cells” on page 146.
v Click the General tab to modify the Process Name, Output Cell names, or

Cell Codes, link to a target cell, or enter a Note about the process.
For information about linking to target cells, see “Linking flowchart cells to
targeted offers defined in a TCS” on page 163.

Note: Profiling is not available for eMessage landing page attributes.
9. Click OK.

Results

The process is configured. You can test the process to verify that it returns the
results you expect.

Note: During the extraction process, Campaign creates an intermediate view in the
system tables database with a UCC_LPV prefix. This internal view remains in the
database until the process box is deleted. If you remove the view, you must
reconfigure its corresponding Extract process before rerunning the process or
flowchart; otherwise, Campaign generates a missing table error.
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Extract tab reference
Use the fields on the Extract tab when you configure an Extract process in a
flowchart.

Table 11. Fields on the Extract tab

Field Description

Target Data Source Location to which the output from this process will be
written. The IBM Campaign Server and any other data
sources to which you are connected are available from the
Target Data Source drop-down list.

Candidate Fields List of fields available to extract, including field name and
data type, based on your input data source. To see the list
of fields, you may need to click the arrow next to an item
to expand the item.

If your input source is a landing page in eMessage, each
field name is an attribute of the landing page. If the
attribute contains special characters or spaces, it is
converted to a valid field name. Data types of all landing
page attributes are listed as text.
Note: Schema object names are limited to 30 characters.
Restrict your attribute names to 30 characters or less to
produce valid column names for extracted output.

Fields to Output Fields that you chose to extract from the Candidate Fields
list. The Output Name defaults to the field name in the
Fields to Extract column.

Profile button Click Profile to preview a list of values in the selected
candidate field.

Derived Fields button Click Derived Fields to create a variable in the list of
candidate fields. Derived fields are variables that do not
exist in a data source and are created from one or more
existing fields, even across different data sources.

More button Click More to open the Advanced Settings dialog. This
dialog includes the option to exclude duplicate IDs from
the output and specify how Campaign identifies duplicates.

The Snapshot process
Use the Snapshot process to capture data for export to a table or a file.

To make sure that duplicate rows are not exported, set Skip Records with
Duplicate IDs to Yes in the snapshot configuration. Or you can use an Extract
process and then snapshot the results.

To associate or track offers with the list, use the snapshot as input to a Mail List or
Call List process. When you configure the Mail List or Call List process, export the
necessary data to an alternate location (either a file or a table).

Taking a snapshot of data
Use the Snapshot process to capture data for export to a table or file. Select the
source of the values that you want to capture and define the output table or a file
for those values.
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Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Snapshot process from the palette to your flowchart.
4. Connect one or more processes to provide input to the Snapshot process.

Note: All of the cells that you select as input must have the same audience
level.

5. Double-click the Snapshot process in the flowchart workspace.
The Process Configuration dialog opens.

6. Use the Snapshot tab to specify how to capture data.
a. Use the Input list to specify which cells to use as the data source for the

snapshot.

Note: If the Snapshot process is not connected to a process that provides
output cells, there are no cells to select from in the Input list. The Multiple
Cells option is only available if the input process generates multiple cells.

b. Use the Export To list to specify the table or file for the Snapshot output.

Note: You can test the Snapshot process by running the process with
output exported to a temporary file that you can review.
v If the table that you want to use is not in the list, or if you want to

output to an unmapped table, select Database Table. Use the Specify
Database table dialog box to specify the table and database names. User
variables are supported in the table name you specify here.

v If you select File from the Export To list, you can specify the type of file
you want to write the output to, the file name, and corresponding data
dictionary.

v If you want to create a new user table, select New Mapped Table from
the Export To list. For instructions, see the IBM Campaign Administrator's
Guide.

v You can also export to an extract table.
c. Select an option to specify how updates to the output file or table are

handled:
v Append to Existing Data. Add the new information to the end of the

table or file. If you select this option for a delimited file, labels are not
exported as the first row. This is a best practice for database tables.

v Replace All Records. Remove any existing data from the table or file,
and replace it with the new information.

v Update Records. Available only if you are exporting to a table. All fields
that are specified for the snapshot are updated with the values from the
current run of the process.

v Create New File. Available only if you are exporting to a file. This
option is selected by default if you are exporting to a file. Each time that
you run the process, a new file is created with "_1," "_2" and so on,
appended to the file name.

7. Specify which fields to snapshot.
a. Use the Candidate Fields list to select the fields that you want to include

in your output.
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You can use Campaign Generated Fields by expanding the list of
Campaign Generated Fields, or use derived fields by clicking Derived
Fields. Select multiple fields by using Ctrl+Click, or select a contiguous
range of fields by using Shift+Click.

b. Move the selected fields to the Fields to Snapshot list by clicking Add.
c. If you selected a table as the snapshot destination, the fields in that table

display in the Candidate Fields list under the Field Name column. You
can automatically find matching fields by clicking Match. Fields with exact
matches for the table field names are automatically added to the Export
Fields list. If there are multiple matching fields, the first match is taken.
You can manually modify the pairings by clicking Remove or Add.

d. You can reorder the fields in the Fields to Snapshot list by selecting a field
and clicking Up1 or Down1 to move it up or down in the list.

Note: To view the values in a field, select the field in the Candidate Fields
list and click Profile.

8. To skip records with duplicate IDs or to specify the order in which records are
output, click More.
The Advanced Settings window opens.
a. To remove duplicate IDs within the same input cell, select Skip Records

with Duplicate IDs. Then choose the criteria to determine which record to
retain if duplicate IDs are found. For example, you can select MaxOf and
Household_Income to specify that when duplicate IDs are found,
Campaign exports only the ID with the highest household income.

Note: This option removes duplicates only within the same input cell.
Your snapshot data can still contain duplicate IDs if the same ID displays
in multiple input cells. To remove all duplicate IDs, use a Merge or
Segment process upstream of the Snapshot process to purge duplicate IDs
or to create mutually exclusive segments.

b. To sort the snapshot output, select the Order By check box, then select the
field to sort by and the sort order. For example, you can select Last_Name
and Ascending to sort IDs by surname in ascending order.

9. Click OK.
10. (Optional) Click the General tab to assign a name and descriptive note.

The name displays on the process box in the flowchart. The note displays
when you hover the cursor over the process box in the flowchart.

11. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results you expect.

The Schedule process
Use the Schedule process to initiate a process, a series of processes, or an entire
flowchart. The Schedule process works only if the flowchart is running.

A Schedule process is active for a defined period of time. During that time,
specified events might occur that cause subsequent connected processes to begin
running. The most common use of the Schedule process is to control timing of the
entire flowchart.
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Note: A flowchart can include multiple Schedule process boxes as long as they are
in independent branches. However, errors can occur if a process has more than one
Schedule ancestor in different ancestral branches leading to the same process.

You can configure a Schedule process to define the total scheduling period by
setting up a time limit in days, hours, and minutes starting from when the process
begins running.
v You can schedule a process to run in a variety of ways, including repetitively, by

trigger, and by calendar.
v You can combine multiple scheduling options. For example, you can schedule a

process to run every Monday at 9:00 a.m., and whenever it is triggered by a
specific event, such as a visit to the website.

v You can schedule a batch process, for example, to run late at night when it will
not interfere with daytime jobs.

There are no limits on the number of options that you can use simultaneously in
scheduling a flowchart, as long as the selections do not conflict. (For example, you
cannot schedule a flowchart to run both "Once Only" and "Every Monday.")

In general, a process runs only when all of its inputs have run successfully (that is,
when all processes connected to the current process have run, even if the
dependency is only temporal). However, when multiple schedule inputs exist
within a branch, the process will run whenever any one of its inputs completes (an
"OR" rather than an "AND" of its inputs).

A contact process with tracking enabled contains an inherent schedule. Using a
Schedule process in the middle of a flowchart is an advanced feature. Make sure
that you are getting the desired behavior and correct results.

Note: If the Schedule process in your flowchart tells the flowchart to run before a
previous run is complete, Campaign holds the request until the previous run is
finished. Only one run can be held in this manner. In certain cases, this might
mean that the flowchart does not run as many times as you expect.

For example, if your flowchart takes two hours to run, and you have a Schedule
process that tries to trigger three runs that are only 10 minutes apart, Campaign
will start the first run. When the Schedule process attempts to start the second run,
Campaign will queue it. When the Schedule process attempts to start the third run,
Campaign will ignore it. When the first run is finished, Campaign will start the
second run. The third run will never start.

Difference between the IBM Campaign Schedule process and
IBM EMM Scheduler

Starting with the 8.0 release of Marketing Platform, the IBM EMM Scheduler is
intended to replace the Campaign Schedule process for scheduling runs of an
entire flowchart. The IBM EMM Scheduler is more efficient, as it does not consume
any server system resources when the flowchart is not actually running.

The IBM EMM Scheduler starts a flowchart even if it is not running, while the
Campaign Schedule process in a flowchart works only if the flowchart is running.

The Campaign Schedule process is preserved for full compatibility with earlier
versions, and for other use cases not handled by the IBM EMM Scheduler. For
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example, you might want to use the Campaign Schedule process to send
Campaign triggers or to delay execution of dependent processes.

Do not use the IBM EMM Scheduler to schedule a flowchart that uses the
Campaign Schedule process as the top-level process that starts a flowchart run.
Typically, only one or the other is necessary. However, if the Schedule process
appears in a flowchart that is started by the IBM EMM Scheduler, it functions as
configured; conditions required by the IBM EMM Scheduler and the Schedule
process must be met before subsequent processes run.

Unlike the IBM EMM Scheduler, the Campaign Schedule process can send external
triggers to call command-line scripts. The IBM EMM Scheduler can send triggers
only to its own schedules.

Inbound and outbound triggers
You can configure the Schedule process to be triggered by an event and to trigger
events upon completion. Use Tools > Stored Triggers to define triggers, then call
the triggers by configuring the Schedule process in a flowchart.

Note: For performance advantages, use the IBM EMM Scheduler to send triggers
to Campaign. To learn more about the Scheduler, see the Marketing Platform
Administrator's Guide.

Inbound triggers: Events that activate the Schedule process

An inbound trigger is an external event that sets a flowchart or campaign in
motion. A trigger can be anything that you define. Examples include clicking a
website link, receiving an email message, a telemarketer's response indicator,
completion of a database upload, or any other defined event.

To specify inbound triggers that activate the Schedule process, configure the
Schedule process and select Custom Run from the Schedule to Run list, then use
the Run On Trigger(s) option.

The Run On Trigger(s) option uses unica_actrg (included with your Campaign
installation) to run. To understand how Run On Trigger works behind the scenes,
it is helpful to look at an example: “Example: Run on Trigger” on page 92.

Outbound triggers: Events activated by the Schedule process

An outbound trigger executes a command line, which can be a batch file or a
script. Campaign can run one or more triggers each time the Schedule process
activates the trigger names in the Send Trigger(s) After Each Run field. If you
specify multiple trigger names, they must be separated by commas.

This function allows you to send an outbound trigger to an executable file. The full
path and the name of the file must be defined in the Stored Trigger Definitions
dialog. Each time that the Schedule process is activated, Campaign runs the
specified executable file.

Using triggers with other scheduling options

Triggers can be used with any other scheduling options or alone. Used in
combination, you can, for example, set up a flowchart to run every Monday at 9:00
a.m. as well as every time someone clicks on an internet banner advertisement.
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If, for example, you scheduled the flowchart to Run On Trigger(s) based on hits
on a website, and you also specify a Delay Period Before Each Run, the flowchart
will not begin until both the event (the Web hit) occurs and the delay period
expires.

Example: Run on Trigger
An online retailer has a cross-sell campaign that runs on a trigger, so that when a
customer makes a purchase, it triggers cross-sell offers.

Specifically, when the customer makes a purchase:
v The website runs the unica_actrg executable, passing the campaign code and the

trigger name (web_purchase).
v The Campaign listener checks that the campaign is active and the trigger name

exists, then runs the Schedule process, and the campaign flowchart is triggered.
For more details about triggers, see the Campaign Administrator's Guide.

Scheduling processes in a running flowchart
Configure the Schedule process to initiate processes in a running flowchart. The
Schedule process works only if the flowchart is running.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Schedule process from the palette to your flowchart.
4. On the Schedule tab, specify the scheduling conditions.

a. Specify a value for Total Schedule Period by entering the appropriate
values in the Days, Hours, and Minutes fields. The total schedule period is
the total time over which the Schedule process is to be active. By default,
the total schedule period is set to 30 days.

b. Select a run frequency from the Schedule to Run drop-down list, to specify
exactly when the Schedule process will activate subsequent connected
processes.
v If you select the Once Only option, the flowchart will run exactly once,

regardless of what other schedule options have been added. If any other
value is selected, then the scheduling options are connected as OR
statements and the Schedule process kicks off any process to which it is
connected when any option is satisfied.

v The first option that is satisfied will begin the Schedule run. If Schedule
To Run is the only option enabled and the setting is Once Only, the
process runs immediately (unless a delay or user authorization has been
enabled).

v The Hours and Minutes fields enable you to specify the time at which
you want the schedule to run. The time entry form is based on a 24 hour
clock (also referred to as "military time"). In other words, 9 hours 30
minutes is 9:30 a.m., and 22 hours 45 minutes is 10:45 p.m. Because the
time base is 24 hours, there is no need to designate a.m. or p.m.

5. If you select Custom Run from the Schedule to Run list, you can use one or
both of the following options to specify when the schedule runs:
v Choose Run On Time, then specify dates and times for the process to run.

Multiple entries must be separated by commas. Click Calendar to select
dates and times from a calendar.
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v Choose Run On Trigger(s) if you want the schedule to be triggered by an
event.
The named trigger(s) must be defined using Tools > Stored Triggers. Enter
the name of each trigger that can activate this Schedule process. Separate
multiple triggers with commas. The trigger name can contain any characters
except commas. A trigger name does not have to be unique. You can use the
same trigger in multiple campaigns or flowcharts and activate them all at the
same time.
For more information, see “Inbound and outbound triggers” on page 91.

6. Use one or both of the following options if you want to specify a delay or
require authorization.
v If you choose Wait for User Authorization Before Each Run, a prompt for

user authorization will appear each time any other schedule conditions are
satisfied, and the Schedule process will not activate unless specific
authorization is provided. This option takes precedence over any other
schedule indicators; the process will not start unless authorization is given.

Note: When a flowchart is running with a client attached, user authorization
can only occur through the client. If no client is attached, any user with
read/write privileges for the campaign can authorize it to continue.

v If you choose Delay Period Before Each Run, specify the amount of time to
wait after a schedule condition has been satisfied before the process runs,
using the Days, Hours, and Minutes fields. This delay applies to all other
specified schedule options. For example, if a Schedule process is configured
to run at 9:00 a.m. on Monday morning with a delay of one hour, subsequent
processes will begin to run at 10:00 a.m.

7. (Optional) Specify triggers to send after the Schedule run is completed.
If you select the Send Trigger(s) After Each Run check box, Campaign runs
one or more triggers each time the Schedule process is activated. An outbound
trigger executes a command line, which can be a batch file or a script file. Any
named triggers must be defined using Tools > Stored Triggers. If you specify
multiple trigger names, they must be separated by commas.

8. (Optional) Click the General tab to assign a name and descriptive note.
The name appears on the process in the flowchart. The notes appear when you
point to the process in the flowchart.

9. Click OK.

Results

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

The Cube process
Administrators use the Cube process to allow users to drill into data from multiple
sources. Data cubes consist of dimensions that are based on strategic segments.

The Cube process is intended for technical users or IBM consultants. A best
practice is to create all global constructs, such as cubes and strategic segments, in
the Sessions area of the application.
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Users can select one or more defined segments, create a cube, and then drill into
the data to select a target audience. The audience can then be converted into the
appropriate processes, such as Select, for inclusion in a flowchart.

Creating a multi-dimensional cube of attributes
Configure a Cube process to create a multi-dimensional cube of attributes. Any
cubes created in the Sessions area will be available globally.

Before you begin

Before you can create a cube using a Cube process, you must create a strategic
segment or dimension hierarchy.

About this task

Procedure
1. Open a session flowchart.
2. Click the Edit icon in the flowchart window.

3. Drag the Cube process from the palette to your flowchart.
4. Double-click the Cube process in the flowchart workspace.
5. On the Source tab, use the Input Segments list to select one or more

segments as input for the cube.

Important: If you select more than one source segment, ensure that they all
have the same audience level.

6. Click the Cube Definitions tab to define your cube.
From the Cube Definitions window you can:
v Click Add to add a new cube.
v Select an existing cube and click Edit to modify it.
v Select an existing cube and click Remove to delete it.

7. To add a cube:
a. Click Add.
b. Enter a name and description.
c. Select up to three dimensions from the corresponding lists. The dimensions

must be related to the strategic segments that the cube source is based on.
d. Click OK. The Edit Cube window closes and the new cube definition is

displayed in the list of cubes on the Cube Definitions tab.
8. Click the Select Additional Fields to Track tab to specify additional fields for

tracking.
From the Select Additional Fields window you can:
v Select and move the fields you want to track from the Available Fields list

to the Selected Fields list, using the Add>> button
v Click Derived Fields to select or create derived fields to track.
v Click Profile to see the contents of the selected field.

9. (Optional) Click the General tab to assign a name and descriptive note.
The name appears on the process in the flowchart. The notes appear when
you mouse over the process in the flowchart.

10. Click OK.
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The process is configured. You can test the process to verify that it returns the
results you expect.

Related concepts:
“About cubes” on page 220
“About dimension hierarchies” on page 217

The Create Seg process
Use the Create Seg process to create lists of audience IDs from customer database
tables. Define the Create Seg process in the Sessions area of Campaign so that the
segments are available globally for use in all campaigns.

The Create Seg process is intended to be used by Campaign administrators. A
Create Seg process that is defined in a session flowchart creates a strategic segment,
which can then be used in any flowchart. The segments can then be used as input
for processes. They can also be used to create dimensions and cubes, or as the
global suppression segment for an audience level.

Note: A best practice is to create all global constructs in a session flowchart.

To work with strategic segments, you do the following:
v Create segments in the Sessions area, using Create Seg.
v Manage segments from the Segments area.
v Use the segments in campaigns from the Campaign section.
Related tasks:
“Creating segments for global use in multiple campaigns”

Creating segments for global use in multiple campaigns
Administrators use the CreateSeg process in session flowcharts to create segments
that can be used in multiple campaigns. The resulting segments are called strategic
segments.

Before you begin

The configuration property saveRunResults must be set to TRUE for flowcharts that
include CreateSeg processes. Otherwise, the strategic segments will not persist.

About this task

Define a CreateSeg process in the Sessions area of the application so the segments
are available globally. Users can then use the segments in any campaign.

Procedure
1. Open a session flowchart.
2. Click the Edit icon in the flowchart window.

3. Drag the CreateSeg process from the palette to your flowchart.
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4. Connect one or more data manipulation processes (for example, a Select
process) as input to the CreateSeg process.

5. Double-click the CreateSeg process.
6. On the Define Segments tab:

a. Select one or more source cells from the Input list. These source cells will be
turned into segments.

b. Select Create Mutually Exclusive Segments if you want to ensure that each
qualifying record belongs to no more than one segment.

c. In the Result Segments area, highlight an input cell and click Edit to
configure the segment.

The Edit Segment dialog opens.
7. In the Edit Segment dialog:

a. Give the segment a name that describes its purpose. Provide a brief
description of the segment contents (for example, what input was used to
create the segment).

b. From the Create Under list, select a folder where the segment will be
stored.

c. From the Temp Table Data Source list, select a data source in which to
cache the strategic segment. Use the Ctrl key to select multiple data sources.
If you prefer to store the temporary tables in a binary file on the server,
rather than in a user data source, do not select a data source. To deselect a
data source (for example, to revert to no data source selection), Ctrl+click
the item again.

Note: Selecting a data source is required only if the
doNotCreateServerBinFile property on the
Campaign|partitions|partition[n]|Server|Optimization Configuration
page is set to TRUE. If this property is set to TRUE, at least one valid data
source must be selected.

d. From the Security Policy list, select a security policy, if applicable, to apply
to the new segment.

e. Click OK to return to the Define Segments tab.
8. (Optional) Use the General tab to assign a name and descriptive note.
9. Click OK.

What to do next

To create or update strategic segments, run the CreateSeg process in production
mode. Test runs do not create or update strategic segments. Remember that
Campaign|partitions|partition[n]|server|flowchartRun|saveRunResults must be
set to TRUE. After you save the flowchart, the strategic segments will be available
for use in other flowcharts.
Related concepts:
“The Create Seg process” on page 95
“About strategic segments” on page 209

Associating strategic segments with campaigns
A strategic segment is a list of IDs created by an administrator or advanced user in
a session and made available to all campaigns. A strategic segment is no different
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from other segments (such as those created by the Segment process) except that it
is available globally, for use in any campaign.

About this task

Associating a strategic segment with a campaign makes it easier to select that
segment when you create flowcharts. Associating the relevant strategic segments
with a campaign also provides greater reporting capabilities.

Procedure

1. On the Campaign Summary tab, click the Add/Remove Segments icon .
2. Locate the segments that you want to add.

v Click the folders to navigate through them.
v Click Tree View/List View to change the view.
v Click Search to search by name or description.

3. Select the segments that you want to add, and click >> to move them to the
Included Segments list. Use Shift+Click or Ctrl+Click to select multiple
segments.

4. Click Save Changes.

Results

The segments that you added are listed on the Campaign Summary page under
Relevant Segments.

Note: When you use the Select process to select customers in your campaign
flowcharts, the segments that are associated with your campaign appear at the top
of the list, so they are easy to locate.

The Mail List process
Use the Mail List process to assign offers to contacts, generate a contact list for a
direct mail campaign, and log the contact history. The Mail List process is often
referred to as a contact process.

Configuring contact processes (Mail List or Call List)
Follow these instructions to configure a Mail List or Call List process in a
Campaign flowchart. Configure a Mail List or Call List process to assign offers to
contacts, generate a contact list for a direct mail or telemarketing campaign, and
write the results to contact history.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag a contact process (Mail List or Call List ) from the palette
to your flowchart.

4. Connect one or more configured processes as input to the contact process.
The processes that you connect must produce output cells, which serve as
input to the contact process. For example, a Select process produces a list of
IDs, so its output can serve as input to a contact process.
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Important: All of the cells that you select as input cells must have the same
audience level.

5. Double-click the contact process in the flowchart workspace.
The process configuration dialog opens.

6. Use the Fulfillment tab to specify what input is used to build the contact list
and to specify whether output is generated to a list or table.
a. From the Input list, specify the cells to use as the data source for the

contact list.

Note: The Multiple Cells option is available only if the input process
generates multiple cells or if there are more processes that are feeding into
the contact process.

b. The Enable Export To check box is selected by default. To export your list
data to a table or file, leave Enable Export To checked, then use the
appropriate options:
v To write the output to a database table, select a table from the Enable

Export To list.
v If the database table that you want to use is not in the list, or if you

want to write the output to an unmapped table, select Database Table.
Use the Specify Database table dialog to indicate the table and database
name. User variables are supported in the table name that you specify.

v To write the output to a file, select File from the Enable Export To list,
then provide a file name and other details. You can write to a file to test
the output of the contact process. After you run the process, review the
file to confirm that the results are what you expect.

v To create a user table, select New Mapped Table from the Enable
Export To list. For instructions, see the Campaign Administrator's Guide.

v Specify how to handle updates to the output file or table:
– Append to Existing Data. Add the new information to the end of the

table or file. This option is the best practice for database tables. If you
select this option for a delimited file, labels are not exported as the
first row.

– Replace All Records. Remove any existing data from the table or file
and replace it with the new information.

– Create New File. This option is available if you specify a new file in
the Enable Export To field.

c. If you only want to write to contact history, and you do not want to
generate output to a table or file, clear the Enable Export To option. (Use
the Log tab, explained later in these steps, to specify how to log to the
Contact History tables.)

d. (Optional) Summary File: Enter a path and file name in the Summary File
field, or navigate to a location by clicking the ellipsis button. A summary
file is a text file with the extension .sum. This file contains information
about the contents of the list. Typically, you include this file with the list
when you send it to the fulfillment center. A summary file is generated
only if you select the Enable Export To option.

e. (Optional) To send a trigger when the process finishes running, select the
Send Trigger(s) option, and choose the trigger that you want to send. To
send multiple triggers, use Ctrl+Click to select more than one trigger. The
selected triggers are listed in the Send Trigger(s) field, and they are
separated by commas.
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7. Use the Treatment tab to assign one or more offers or offer lists to each target
cell:
a. Click the Offer field next to the cell, then select an offer. To assign offers to

multiple cells, select all rows to which you want to assign offers, then click
Assign Offers.

Note: If the input cells are linked to a top-down cell defined in the target
cell spreadsheet (TCS), and offers are already assigned in the TCS, the
offers are displayed here. You can override these assignments. Any
changes that you make here are reflected in the TCS after you save the
flowchart.

b. If you want to exclude some IDs from the contact list, select Use Holdout
Control Groups, then change the Control? field to Y for each cell that you
want to use as a control. Those cells appear in the Control Cell list and
cannot be assigned offers.

c. For each non-control cell, you can specify a control cell and an offer.
8. Use the Parameters tab if your organization is using parameterized offers. For

example, an offer might be parameterized with values of 10% and 20%. The
Parameters tab shows the values for each offer that was assigned on the
Treatment tab. If there are no parameterized offers, you can skip this tab.
a. Use the For Cell(s) list to select the cells that you want to affect.

To save data entry time, select [All Cells] to assign values that apply to
most of the cells, then select individual cells to override the values.
When you select [All Cells], you see one row per offer per parameter.
Values that you enter in the Assigned Value field apply to every cell that
gets that offer.
If you assigned the same offer to multiple cells on the Treatment tab, but
you assign different parameter values for each cell, the [All Cells] view
displays the text [Multiple Values] in the Assigned Value column, and the
For Cell(s) list shows the value that is assigned to each cell.
When you select an individual cell, you see only the offers assigned to the
selected cell. Values that you enter in the Assigned Value field apply only
to that cell.

b. Click in the Assigned Value field (or select a row in the table and click
Assign Value), then select or type a value to assign to the parameter. You
can use constants, derived fields, or table fields as values. For example,
you can use a derived field to produce values that can be assigned to offer
attributes.
The configuration setting Campaign | partitions | partition[n] |
server | flowchartConfig | disallowAdditionalValForOfferParam
determines whether you are allowed to specify additional values or
whether you are restricted to values in the list for offer attributes of type
Single Select drop down.

9. Use the Personalization tab to specify which fields to write out to the contact
list. For example, if you are building a mailing list, include contact names and
addresses.
v The Export Field list indicates which fields to write to the output list.
v If you selected a table on the Fulfillment tab, the Export Field list includes

all of the fields from that table. You must map each data field to a
corresponding table column. To automatically find matching fields, click
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Match. Fields with exact matches for the table field names are automatically
added to the list. If there are multiple matching fields, the first match is
taken.

v If you selected a file on the Fulfillment tab, the Export Field list is empty
and you must specify which fields to output.

v When you select Candidate Fields, you can click the arrow next to an item
to expand it. For example, you can expand the IBM Campaign Generated
Fields list, then select Treatment Code. By including the Treatment Code in
your output, you can use it to track responses. Direct Response tracking
requires customers to provide the same code when they respond to the offer
(for example, by using a coupon). Use Ctrl+Click or Shift+Click to select
multiple fields.

v To view the values in a field, select the field and click Profile.
v Use the Add and Remove controls to adjust the contents of the list.
v The order of the fields in the Export Fields list determines the order that the

data is written out.
10. To sort the output and specify how to handle duplicate IDs in the list, click

More on the Personalization tab.
You see the Advanced Settings dialog.
a. Decide whether your list will include or omit duplicate IDs. For example,

if your Audience ID is Household, there might be duplicate Audience IDs
for each person in that household. You may or may not want each person
included in the list. To omit duplicate IDs, choose Skip Records with
Duplicate IDs, and specify which record to retain if duplicate IDs are
returned. For example, to keep only the family member with the highest
household income, select MaxOf and Household_Income.

Note: This option removes duplicates that occur in the same input cell. If
the same ID exists in multiple input cells, your contact list might still
contain duplicates. If your goal is to remove all duplicates from the list,
use a Merge or Segment process upstream of the contact process to purge
duplicate IDs or create mutually exclusive segments.

Note: This option pertains only to the fulfillment table (the list) and not to
contact history. The contact history tables always contain unique IDs only.
For example, say that your output list includes multiple family members
(duplicate IDs for Households). The contact history will contain only one
record for Household, using the first CustomerID found. The flowchart
designer must ensure that the result set obtains the correct records before
the records reach the contact history tables. Use the Extract process to
de-dupe the results before the contact process box to ensure that the
correct records are written to both the fulfillment table and contact history.

b. To sort the output, use the Order By options. For example, to sort by
surname in reverse order, select the Last_Name field and Descending.

c. Click OK to close the Advanced Settings window.
11. Use the Log tab to control what is written to contact history.

You must have the appropriate permissions to enable or disable the contact
history log options.
a. To log contact history to the system tables, check Log to Contact History

Tables. This option makes contact information available for tracking and
reporting throughout Campaign.
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Note: When you create a mailing list, do not log to contact history if you
plan to send the list to a mailing house for processing (such as validating
addresses). Instead, consider using a Track process to log the information
after it is returned from the mailing house. In this way, you capture only
the list of customers who were mailed an offer. Another approach is to
allow the Mail List to update contact history, then use the Track process to
update the contact history records that were created by the Mail List
process.

b. (Optional) To store contact information in another location, in addition to
or instead of the contact history tables, check Log into Other Destination.
This option is useful if your organization requires further processing of the
information in another format, or if you want to examine the output before
you update contact history.

12. If you selected Log into Other Destination on the Log tab:
a. Use Select cells to specify which input to use (if there are multiple inputs).
b. Use Log to to select a destination table or file. If you select File, define the

output file name and parameters.
Indicate which field data to include by moving candidate fields to the
Fields to Output list. You can automatically find matching fields by
clicking Match. Fields with exact matches for the Table Field names are
automatically added to the Field to Log list. If there are multiple matching
fields, the first match is taken. The order of fields in the list determines the
order of data in the file.

c. Use the following options to specify how updates to the destination file or
table are handled:
v Append to Existing Data: Add the new contact information to the end

of the table or file. Appending data is a safe choice for database tables
because it preserves existing data. If you select this option for a
delimited file, labels are not exported as the first row.

v Replace All Records: Remove any existing data from the table or file,
and replace it with the new contact information.

An informational field indicates whether Skip records with duplicate IDs
is set to Yes or No. You set this option on the Personalization tab but it
also applies to the table or file that you specified for Log into Other
Destination, where you are additionally logging contact history.

13. To customize the information that gets written to contact history, click More
Options on the Log tab.
The Contact History Logging Options dialog opens.
a. To avoid updating contact history when this process runs, select Create

Treatments Only.
This option generates new treatments in the Treatments table without
updating the contact history, allowing for a delayed update to the history
tables. For example, use this option if you plan to remove invalid and
duplicate addresses through post-processing. By waiting to update contact
history with the final list of IDs to which offers are sent, the resulting
contact history will be smaller and more accurate.
If you select this option, the other options in this dialog that no longer
apply are disabled.
By default, this option is not selected, so contact history is updated when
the process runs.
For more information about logging contact history, see Chapter 9,
“Contact history,” on page 167.

Chapter 5. Process configuration 101



b. To generate new treatments with the same package ID as in the most
recent process run, select Use Last Package ID.
All offers given to an individual in the same contact process are
considered to be a single "package". By default, Use Last Package ID is
not selected. Not selecting this option ensures that each package is
assigned a unique ID for each production run of the contact process.
If you selected Create Treatments Only to prevent customer history from
being updated, you can also select Use Last Package ID to ensure that the
package ID from the prior run is assigned to each set of offers. This action
links the offers to the existing contact history.

c. Use the Tracking Audience Level to determine which audience level is
written to contact history.

Note: The contact process removes duplicate records based on the
Audience level of the input process. Changing the Tracking Audience
Level does not affect how records are de-duped. For example, say the
input process for a Maillist process uses Audience level 1. However, you
want to log records to contact history at Audience level 2. In this case, you
must configure an Audience process to change the audience level. Then
connect the Audience process as input to the contact process. Now you can
select a Tracking Audience Level of 2.

d. Use the Contact Date field to specify when to contact the people in the
contact list. If you do not specify a date, Campaign uses the flowchart run
date.

e. Use the Contact Status Code list to specify a status code for tracking.
f. Use the controls to add fields from the Candidate Fields list to the Fields

to Log list.
g. Click Close to return to the Log tab of the process configuration dialog.

14. (Optional) To clear some or all existing contact history and associated
response history entries before the next run of the contact process, click Clear
History on the Log tab.

Important: Clear History permanently deletes contact and response history
records from the system tables. This data is not recoverable.

15. (Optional) Use the General tab to assign a name and descriptive notes to the
process.

16. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results you expect. A test run does not output data or update any tables or
files, but it does run any triggers that were selected on the Fulfillment tab.

The Call List process
Use the Call List process to assign offers to contacts, generate a contact list for a
telemarketing campaign, and log the contact history. The Call List process is often
referred to as a contact process.

You configure a Call List process the same way as you configure a Mail List
process. See “Configuring contact processes (Mail List or Call List)” on page 97.
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The Track process
Use the Track process to update the contact statuses or additionally tracked fields
for existing records in contact history. The Track process can update existing
contact history records, create new records, or do a combination of both.

The Track process lets you log contact information to the contact history tables,
separate from the contact process that generated the list of contacts.

For example, if your mail house does post-processing to remove invalid and
duplicate addresses, then you probably would not write your initially-generated
list to contact history. Instead, you would wait for the mail house to send you a
confirmation list of IDs to which they actually sent offers.

In this case, your input to the Track process will be the final mailing list used by
the mail house after they performed post-processing, and your contact history will
be more accurate. Later, if some direct mail pieces are returned as undeliverable,
you can use the Track process to update the contact status for those contacts as
"Undeliverable."

Additionally, there are times when the target list is large, and it is not necessary to
load all of this information into contact history. Instead, you can log only those
contacts who were actually contacted. Often, you do not know who was or was
not contacted until you receive feedback from call centers or mail houses. You can
use the Track process so that when feedback is received from different sources you
can insert it into the contact history tables.

For details about logging contacts to contact history, see Chapter 9, “Contact
history,” on page 167.

Example 1

You create two separate flowcharts to take advantage of the Track process's
delayed writing to contact history.

Create your contact list in Flowchart 1: A Select process selects data and provides
input to a Segment process, where the data is segmented by value tier. The
segmented data from the Segment process is input to a Mail List process. You
configure the Mail List process to output a list of IDs to a file, without logging
contact history, because you want the contact list to undergo post-processing by
the mail house.

Create Flowchart 2 to handle the contact list that the mail house returns to you,
and to write the final list of contacts to contact history. Flowchart 2 consists of a
Select process whose input is the list of customers who were actually contacted by
the mail house, connected to a Track process which then writes the information to
contact history.

Example 2

In a variation of the previous example, the mail house returns a list of IDs that
could not be contacted. To obtain the list of contacted IDs, select the original
output contact list from Flowchart 1 and use a Merge process to suppress the IDs
that could not be contacted. The output from the Merge process is then your list of
contacted IDs, and these IDs can be passed to a Track process for writing to
contact history.

Chapter 5. Process configuration 103



Note: In both examples, the Treatment code is needed to map the updated data
back to the original list.

Tracking contact history
Configure a Track process to update existing rows in contact history or create new
rows.

About this task

For examples, see “The Track process” on page 103.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click the Edit icon in the flowchart window.

3. Drag the Track process from the palette to your flowchart.
4. Connect one or more configured processes as input into the Track process.
5. Double-click the Track process in the flowchart.
6. Use the Source tab to select input cells that contain potential responders. Cells

from processes that are connected to the Track process appear in the Input
list.
a. Use the Input list to select different or additional source cells.
b. Use the Contact Date field to select a date to associate with records that

the Track process will update. By default, a value of "Today" is selected.
You can also use derived fields to populate the Contact Date.

c. Select a Contact Status Code to associate with the records that you are
updating in contact history.

7. Click the Mapping to Treatments tab.
Use the Candidate Action Fields list to choose the relevant field to match to
the Treatment Code. The treatment code uniquely identifies the row in the
contact history to update.
Select a field to use for matching, and click Add to move it to the Matched
Offer/Treatment Fields list, so it is paired with a Treatment Code.

8. Click the Log tab to specify how to update contact history.

Note: You must have the appropriate permissions to enable or disable
updates to contact history tables.
a. To update contact history in the system tables, select the Log to Contact

History Tables check box.
b. Specify how to update the contact history tables:

v Update Existing Records: If a record exists, update it. If a record does
not exist, do not create it.

v Create New Records Only: If a record does not exist, create it. Do not
update existing records.

v Update Existing and Create New: If a record exists, update it. If a
record does not exist, add it.

c. To write additional fields to the contact history, click Additional Fields to
display the Contact History Logging Options dialog. Use the Add,
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Remove, Match, Up1, and Down1 buttons to select and move fields from
the Candidate Fields list to the Fields to Log list. Unmatched fields will
not be updated.

d. Click OK.
9. If you want to log to a destination other than, or in addition to, the contact

history in the system tables, select the Log into Other Destination check box.
This option allows you to write to an alternate table or file.
a. Use the Log To list to specify whether the output should be written to a

file or a new or existing table in the database:
If you select File, use the Specify Output File dialog to specify the output
file type, the file name, and the corresponding data dictionary.
If you select New Table, use the New Table Definition dialog to specify
information about the new table to which you want to write the log
output.

b. To specify which fields to output, select fields from the Candidate Fields
list and move them to the Fields to Output list. If you do not see the
fields that you want to select, expand the items in the Candidate Fields
list. You can also used derived fields for Candidate Fields.

c. You can automatically find matching fields by clicking Match. Fields with
exact matches for the Table Field names are automatically added to the
Field to Log list. If there are multiple matching fields, the first match is
taken.

d. Select an option to specify how to handle updates to the output file or
table:
v Append to Existing Data: Append the new contact information to the

end of the table or file. If you select this option for a delimited file,
labels will not be exported as the first row. This is the best practice for
database tables.

v Replace All Records: Remove any existing data from the table or file,
and replace it with the new contact information.

10. (Optional) Click the General tab to assign a name and descriptive notes to the
process.

11. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results you expect.

The Response process
The Response process tracks the responses of customers who were contacted in a
contact process, such as Mail List or Call List.

Based on rules that you define during process configuration, the Response process
evaluates which responses are considered valid and how they are credited back to
campaigns or offers. The output of the Response process is written to several
response history system tables, where the data can be accessed for analysis using
Campaign performance and profitability reports.

In its simplest form, the Response process can appear in its own flowchart
connected to a Select process (and optionally a Segment process). In such a
flowchart, the Select process selects IDs from a mapped table containing data about
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responders and their response actions. These IDs are segmented by the Segment
process into meaningful groups, and finally passed to a Response process, where
response tracking rules are applied and output is written to response history
tables.

A Response process is tightly aligned with its corresponding contact process, in
which the responders now being tracked were possibly members of cells targeted
with particular offers.
Related tasks:
“Updating response history”
Related reference:
“Performance reports for IBM Campaign” on page 228

Updating response history
Use the Response process to update response history. The Response process
compares campaign response information with contact history and writes
information to the response history tables for the appropriate audience level.

Before you begin

A Response process is tightly aligned with its corresponding contact process, in
which the responders now being tracked were possibly members of cells targeted
with particular offers. Therefore, before you can configure a Response process, you
must:
v Know the audience level of your contact list.
v Ensure that contact history and response history system tables are mapped for

each audience level that you are contacting and tracking. This is usually done by
the Campaign administrator.

v Set up a separate Response process for each audience level in which you are
tracking responders.

v Know the codes representing the response types that you want to track.
v Know what Campaign-generated codes (campaign, cell, offer, or treatment

codes) were sent to your contact list, so you can map them for tracking.
v Enable the ability to create temp tables in the Campaign system tables database

(set the AllowTempTables configuration property to true).

About this task

Follow the steps below to configure a Response process.

Procedure
1. Navigate to the list of campaigns where you created your contact flowcharts

(the flowcharts that assigned the offers that you plan to analyze).
2. Typically, you create a separate flowchart to handle the response process. You

could also have one response flowchart per channel or one global response
tracking flowchart for all campaigns.

3. Click the Edit icon in the flowchart window.

4. Drag the Response process from the palette to your flowchart.
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5. Connect a Select or Extract process as input to the Response process.
The Select or Extract process typically reads from an action table. An action
table is an optional database table or file containing response data that is
collected after offers are presented to customers. Often, data originates from
several tables such as transactions or sales information.

Note: Administrators must ensure that the action table is locked during
response processing. Administrators must also clear rows after each Response
process run to ensure that responses are not credited multiple times. For
example, use Campaign to run SQL after the Response process to purge the
action table. For important information, see the Campaign Administrator's
Guide.

6. Double-click the Response process in the flowchart to open the process
configuration dialog.

7. Use the Source tab as follows.
a. If you followed the steps in this procedure, the Input list already displays

the correct input. The input should originate from the mapped action table
that holds your customer response information.

Note: If you are using a delimited flat file as input to the Response
process, you must ensure that all of the data types in the input files are
mapped appropriately, as this is not enforced by the Response process.
Using a mismatched data type (for example, having a treatment code
mapped as "numeric" when the UA_Treatment.TreatmentCode field is a
"string" type) causes a database error on some databases (for example,
system tables on DB2®).

b. For Response Date, select a date from your action table to associate with
the records that will be output by the Response process. By default, a
value of "Today" is selected.

c. For Response Type Code, choose a field from your action table. The
response type codes are globally defined and available for all campaigns.
Response types are the specific actions that you are tracking, such as
click-through, inquiry, purchase, activation, and use. Each response type is
represented by a unique response code.

8. Use the Mapping to Treatments tab to select the fields to be tracked and
match them to a list of offer and treatment attributes.
a. In the Candidate Action Fields list, expand the action table that you are

using, so you can see the list of fields.
b. Use the Add button to match Candidate Action Fields to the

corresponding attributes in the Matched Offer/Treatment Fields list. The
Offer/Treatment Attribute column lists all offer or treatment attributes in
the system.
It is best to match at least one Attribute of Interest and one Response
Code.

Note: Unmapped fields and fields for which values are not available (or
are NULL) are not used for response attribution. For a treatment instance
to receive response credit, all populated fields must match, except for
controls. For controls, all codes are ignored.

9. Click the Log tab to specify additional fields to log to response history.
Use the controls to match fields from the Candidate Fields list with fields in
the Fields to Log list.
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You can automatically match fields by clicking Match. Fields with exact
matches for the Table Field names are automatically added to the Fields to
Log list. If there are multiple matching fields, the first match is taken.

10. Click the General tab to assign a name and descriptive note to the process.
11. Click OK.

Results

The process is now configured. You can test run the process to verify that it returns
the results that you expect.

When you save and run the flowchart, information is written to the response
history system tables. Campaign administrators must be sure to clear rows after
each Response process run to ensure that responses are not credited multiple times.
Related concepts:
“How to track responses to a campaign” on page 177
“The Response process” on page 105
“Direct responses” on page 183
“Attribution methods” on page 186
Related reference:
“Performance reports for IBM Campaign” on page 228

Profiling fields to preview values from your user data
You can use the Profile feature to preview field values when you configure a
process in a flowchart. This feature lets you see actual values from fields in your
user data. You can profile any field in a mapped data source. You can also profile
derived fields.

Before you begin

You must have the appropriate permissions to profile fields. Ask your system
administrator if you have questions about your access to this feature. Also note
that your administrator can prevent fields from being profiled. You see a warning
if you try to profile a field that is also an audience because profiling an audience
can return many records and potentially impact performance.

About this task

When you profile a field, you can view and select values to use in the current
operation, for example to build a query for a Select process.

In addition to listing the values, the Profile feature indicates each value's
frequency of occurrence in the selected field. You can use this information to
ensure that you are targeting the intended contacts. Only records in the current cell
are included in the count, unless the counts were pre-computed.

Procedure
1. In the configuration window of a process that includes the Profile button,

select the field that you want to profile.
2. Click Profile.
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Results

Campaign profiles the data in the selected field. The categories and frequency
counts update as profiling progresses.

Note: Wait until profiling is complete before using the results, to ensure that all
categories are processed and counts are complete.

When profiling is complete, the Profile Selected Field window shows the following
information:
v The list of values in the selected field, shown in the Category column, and the

corresponding Count of IDs with that value.

Note: Campaign organizes values by category, grouping them to create
approximately equal-sized segments. The default maximum number of
categories (distinct bins of values) for display is 25. You can change the
maximum number of categories.

v The Statistics pane on the right shows the total count of IDs and other details
about the data for that field, including:
– The number of NULL values found.
– The total number of categories, or values, for that field.
– Statistical values for the data including the mean, standard deviation,

minimum, and maximum values.

Note: Mean, Stdev., Min., and Max. are not available for ASCII fields. When
you profile text fields, these values appear as all zeros.

Refreshing profile counts
Refresh the profile count when something occurs that might change the results. For
example, you can refresh the count when new values are added to a field or when
a database table is updated.

Procedure

Follow these steps to refresh the profile results for a field.
1. Open any process configuration dialog in which the Profile option is available.
2. Select a field and click Profile.
3. In the Profile Selected Field dialog, click Recompute.

Note: When you first profile a field from a dimension table, Campaign returns
counts that match the field in the dimension table. When you click Recompute
to refresh the profile results, Campaign returns counts from the resulting join
with the base table that is linked to the dimension table. If you want to profile
a dimension table field without joining to a base table, map the dimension table
as a base table.

Restricting input for profiling
When Campaign profiles a field, it creates only those segments that are available in
the input to the process where you are performing profiling.

In other words, if you restrict input to the Segment process, and you profile a field
based on the restricted input, the Profile only displays segments that were
available in the restricted input.
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Consider this example:
1. You configure a Select process that does a query that returns only 354 records.
2. You use that Select process as input to a Segment process.
3. In the Segment process configuration dialog, you use the Profile feature to see

which values are available in various fields.
4. The selection that you make in the Input list of the Profile Selected Field

dialog determines how many records are profiled. If you choose None,
Campaign profiles all of the records. If you choose the incoming Select box as
the Input, Campaign profiles only the records that were selected by that
process. If the Select process query resulted in only 354 records, Campaign
profiles only those records.

The following example shows a restricted profile, where the Input is set to Select1.

Disallowing profiling
Real-time profiling allows you to view and use characteristics of a selected field. It
can affect performance, however, when working with large databases. For this
reason, Campaign allows this option to be disabled.

When real-time profiling is disabled, and you click Profile, a messageat the bottom
of the Profile Selected Field window indicates that real-time profiling is disallowed.

If profiling is disallowed and the field is not configured to be pre-computed, the
Profile Selected Field window indicates that no data is available, no counts or
categories are displayed, and all Statistics counts are zero.

If pre-computed values are available for a field, the pre-computed values are
displayed instead of live values when profiling is performed. The Profile Selected
Field window indicates that the data source is "Imported," and shows the date and
time that the values were last computed.

For more information about disallowing real-time profiling, see the IBM Campaign
Administrator's Guide.

Changing the maximum number of profile segments
When you profile fields in flowchart process boxes, IBM Campaign automatically
creates up to a maximum number of 25 segments. You can change this value for
the current flowchart session.
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About this task

When you use the Profile option in a process configuration dialog, you can specify
the maximum number of segments to generate when previewing field values. The
new value is used by all process boxes in the current flowchart. However, the
value applies only to the current flowchart and session. When you open another
flowchart or close and then reopen the same flowchart, the value reverts to the
default value of 25.

Procedure
1. Open any process configuration dialog in which the Profile option is available.
2. Select a field for profiling and click Profile.
3. In the Profile Selected Field dialog, click Options.
4. In the Profiling Options dialog, enter a new value in the Number of Segments

field to indicate the maximum number of segments into which you want the
field values grouped.

Results

The profile is recomputed with the new value.

If the number of distinct values in the field exceeds the maximum allowed number
of segments, the profile groups the values together into equal sized segments to
avoid exceeding the maximum number of segments.

Profiling field values by meta type
Profiling by meta type affects how data is sorted when you profile a field in a
process configuration dialog. You can sort field values for data types such as dates,
money, and other numeric data.

Procedure
1. Open any process configuration dialog in which the Profile option is available.
2. Select a field for profiling or click Profile.
3. Profile Selected Field The Profile By Meta Type option is enabled by default,

so field values that represent dates, money, telephone numbers, and similar
data types are correctly sorted and binned. For example, dates are sorted as
dates, not as numeric values. If you disable this option, the values are sorted as
ASCII text.
The following example shows how this setting affects a date field. Meta type
profiling recognizes that the data type is Date and sorts the dates accordingly.

Profile by Meta Type enabled

(sorted by date)

Profile by Meta Type disabled

(sorted numerically)
25-DEC-2011 20-FEB-2012
20-FEB-2012 20-MAR-2012
20-MAR-2012 25-DEC-2011

Inserting a profile category into a query
While building a query expression in a process configuration dialog, you can insert
a field value into your query expression.
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Procedure
1. While configuring a process, select a field and click the Profile button.
2. When profiling is finished, from the Profile Selected Field dialog, double-click a

category to insert that value at the current cursor location in the query text box.

Note: If you do not see the value that you want, it is possible that multiple
values are being grouped together into a profile segment. If you set the
maximum number of profile segments to a number greater than the number of
categories (reported in the Profile Selected Field window), each field value will
be listed as a separate category. This makes it possible to access all of the
existing categories.

Printing profile data
After you profile a field, you can print the profile data.

Procedure
1. Click Print from the Profile Selected Field dialog.

The Page Setup page appears, from which you can specify the printer and
printing options.

2. Click OK.

Exporting profile data
After you profile a field, you can export the profile data to a comma-separated
values (CSV) text file.

Procedure
1. Profile a field while configuring a process in a flowchart.
2. In the Profile Selected Field dialog, click Export.

Note: The Export button is available only when profiling is finished.
The Export Report Data dialog opens.

3. Enter a file name in the File name field or accept the default value. Do not
specify a path or extension. The extension .csv will be used when the file is
created.

4. (Optional) Select Include Column Labels if you want to include column
headers in the file to identify each field.

5. Click Export. If this button is disabled, you must enter a file name first.
6. Use the resulting dialog box to open or save the .csv file.
7. If you save the file, you are prompted for a location. You can also change the

file name at that time.

What to do next

You can open the CSV file in any text editor. If you open the file in Microsoft
Excel, your Excel settings determine how the data is displayed. For example, Excel
might interpret a range value, such as "1-5", as a date (January 5).

Skipping duplicate IDs in process output
The Extract, Call List, Mail List, and Snapshot processes allow you to specify how
to treat duplicate IDs in the process output. The default is to allow duplicate IDs in
the output.
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About this task

Follow these steps to exclude records with duplicate IDs from the output.

Procedure
1. From the configuration window of the process, click More.

You see the Advanced Settings window.
a. Select Skip records with duplicate IDs, and specify the criteria to

determine which record to retain if duplicate IDs are returned. For example,
select MaxOf and Household_Income to export only the ID with the
highest household income.

Note: This option only removes duplicates in the same input field. Your
data can still contain duplicate IDs if the same ID appears in multiple fields.
To remove all duplicate IDs, you must use a Merge or Segment process
upstream of the Extract process to purge duplicate IDs or create mutually
exclusive segments.

2. Click OK to close the Advanced Settings window.
Your duplicate ID settings are displayed in the configuration window.

Note: In the Mail List or Call List process box, the Skip records with duplicate
IDs option pertains only to the fulfillment table created by the process and not
to records that are written to contact history. The contact history tables only
handle unique IDs. The flowchart designer must ensure that the result set
obtains the correct records before reaching the contact history tables. Use the
Extract process to de-dupe the result set before the Mail List or Call List
process box to ensure that the correct records are written to both the fulfillment
table and contact history.
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Chapter 6. Using queries to select data

You can use a query to identify contacts from your databases or flat files when you
configure a Select, Segment, or Extract process in a flowchart. There are several
different query methods.

Creating queries with Point & Click
These instructions explain how to create a query using the default Point & Click
method in a process configuration dialog. You can also follow these instructions to
edit a query. Selecting a new item from the Select Based On list removes the
existing query.

Procedure
1. Begin configuring a process that uses queries, such as Segment, Select, or

Extract.
2. Access the query option for the process:

v For a Select process, choose Select <audience> IDs With.
v For a Segment process, use Segment by Query, double-click a segment to

edit it, then use Select IDs With.
v For an Extract process, use Select records With.
The Point & Click query builder is displayed.

3. Construct your query by creating an expression:
a. To specify which field to query, click in the Field Name cell. The Available

Fields list should appear. If the list does not appear, click in the Field Name
cell again. Select an available field by double-clicking it or highlighting it
and clicking Use. When deciding which available field to use, you can
highlight a field and click Profile to see a list of field values.

b. You can use the Derived Fields button if you want to create or select an
existing variable for querying.

c. Click in the Oper cell, then double-click a comparison operator in the
Operators list (such as =, <, >, Between).

d. Click in the Value cell, then double-click a value. If no values appear, click
Profile to see a list of field values. You can also double-click in the Value
cell to edit the value directly.

Note: If you do not see the expected list (Available Fields, Operators,
Values, For Selected Expresssion), try either single clicking or double
clicking on a cell in the Expressions area.

You now have an expression that consists of a field name, operator, and value,
such as Status=Active.

4. To add and combine multiple expressions, follow the guidelines below:
a. To add another expression, click the And/Or cell, then double-click AND or

OR in the Values list to indicate how to combine the expressions.
b. Build your next expression, consisting of a field name, operator, and value.
c. To add parentheses to control evaluation order, double-click the Field Name

in any row to display the For Selected Expression list. In the list of
expressions, double-click Add (...) to add a set of parentheses, Remove (...)

© Copyright IBM Corp. 1998, 2013 115



to remove a single set of parentheses, or Clear all (...) to remove all of the
parentheses in the selected expression. Parentheses allow you to group
expressions when defining complex queries. For example, (AcctType =
'Gold' AND Rank = 'A') OR NewCust = 'Yes' is different from AcctType =
'Gold' AND (Rank = 'A' OR NewCust = 'Yes').

d. To reorder the selected expression, double-click Move Up or Move Down.
e. To add a blank row below the selected expressions, double-click Insert.
f. To delete the selected expression, double-click Delete.

5. Click Check Syntax to confirm whether your query syntax is valid. Checking
the syntax does not put any load on the database server.
Campaign indicates whether the syntax contains any errors.

6. (Optional) Use Test Query to see how many IDs the query returns.
A progress bar is displayed while the query is being tested. Close the progress
window if you want to cancel the test. When testing is complete, Campaign
indicates the number of rows the query returned.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Test queries might also return non-normalized data. To obtain an
accurate result count, test run the process.

7. Click OK.

Creating queries with Text Builder
These instructions explain how to create a query using the Text Builder feature in a
process configuration dialog. To edit an existing query, edit the text of the query
directly in the query text box, after clicking the Text Builder button.

Procedure
1. Begin configuring a process that uses queries, such as Segment, Select, or

Extract.
2. Access the query option for the process:

v For a Select process, choose Select <audience> IDs With.
v For a Segment process, use Segment by Query, double-click a segment to

edit it, then use Select IDs With.
v For an Extract process, use Select records With.

3. Click Text Builder to change from the default Point & Click query method.
The Point & Click query columns are replaced by a query text box. Any
existing queries are displayed in the text box.

4. Choose an Input data source, and a data source to query from the Select Based
On list. Your selections determine which fields can be used to build your
query:

5. Create your query by:
v Selecting the field or table name(s) from the Available Fields list and

double-clicking to enter them in the query text box. You can also click once
then click <-Use to move it to the query text box.

v Entering the required operators and values. To see the values of a selected
field, you can click Profile.

Note: Although you can enter field and table names directly in the query text
box, selecting them from the list helps to avoid syntax errors.
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6. To check the syntax of the query, click Check Syntax. Checking the syntax does
not put any load on the database server.

7. (Optional) Use Test Query to see how many IDs the query returns.
A progress bar is displayed while the query is being tested. Close the progress
window if you want to cancel the test. When testing is complete, Campaign
indicates the number of rows the query returned.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Test queries might also return non-normalized data. To obtain an
accurate result count, test run the process.

8. When you finish creating your query, click OK.
The process configuration box closes and you return to the flowchart page in
Edit mode.

Creating queries with Formula Helper
These instructions explain how to use the Formula Helper to build a query in a
process configuration dialog. Use the Fomula Helper to select macros and
functions from pre-defined lists. Use the supplied buttons to insert operators and
punctuation.

Procedure
1. Begin configuring a process that uses queries, such as Segment, Select, or

Extract.
2. Access the query option for the process:

v For a Select process, choose Select <audience> IDs With.
v For a Segment process, use Segment by Query, double-click a segment to

edit it, then use Select IDs With.
v For an Extract process, use Select records With.

3. Click Text Builder to change from the default Point & Click query method.
4. Click Formula Helper.

The Formula Helper window opens. It contains a set of buttons for inserting
commonly used operators, and a list of macros and functions.

5. (Optional) To work only with SQL operators and functions, check SQL.
6. Build your query by selecting fields from the Available Fields list as you

normally would. Additionally, use the Formula Helper window:
a. Expand the list of macros or functions to locate the item you want to use.

Select an item to see a description and syntax example. Double-click an item
to add it to the query text box.

Note: If you select a custom macro, the description and syntax were created
by the person who wrote the macro.

b. Use the Formula Helper buttons to add operators and punctuation. The
Clear button acts as a backspace (erase) key.

c. You can also edit the query directly. However, you can avoid syntax errors
by selecting items, such as field and table names, from the lists provided.

d. Click Close.
7. Use Check Syntax to detect any errors. Checking the syntax does not put any

load on the database server.
8. (Optional) Use Test Query to see how many IDs the query returns.
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A progress bar is displayed while the query is being tested. Close the progress
window if you want to cancel the test. When testing is complete, Campaign
indicates the number of rows the query returned.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Test queries might also return non-normalized data. To obtain an
accurate result count, test run the process.

Creating raw SQL queries
Experienced SQL users can write their own SQL queries or copy and paste SQL
queries from other applications. Writing raw SQL is an advanced operation; users
are responsible for correct syntax and query results.

Procedure
1. Begin configuring a Select or Segment process.
2. For a Select process, you must switch to the Text Builder in order to write a

SQL query:
a. Choose Select <audience> IDs With.
b. Change to the Text Builder (instead of the default Point & Click method).
c. Click Advanced.
d. In the Advanced Settings dialog, check Use Raw SQL for Record Selection.

This option enables the use of raw SQL in the Text Builder when you
specify your selection criteria. If you do not select this option, you can only
use IBM EMM expressions and Custom Macros.

e. Select a data source to query from the Database list. Select the target
audience from the Audience Level list.

f. If you want to run SQL commands before or after the Select process, you
can specify raw SQL in the Pre-Processing or Post-Processing area. See
“Specifying pre- or post-processing SQL statements” on page 119.

g. Click OK to close the Advanced Settings dialog.
h. Enter raw SQL in the text entry area. You can use the Formula Helper to

help construct the SQL. Check SQL in the Formula Helper to restrict the list
of operators and functions to SQL-specific options.

3. For a Segment process:
a. Choose Segment by Query, then create or edit a segment.
b. Choose Select IDs With, click Text Builder, then click Advanced.
c. In the Advanced Settings dialog, check Use Raw SQL, select a data source,

and click OK.
d. Enter raw SQL in the text entry area. Optionally, use the Formula Helper to

help construct the SQL. Check SQL in the Formula Helper to restrict the list
of operators and functions to SQL-specific options.

Guidelines for SQL queries
Writing raw SQL is an advanced operation; users are responsible for correct syntax
and query results.

Follow these guidelines when using raw SQL to construct queries in a process
configuration:
v A SQL query must return a list of only the unique IDs as defined by the key on

a base table.
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v A SQL query must use the following syntax:
SELECT DISTINCT(<key1> [<key2>,...]) FROM <table> WHERE <condition>
ORDERBY <unique_id>

This query instructs the database to perform sorting and data deduplication. If
you omit the DISTINCT or ORDERBY clause, Campaign sorts and deduplicates the
data on the application server, so you still receive the correct results, but
performance will be slower.

v If in-database optimization is enabled and there is an input cell to the Select
process, you must use the <TempTable> token to obtain the correct list of
audience IDs.

v To significantly improve performance with large tables, use the <TempTable>
token even when not using in-database optimization.

v If your database allows multiple commands to be passed, enter as many valid
SQL commands as you need, with the following rules:
– Separate commands with the appropriate delimiter
– The last command must be a select command.
– This select command must select all the relevant fields required in defining

your audience level in the same order the audience level is defined.
– No other select statements are used

v Data filters do not apply to raw SQL queries or to custom macros that use raw
SQL. To learn about data filters, see the IBM Marketing Platform Administrator's
Guide.

Specifying pre- or post-processing SQL statements
If you are using a Select or Extract process, you can optionally include raw SQL
statements to run before or after the process.

Before you begin

For important information, see “Guidelines for SQL queries” on page 118.

About this task

You can include SQL procedures as part of the process run, which can be useful for
ETL, routine data mart updates, performance tuning, and security. You can specify
pre- or post-processing SQL:
v Pre-processing: Enter raw SQL to be processed before the query runs.
v Post-processing: Enter raw SQL to be processed after the query runs.

For example, you can use pre- and post-processing SQL statements to:
v Run stored procedures in the database
v Create, drop, and re-create tables and indexes
v Grant or change privileges to other users or groups
v Organize multistep database commands
v Run complex database routines without having to use external scripts to connect

to the database

Note: For important information, see “Guidelines for SQL queries” on page 118.

Procedure
1. Begin configuring a Select or Extract process.
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You can select all records or use a query to select specific IDs. For the Select
process, you can apply pre or post processing regardless of the query type
(standard query or Use Raw SQL for Record Selection).

2. Click the Advanced button.
The Advanced Settings window appears.

3. Double-click in the Pre-Processing area and enter a raw SQL statement to run
before the process.

4. Click in the Database cell, and select the database on which you want to run
this statement.
The Database list shows all available databases (those for which a data source
category was configured on the Configuration page in Marketing Platform). If
your database does not appear in the list, contact your Campaign system
administrator. You must enter a SQL statement before you can select a
database.
The SQL statements are processed in the order in which they appear.

5. Follow the same procedure to enter any Post-Processing SQL statements to run
after the process.
The SQL statements are processed in the order in which they appear.

Note: For information about the Use Raw SQL for record selection option in
the Advanced Settings dialog, see “Creating raw SQL queries” on page 118.

Using the TempTable and OutputTempTable tokens in raw SQL
queries

Temporary tables provide a workspace for intermediate results when processing or
passing data. When the operation is finished, temp tables are discarded
automatically.
v For best performance, use the <TempTable> token in raw SQL queries, especially

when querying large tables.
v If you are using in-database optimization and you specify a raw SQL query in a

Select process with an input cell, you must use the <TempTable> token to ensure
correct behavior. See below for a full explanation.

v If you are using in-database optimization, also use the <OutputTempTable> token
to prevent audience IDs from being unnecessarily copied from the database to
the Campaign server.

When you use a raw SQL query in a Select process with an input cell, the
processing behavior depends on whether you are using in-database optimization.
(In-database optimization is controlled globally with the Use In-DB Optimization
configuration setting. It is controlled for individual flowcharts with the
useInDbOptimization during Flowchart Run option on the Admin menu.)
v When in-database optimization is off: The list of IDs from the raw SQL query is

automatically matched against the ID list from the incoming cell. The resulting
list of IDs is a subset of the cell, as expected.

v When in-database optimization is on: Campaign assumes that the ID list
generated from the Select process is the final list. Campaign does not match this
list against the ID list of any incoming cell. Therefore, the raw SQL query
written for an intermediate Select process (a Select process with an input cell)
must use the <TempTable> token to properly join against the incoming cell.
Joining against the input cell ensures correct results and improves performance
by preventing extraneous processing for audience IDs that are not in the input
cell.
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In-database optimization is explained in the IBM Campaign Administrator's Guide.

Example: Using the TempTable and OutputTempTable tokens
This example shows how to use TempTable and OutputTempTable tokens in a raw
SQL query.

Assume that you have a Select1 process that selects 10,000 customers who are
"Gold" customers (for example, Indiv.AcctType = 'Gold'). You then connect Select1
to a second Select process ("Select2") using a raw SQL query:

Select p.CustID from Indiv p, <TempTable> where p.CustID =
<TempTable>.CustID group by p.CustID having sum(p.PurchAmt) > 500

This example selects customers the sum of whose purchases exceeds $500 and who
are in the input cell (in other words, customers who have a "Gold" account type).

In contrast, a raw SQL query omitting the <TempTable> token and join:

Select p.CustID from Purchases p group by p.CustID having sum(p.PurchAmt) >
500

first calculates the sum of purchases for all customers in the Purchases table (which
could be millions of customers) and then selects all customers the sum of whose
purchases exceed $500, regardless of whether they are "Gold" customers or not.

Therefore, for best performance, even if in-DB optimization is disabled, write your
raw SQL queries using the <TempTable> token when there is an input cell.

For simplicity, this example does not use the <OutputTempTable> token, but to
maintain in-DB optimization and prevent the audience IDs from being retrieved
from the database back to the Campaign server, you must include the
<OutputTempTable> token in your raw SQL query. For example:

Create table <OutputTempTable> as Select p.CustID from Purchases p,
<TempTable> where p.CustID = <TempTable>.CustID group by p.CustID having
sum(p.PurchAmt) > 500

Referencing Extract tables in raw SQL queries
You can reference an Extract table in downstream processes via raw SQL using the
<Extract> token. Use this token to specify subsets of data for subsequent
processing, which can improve performance when working with large tables.

The following example queries an Extract table to select the customer IDs of all
customers whose account balance exceeds $1,000.

Select p.CUSTOMERID from USER_TABLE p, <Extract> where p.CUSTOMERID =
<Extract>.CUSTOMERID group by p.CUSTOMERID having sum(p.BALANCE) > 1000

For flowcharts containing multiple Extract processes, the <Extract> token always
refers to the latest available Extract table.

Note: After a Merge, the <Extract> token may or may not be valid. Test run the
flowchart to determine if the token works as expected.
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How queries are evaluated in Campaign processes
Queries in Campaign processes are evaluated left to right using mathematical
rules.

For example, the following statement:

[UserVar.1] < PDF < [UserVar.2]

is evaluated as:

([UserVar.1] < PDF) < [UserVar.2]

That is, the first part of the statement ([UserVar.1] < PDF) is evaluated as true or
false (1 or 0), and the result is passed to the second statement:

[1 | 0 ] < [UserVar.2]

For the example to be evaluated as PDF greater than [UserVar.1] and less than
[UserVar.2], you would need to construct the following query:

[UserVar.1] < PDF AND PDF < [UserVar.2]

This statement is equivalent to the following:

([UserVar.1] < PDF) AND (PDF < [UserVar.2])
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Chapter 7. Offer management

Offers are specific marketing communications that you send to particular groups of
people, using one or more channels. Each offer is based on an offer template that a
Campaign administrator defines.

A simple offer from an online retailer could consist of free shipping on all online
purchases made in the month of April. A more complex offer could consist of a
credit card from a financial institution, with a personalized combination of
artwork, introductory rate, and expiration date that varies based on the recipient's
credit rating and region.

In Campaign, you create offers that can be used in one or more campaigns.

Offers are re-usable:
v in different campaigns;
v at different points in time;
v for different groups of people (cells);
v as different "versions" by varying the offer's parameterized fields.

The general workflow is:
1. (Optional) An administrator defines custom attributes.
2. An administrator creates offer templates (required) and adds custom attributes

to them (optional).
3. A user creates offers based on the templates.
4. A flowchart designer assigns the offers by configuring a contact process in a

flowchart or by relating offers to target cells that were defined in a target cell
spreadsheet.

5. The campaign runs, and the offer is made to the customer.

After an offer has been used in a campaign that has run in production mode, the
offer cannot be deleted. However, it can be retired. Retired offers cannot be
assigned, and any assigned offers that have been retired will no longer be sent.
Retired offers are grayed out in the offer hierarchy. They are still available for
reporting and response tracking.

Note: Working with offers requires the appropriate permissions. For information
about permissions, see the Campaign Administrator's Guide.

Offer attributes
Offer attributes are the information that defines an offer. Offer Name, Description,
and Channel are examples of offer attributes.

Some attributes are specific to a type of offer. For example, Interest Rate might be
an attribute of a credit card offer, but not of a free shipping offer.

There are three types of offer attribute:
v Basic: The fields that are required to define an offer, such as Offer Name,

Security Policy, a unique Offer Code, Description, and Relevant Products.
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v Standard: Offer attributes that are supplied with Campaign, which can
optionally be included in an offer. Examples are Channel, Effective Date, and
Expiration Date.

v Custom: Attributes that are created for your organization, such as Department,
Sponsor, Interest Rate, and SKU.

When administrators define offer attributes in an offer template, each attribute is
defined as either static or parameterized. The same offer attribute (for example,
Channel), could be static in one offer template, but parameterized in another.
v Static attributes: Offer attributes whose values do not change when you create a

different version of the offer. Examples are offer code, offer name, and
description.

v Hidden static attributes: Static attributes are included on an offer template but
hidden from the person who creates the offer. Hidden attributes can be searched
for, tracked, and reported on. For example, if a template includes Offer Cost (the
cost to your organization of administering the offer), you can search for all offers
that cost less than $1.00 to administer. The information can be used in reports
for performance ROI analysis.

v Parameterized attributes: Offer attributes whose values can be supplied when
the offer is assigned. For example, you can type a value, select an option from a
pre-defined drop-down list, or select a database field. When the offer template is
defined, your administrator can set up any standard or custom offer attribute as
a parameterized attribute.

Parameterized attributes in offer templates have default values that you can
override when the offer is created and when it is assigned. For example, the
introductory interest rate for a credit card offer could be parameterized in its offer
template with values of 5%, 8%, and 12%. When you use the template to create an
offer, you can select one of those values as the default interest rate. When the offer
is subsequently used in a flowchart and assigned to a cell, the flowchart designer
can change the interest rate to a different value.

Offer versions
An offer version is created each time you vary the parameterized attributes of an
offer to create a unique combination.

For example, you can vary the following attributes in a credit card offer:
v Artwork (lighthouse, kittens, or racing cars)
v Introductory rates (5.99%, 8.99%, or 12.99%)
v Offer valid dates (January, June, or September)

Thus, a credit card with the lighthouse image, 5.99% introductory rate, and offer
valid from September 1-31 is a different version of the offer than a credit card with
a different image, rate, or valid date.

Note: To uniquely identify specific instances of offer usage, use treatment codes.

Offer templates
When you create an offer, you base it on an offer template. Offer templates are
created in advance by an administrator.
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Every offer template includes several required fields, such as Offer Name and
Security Policy. Additionally, templates may include custom attributes that were
defined separately. For example, a template for creating "Reward Card" offers
might include a "Discount" drop-down list (a custom attribute) that contains the
values 10%, 15%, and 20%.

When you create an offer based on that template, you fill out any fields that are
defined in the template. For example, you supply an Offer Name, select a Security
Policy, and choose a default value from the "Discount" drop-down list. If you are
allowed to add values to the list, you see an Add button next to the attribute when
you create the offer. For example, if you add the value 25%, the list will then
contain four values (10%, 15%, 20%, 25%).

When you save the offer, it becomes available for use in campaign flowcharts. The
flowchart designer can then assign offers by configuring a contact process, such as
Mail List, Call List, or Optimize.

The behavior of drop-down lists in contact processes is controlled by the generic
configuration parameter disallowAdditionalValForOfferParam. This parameter
determines whether flowchart designers are restricted to selecting a value from the
list when they configure a contact process. If the parameter is true, designers can
only select values from the drop-down list. If the parameter is false, designers can
select values outside of the list, for example from a database table.

Treatments
Treatments are unique combinations of a cell and an offer version at a particular
point in time. Because they enable you to track responses in a very specific way,
using treatment codes for response tracking is a best practice.

Treatments are automatically created when you run a flowchart with contact
processes (Call List or Mail List) that have been associated with offers. Each
treatment is uniquely identified by a system-generated treatment code whose
format is specified in the offer template(s) from which the offer(s) were produced.
Treatment codes cannot be overridden by users.

Each time a contact process is run (except in test mode), Campaign records the
following details:
v The offer version(s) assigned in the contact process;
v The cell(s) to which the offers are assigned;
v The treatment code for each unique combination of offer version, cell, and

date/time;
v The contact process run date.

Running the same contact process twice (in production runs) creates two treatment
instances, each with a unique treatment code. This enables you to track responses
in a very specific way, back to an exact contact instance. For example, you could
run the same promotion on January 15 as you ran on February 15, and if you used
the treatment codes for tracking, people responding to the February 15 mailing
would be distinguishable from people responding to the January 15 mailing by
their treatment codes, even if they were targeted by both promotions.
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Treatment codes are not available prior to flowchart runs because they are
generated only at run-time, and therefore are not suitable for pre-printed codes
requirements. However, they can be output as Campaign-generated fields for
tracking or on-demand print purposes.

Creating offers
Create offers to represent the marketing messages that you want to communicate
to customers or prospects.

Before you begin

Before you can create an offer, an administrator must create at least one offer
template and you must have permission to use that template. To be able to create
offers in a folder, you must have appropriate permissions in the security policy
that governs that folder.

About this task

Whether you create a new offer or a new version of an existing offer depends on
how your administrator defined offer templates. You must create a new offer in the
following situations:
v Whenever non-parameterized offer fields change.
v When you need a new offer code for tracking purposes (for example, for

pre-printing response codes on mailers).

To create an offer you can follow this procedure, or you can duplicate an existing
offer and then edit it.

Procedure
1. Select Campaign > Offers.

2. Click the Add an Offer icon .
3. If only one offer template exists, the New Offer page opens. If there is more

than one offer template, you are prompted to select an offer template on which
to base your new offer.

Note: Template names that are displayed in gray are retired and cannot be
used for creating offers.

4. Click Continue.
5. Use the New Offer page to define the offer. The fields that you see depend on

the offer template that is being used. However, the following fields are always
included:

Option Description

Offer Name Offer names have specific character
restrictions. See Appendix A, “Special
characters in IBM Campaign object names,”
on page 233.

Security Policy A policy that is defined by your
administrator.

Description Optional.
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Option Description

Offer Code Offers are identified with unique
system-assigned offer codes based on a
format that is specified by your company. If
you override or regenerate offer codes,
Campaign cannot assure that the new offer
code is unique. If you use a non-unique
offer code for response tracking, your results
can be inaccurate.

For details about offer codes, see the
Campaign Administrator's Guide.

Relevant Products Optionally, list any product IDs to use for
inferred response tracking. For example, you
might want a Gum purchase to be
considered a response to your Candy offer.

Parameterized Attributes Optionally, select values and specify
defaults. The values that you can view and
change in the Parameterized Attributes
section are defined by the offer template you
are using.

Parameterized attributes are offer attributes
whose values can be supplied when the
offer is assigned. The Parameterized
Attributes section might contain fields,
buttons, or drop-downs from which you can
select predefined values or enter your own
default values. You can modify the
Parameterized Attributes section only if the
offer template has defined parameterized
attributes.

If a list of values is available and you are
allowed to add values to it, you see an Add
button next to the attribute. For example,
you might add the value 25% to a
"Discount" offer list.

If you add list items, those additions are
saved back to the custom attribute so they
are available to all users. After you save
changes, you cannot remove any items that
you added. Only administrators can remove
items from lists, by modifying the custom
attribute.
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Option Description

Offer Suppression for Real Time Interactions Optionally, determine whether to stop
presenting this offer in real-time interactions
based on criteria you specify. This section is
displayed only if you are defining an offer
using a template that has Allow offers
created from this template to be used in
real-time interactions selected.

For example, you might suppress this offer
from being presented to visitors who have
explicitly rejected it, or you might want to
suppress the offer after it has been presented
to a visitor a certain number of times.

For detailed information on using the Offer
Suppression for Real Time Interactions
section, see the Interact User's Guide.

6. Click Save Changes.

What to do next

To use the offer, assign it to a cell in a flowchart or a target cell spreadsheet (TCS).

Editing offers
You can edit an offer at any time, whether or not it has been used in a contact
process, depending on your roles and permissions.

About this task

After an offer is used in production (once it has been assigned to a cell in a
flowchart that has been run in production and logged to contact history), you can
edit only the offer name, description, and default values for parameterized offer
attributes. This restriction ensures that Campaign can track the exact offer details
for offers that have already been made.

Procedure
1. Select Campaign > Offers.
2. Click the offer name.

3. Click the Edit icon on the offer Summary page.
4. Make your changes.
5. Click Save Changes.

Digital assets from other IBM EMM products
Marketing campaigns created in IBM Campaign can include digital assets from
other IBM EMM products, including eMessage and Marketing Operations.

Viewing and editing eMessage assets that are linked to a
Campaign offer

You can view all of the related eMessage digital assets for an offer from the offer
Summary page and optionally edit the assets in the Content Library.
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Before you begin

Before you can view eMessage assets in an offer, you must use the eMessage
Document Composer to associate the offer with at least one asset in the Content
Library. Each asset can be associated with only one offer at time, but an offer can
be associated with more than one asset. For more information, see your eMessage
documentation.

About this task

After establishing the relationship between an offer in Campaign and assets in
eMessage, you can view those assets from the Campaign offer Summary page.

Procedure
1. Click Campaign > Offers.
2. Locate an offer that has eMessage assets.
3. Click the offer name.

The offer Summary page appears.
4. Click Link to IBM eMessage Digital Asset at the top of the Summary page.

The eMessage Content Library opens and displays a list of all of the eMessage
assets that are related to the offer.

5. You can double-click an asset to open it.
Related concepts:
“Overview of eMessage offer integration with IBM Campaign” on page 9

Introduction to using Marketing Operations assets in
Campaign offers

If both Marketing Operations and Campaign are installed, and you licensed the
IBM Marketing Asset Management add-on for Marketing Operations, your
campaigns can include digital assets from your Marketing Operations asset
libraries. Campaign does not need to be integrated with Marketing Operations,
although it may be.

An example of this functionality is to create an offer that includes a product logo
stored in a Marketing Operations asset library.

To include a Marketing Operations asset in an offer, a user creates an offer based
on a template that includes the CreativeURL attribute. A "Creative URL" is a
pointer that indicates the location of an asset in Marketing Operations. The asset
that the CreativeURL attribute points to is included in the offer.

The CreativeURL attribute allows users to move seamlessly from Campaign to
Marketing Operations when configuring offers, offer templates, or campaigns.

For example, when creating or editing a campaign, you can go from a target cell
spreadsheet (TCS) cell to the offer related to that cell. From the offer, you can go to
the related asset in Marketing Operations, where you can view or modify it. You
can also upload a new asset to the library for immediate use in the campaign.

The following example shows one possible workflow for a system. This example is
for a system that is not integrated. Your workflow might differ.
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Using Marketing Operations assets in Campaign offers
This topic explains how to relate a digital asset from Marketing Operations to a
Campaign offer, for systems that are not integrated. If Marketing Operations is
integrated with Campaign, and offer integration is enabled, you follow a slightly
different procedure. See the IBM Marketing Operations and Campaign Integration
Guide.

About this task

An asset is an electronic file that is designed for use in a marketing program.
Examples include logos, brand images, marketing research documents, reference
materials, corporate collateral, or document templates. If you use both Marketing
Operations and Campaign, you can include a file from a Marketing Operations
asset library as part of a Campaign offer. To include an asset in an offer, use the
CreativeURL attribute. A "Creative URL" is a pointer to a file in a Marketing
Operations asset library.

Table 12. Using Marketing Operations assets in Campaign offers

Task Details

Prerequisite: Create and populate
an asset library in Marketing
Operations.

Marketing Operations administrators create asset libraries, which serve as
repositories for files. Marketing Operations users can upload digital assets and
organize them in folders within the asset libraries.

For a list of prerequisites and guidelines, see the Campaign Administrator's
Guide.

Prerequisite: Add the CreativeURL
attribute to an offer template.

Campaign administrators add the CreativeURL attribute to an offer template
when they define the template.

For more information, see the Campaign Administrator's Guide.
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Table 12. Using Marketing Operations assets in Campaign offers (continued)

Task Details

Create an offer that is based on a
template that includes the
CreativeURL attribute, and relate
one asset to the offer.

1. Select Campaign > Offers, click Add an Offer , and select a template
that includes the CreativeURL attribute.

2. Use the New Offer page to define the offer (name, security policy, and
other information), then click Browse Library in the Creative URL. (Steps 2
- 5 can also be done from the Target Cell Spreadsheet view mode.)

3. In the dialog, click a library to open it. The library window opens.

4. In the library window, go to a folder in the asset library, and select the
asset that you want to use in this offer.

5. To add an asset, click Add Asset, then define the asset name, owner, and
other information. In the File field, click Upload, then browse to the asset.
You can upload a File, Preview File, or Thumbnail.

6. Follow the prompts to select and upload assets to the library, save changes,
and accept the asset.

7. Click Save Changes to save the offer.

A link to the specified asset is now included in the Creative URL field.

Assign offers to cells in the
campaign Target Cell Spreadsheet
(TCS).

1. Go to the All Campaigns page, click a campaign, select the Target Cells
tab, and edit the TCS.

2. Click in the Assigned Offers column and click Select one or more offers.

3. Use the Select Offers window to select the offer you created.

4. Save and exit the TCS.

Your campaign now includes a digital asset from Marketing Operations.
Typically, a campaign now goes through a review and adjustment process,
which is explained in the following steps.

Optionally, modify the offer. 1. Go to the All Campaigns page, click a campaign, select the Target Cells
tab, and edit the TCS.

2. Click in the Assigned Offers column and click View Offers . The
View/Edit Offer window opens.

3. Select the offer and click Preview. (If you decide to remove an offer, select
it and click Remove.)

4. To open the offer for editing, click the Edit icon at the top of the window.

5. With the offer open for editing, you can edit the values of parameterized
attributes. You can also access Marketing Operations assets:

a. Click the Browse Library link in the Creative URL field.

b. In the window that opens, click a library.

c. In the resulting window, go to a folder in the asset library, and select an
asset to use in this offer.

d. If you want to add an asset, click Add Asset, then provide the required
information. In the File field, click Upload, then browse to the asset.
You can upload a File, a Preview File, or a Thumbnail. Follow the
prompts to complete the action.

e. Click Save Changes to save the offer.

A link to the selected asset is now included in the Creative URL field.

Save and exit. Close the windows in IBM Marketing Operations and return to the Campaign
TCS. Save and exit the TCS.
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Assigning offers to cells in a flowchart
Flowchart designers assign offers to cells by configuring a contact process in a
flowchart. A cell is a list of customers who you want to contact with a specific
offer. A target cell is a cell that has an offer assigned to it. You can optionally
exclude control groups from contact, for analysis purposes.

Before you begin

Before you begin, you must create an offer so it is available for assignment. You
can also choose to associate offers with campaigns by using the Campaign
Summary tab. Offers that are associated with a campaign appear at the top of
selection lists as "relevant" offers.

About this task

Note: Organizations who use a "top-down" management approach assign offers to
cells in a target cell spreadsheet (TCS). A flowchart designer then selects recipients
for those offers. For more information, see “Assigning offers to cells in a TCS” on
page 161

Note: If Campaign is integrated with Marketing Operations, use Marketing
Operations to assign offers to output cells in the target cell spreadsheet (TCS) form
of a campaign project. You cannot assign offers in a contact process unless you are
working with legacy campaigns.

Follow these steps to assign offers to cells in a flowchart.

Procedure
1. Open a campaign and click a flowchart tab.
2. Click Edit in the flowchart window.
3. Double-click the contact process, such as Mail List or Call List, which contains

the recipients for your offer.
4. Use the Treatment tab to assign at least one offer to each cell.
5. Click the Parameters tab to see the names and values of each parameterized

offer that was assigned on the Treatment tab and to adjust the offer parameter
values.
For example, if a Mail List process includes a credit card offer, you can adjust
the terms that are offered. Depending on how the offer was defined, you might
be able to select values from a list. If a list is available, the configuration setting
Campaign | partitions | partition[n] | server | flowchartConfig |
disallowAdditionalValForOfferParam determines whether you can specify
more values or whether you are restricted to selecting values from the list.

What to do next

For more information, see “Configuring contact processes (Mail List or Call List)”
on page 97.

Associating relevant offers with campaigns
You can associate offers with campaigns to make it easier for users to select
relevant offers when they configure contact processes in flowcharts (assign offers to
cells).
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Procedure

1. On the Campaign Summary tab, click the Add/Remove Offers icon .
2. Select the offers that you want to add, and move them into the Offers to

Include list.
You can use Search to search for offers, or you can navigate through the
folders. Use Shift+Click or Ctrl+Click to select multiple offers.

3. Click Save Changes.

Results

The Relevant Offers area of the Campaign Summary tab shows all of the offers
that are associated with the campaign. The offers are grayed out until someone
uses them in a flowchart in this campaign.

As asterisk next to an offer name indicates that the offer was associated with a
campaign ("top-down" association). Offers that were used directly in a flowchart
("bottom up") without first being associated with a campaign do not have an
asterisk.

When users configure a contact process to create contact lists in campaign
flowcharts, relevant offers appear at the top of the list, so they are easy to locate
and select for assignment to one or more target cells.

Relevant products for offers
Relevant products are products that can be used for inferred response tracking to
determine whether an event (such as a purchase) is considered to be a response.
For example, if you list Gum as a relevant product for your Candy offer, then if a
customer purchases Gum, it is considered a response.

When you create an offer, there are two ways to define relevant products.
v You can use the Edit Query button to build a query which returns the list of

product IDs that you consider relevant.
v You can use Import Product IDs to type or paste a list of IDs from a source file,

then paste the resulting list into the Relevant Products field.

Note: When offer management is performed from IBM Marketing Operations, the
relevant products functionality, which relates product IDs to offers, is not available.

Assigning relevant products to an offer
You can assign a list of "relevant" product IDs to an offer. Relevant products are
products that are not explicitly part of the offer but which you intend to count as
responses.

Procedure
1. Choose Campaign > Offers, and create a new offer.
2. Click Import Product IDs on the New Offer page The Select Products dialog

opens.
3. Copy product IDs from your source file.
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Note: The source content can include one or more of the following delimiters:
tab, comma, or linefeed/newline. Multiple consecutive delimiters are ignored. If
product IDs are text strings, spaces are not stripped, and case is preserved.

4. Paste the IDs into the Import Product IDs list.
5. Click Import.

The Import feature builds a list in the right side of the dialog. You can edit the
content of the Import Product IDs list (paste additional items and edit existing
items), then click Import again to continue building the Select Products Where
list.
The Import feature does not allow duplicates; duplicate occurrences of the
same value are removed.

6. When the Select Products Where list contains the entries that you want, click
Save Changes to close the dialog.

Note: After you close the dialog, you cannot import additional IDs. If you click
Import Product IDs again, your existing IDs are cleared unless you click
Cancel.

What to do next

The product IDs from the Select Products Where list are saved as a query for the
offer, and the IDs are added to the Relevant Products list.

Changing the list of relevant products for an offer
When you assign relevant products to an offer, the list is saved as a query. You can
edit the offer if you want to change the query or remove items from the list.

Procedure
1. Choose Campaign > Offers, and open the offer that you want to edit.
2. Do one of the following:

v If you want to remove items from the list of Relevant Products, use
Ctrl+click or Shift+click to select the items, then click Remove.

v If you want to completely clear the list, click Import Product IDs. You can
then either exit or rebuilt the list.

v If you want to edit the query that generated the list, click Edit Query. The
Select Products dialog opens, and the Select Products Where list displays
the list of relevant products.
Use the controls to move entries out of the list or change the order. For
example, you can include additional query conditions. Add a query clause
using any attribute in the UA_Products table, including Product ID, and use
the >> button to move it to the Select Products Where list.
Click Save Changes to close the dialog and save the query.

3. On the offer Edit page, click Save Changes to save the offer.

Duplicating offers
You can create new offers by duplicating existing offers, to save data entry time.
You can duplicate retired offers or active offers.
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About this task

Offers that are created by duplication are automatically assigned unique offer
codes. They are named "Copy of <original offer name>" and have the same
description, security policy, and offer attribute values as the original offer.

Note: Duplicated offers are created in the same folder as their originals, but can be
moved to a different location later. You must have the appropriate permissions to
be able to duplicate and move offers.

Duplicating an offer from the Offers page
To save time, you can duplicate an offer from a list of offers. You can then change
the new offer so that it meets your needs.

Procedure
1. Select Campaign > Offers. The Offers page opens.
2. Navigate to the folder that contains the offer or offers that you want to

duplicate.
3. Select the check box next to each offer that you want to duplicate.

4. Click Duplicate Selected Offers .
5. Click OK to confirm. The selected offers are duplicated and display in the list

of offers.

Duplicating an offer from the offer's Summary page
To save time, you can duplicate an offer while you are viewing or editing its
summary information. You can then change the new offer so that it meets your
needs.

Procedure
1. On the Offer Summary page of the offer you want to copy, click Create

Duplicate Offer . A confirmation window opens.
2. Click OK to confirm. You see the New Offer page in Edit mode, with fields

populated with values from the original offer but with a new offer code.
3. Edit the values that you want to change, including the offer name and

description.

Note: Offer names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233

4. Click Save Changes to create the new offer.

Grouping offers
You can group offers for reporting or analysis purposes.

For example, you might want to see the response rates to a "Free Shipping" offer
that was sent through various channels and offered at different times of year.

Note: For any report to use an offer attribute for grouping or roll-up purposes, the
report must be customized by your report administrator.
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You can group offers in two ways:
v Using attributes
v In folders

Using attributes
You can create any number of custom attributes in your offers to use as "offer
grouping fields." For example, if you have various college-affiliation credit card
promotions, you could create a custom attribute called "region" that you can then
use in reports. This would allow you to group together offers targeted to alumni of
colleges in New England colleges versus those on the West coast.

When you create offers that use custom attributes, you must enter the values
manually. You can also duplicate a similar offer to reduce data entry effort, as the
values of parameterized attributes will also be copied.

Offer attributes can also be used within smart offer lists to identify and group
offers.

Grouping offers in folders
It can be useful to group offers in folders for reporting purposes. If you maintain
all related offers in the same folder, and specify the folder as the target when
prompted for offers to report on, all the offers in that folder (and in any of its
subfolders) are automatically selected for reporting.

Note: Including folder and subfolder contents for reporting in this way does not
achieve "roll up" reporting for the offers. They are simply selected based on
inclusion in a folder structure.

Moving offers or offer lists
You can move one or more offers among folders. The procedure for moving offers
is the same as for moving offer lists, and you can move offers and offer lists in the
same operation.

Before you begin

Access to different locations is governed by different security policies. You can only
move offers into a folder with a security policy in which you have permissions to
do so.

Procedure
1. From the Offers page, select the offers or lists that you want to move, and click

the Move Selected Items .
An alternative way to move an offer (but not a list) is to view its Offer

Summary page and click Move to Another Folder .
2. Select the destination folder and click Accept this Location.
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Retiring offers or offer lists
If you have the appropriate permissions, you can retire offers and offer lists to
prevent their further use. Retired offers can no longer be assigned and cannot be
given out as part of an offer list.

About this task

Retired offers remain visible in the offer hierarchy but are grayed out. They can be
found using the search feature, can be duplicated to create new offers, and are
available for reporting.

Note: A retired offer cannot be re-enabled. If you need an offer with the same
details, you can create a new one by duplicating the retired offer.

Retiring an offer does not affect campaigns or flowcharts in which the offer has
already been used, and maintains the data integrity with any system table data
that has been generated based on the offer, such as contact and response history.

You can clean up static offer lists by deleting retired offers from them. Smart offer
lists do not require cleanup as they will resolve only to non-retired offers matching
their query criteria.

The procedure for retiring offers is the same as that for retiring offer lists, and you
can retire offers and offer lists in the same operation.

Procedure
1. From the Offers page, select any offers or offer lists that you want to retire, and

click the Retire Selected Lists icon .
Another way to retire an offer is to view its Offer Summary page and click the

Retire This Offer icon . However, this method is available only for offers,
not offer lists.

2. Click OK.

Results

The selected offers and offer lists are retired and display in gray.

Deleting offers or offer lists
You must have the appropriate permissions before you can delete an offer or offer
list. In addition, to preserve system integrity, Campaign does not allow you to
delete offers or offer lists that are referenced in system tables.

This includes offers or offer lists that:
v are associated with a campaign
v have been assigned to a cell in a contact process in a flowchart for which contact

history has been populated
v have been assigned to a cell in an Optimize process in a flowchart

Important: If you attempt to delete an offer or offer list in these situations, a
confirmation message indicates that the offer or offer list will be retired instead of
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deleted. You can back out if you want. To prevent further use of offers or lists that
have been referenced in system tables, you should retire rather than delete them.

If the offers you want to delete belong to any static offer lists, you will be asked to
confirm the deletion. If you choose to continue, the deleted offer(s) are
automatically removed from any static offer lists.

Contact processes containing cells that were assigned offers that have subsequently
been deleted will remain configured, but the offer will be indicated as "Unknown
Offer" in the process configuration dialog, and a warning will be produced when
the flowchart is run.

The procedure for deleting offers is the same as that for deleting offer lists, and
you can delete offers and offer lists in the same operation.

Deleting an offer or offer list
You use the same procedure to delete an offer or an offer list.

Procedure
1. From the Offers page, select the offer(s) or offer list(s) that you want to delete,

and click the Delete Selected Items icon .
OR
From the Offer Summary page of the offer you want to delete, click the Delete

This Offer icon . A confirmation window opens.
2. Click OK. You are returned to the Offers page. The deleted offer no longer

displays.

Searching for offers
You can search for offers but not for offer lists.

You can perform a basic search for offers using any of the following criteria:
v Name or partial name
v Description or partial description
v Offer code or partial offer code
v Owner name

In addition, you can use the Advanced Search feature to find offers or offer lists
using queries based on offer attributes and specified values.

Searching for offers with Advanced Search
With the Advanced Search option, you define a query to find the offers that match
your specifications.

Procedure

1. From an Offers folder, click Advanced Search .
The Advanced Search Options window opens.
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2. In the Create a Condition section, select an offer attribute to use in the On
This Attribute field.

3. Based on the type of attribute you selected, you can enter further conditions for
searching. For example:
v On the attribute "Cost Per Offer", search for values less than or equal to

$10.00
v On the attribute "Expiration Date", search for specified date of 11/30/2007
v On the attribute "Description", search for specified values that do not contain

the string "2005"
4. Click AND>> or OR>> to move your criteria to the Find Offers Where section,

and to build your query. To remove a condition from the Find Offers Where
section, click <<.

Note: Depending on the operator(s) that you use in your query (that is, =, >,
contains, begins with, and so on), you might be able to select multiple values
or only a single value. In some cases when you choose multiple values with an
operator, you create "OR" conditions. For example, if you create a query where
"Color =" and select blue, red, and white as the colors, the query you create is
"Color = blue OR color = red OR color = white."

5. When you finish building your query, click Search.
The Search Results page lists any offers that match your search criteria.

Analyzing offers
Use IBM Campaign reports to analyze an individual offer or do a system-wide
analysis across multiple offers.

Procedure
1. To analyze an individual offer:

a. Select Campaign > Offers.
b. Click the name of an offer.
c. Click the Analysis tab.
d. Select a report from the Report Type list at the top right of the page. The

report displays in the same window.
2. To analyze results across multiple offers:

a. Select Analytics > Campaign Analytics.
b. Click one of the report folders.
c. Click a report link.

If the report allows filtering, the Report Parameter window opens.
d. Select one or more objects on which to filter the report. Use Ctrl+click to

select multiple objects. Your permissions determine which objects appear.
e. Click Generate the Report.

The report displays in the same window. The report generation date and
time are displayed at the bottom of the page. If the report spans more than
one page, use the provided controls to move to the top or bottom of the
report or to page up and down.
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Offer lists
Offer lists are configurable groups of offers that you can use to manage offers. The
same offer can exist in more than one offer list. You can add offers to offer lists
and assign offer lists to cells. You can also edit, move, delete, or retire offer lists.

After an offer list has been used, it cannot be deleted but it can be retired. Retired
offer lists can no longer be assigned. Assigned offer lists that have been retired will
no longer be given out.

There are two types of offer lists:
v “Static offer lists”: Pre-defined lists whose contents do not change unless you

edit the list.
v “Smart offer lists”: A dynamic list of offers that is specified by a query, so its

contents can change each time it is used.

Offer lists appear in the same hierarchy as offers, but are identified by different
icons:

Offers

Static offer lists

Smart offer lists

Note: Working with offer lists requires the appropriate permissions. For
information about permissions, see the Campaign Administrator's Guide.

Smart offer lists
Smart offer lists are dynamic lists of offers which can resolve to different sets of
results each time a smart list is used. A smart offer list is specified by a query
which can be based on offer attributes, offer locations (folders or subfolders), offer
owner, and so on.

Generally you use smart offer lists for periodically recurring campaigns. You can
set up a cell to receive a smart offer list and then change the contents of the smart
offer list without having to modify the flowchart. For example, if you set up a
smart offer list to be the contents of a particular folder, then you can simply add or
remove offers to and from that folder to modify the offers given out each time the
campaign is run.

A further example for using smart offer lists involves setting up the smart offer list
to automatically return the offers you want to give out. If you want to give your
"high-value customer" cell the "best credit card offer" available, you can set up a
smart offer list that includes all credit card offers, sorted by the lowest interest rate
and with maximum size set to 1. The lowest interest rate credit card offer available
at the time(s) that the flowchart contact process is run is automatically found and
given to the high-value cell.

Static offer lists
Static offer lists are pre-defined lists of offers whose contents do not change unless
you explicitly edit the list.
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A limitation of static offer lists is that default values are used for any
parameterized offer attributes.

Generally you use static offer lists to repeatedly reuse a specific, fixed set of offers.
For example, if you have 5 each of RFM (Recency, Frequency, Monetary) segments,
giving you 125 cells, and you want to assign the same offers to each cell, you can
create a single set of offers in a static offer list, and assign that offer list to all 125
cells. The same type of reusability applies across flowcharts and campaigns.

Security and offer lists
Object-level security applies to offer lists, based on the folders where your offer
lists and the offers included in your lists reside.

When you create a static offer list, you can only add offers to which you have
access. However, anyone with permission to access an offer list is automatically
granted permissions to access the offers included in that list. Therefore, anyone
who can access your list can also use that offer list and all the offers within it, even
if they would not normally have access to those offers based on their security
permissions.

Similarly, users who can access a folder containing a smart offer list can use that
smart offer list. They will get the same result as anyone else running that offer list,
even if they would not normally have access to particular offers (for example in
another division's folders).

Creating static offer lists
To create a static offer list, you select individual offers to include in the list.

Procedure
1. Select Campaign > Offers.

2. Click Add a List .
3. Enter a name, security policy, and an optional description.

Note: Offer list names have specific character restrictions. See Appendix A,
“Special characters in IBM Campaign object names,” on page 233.

4. Verify that This is a "Smart" offer list is not checked.
5. In the Included Offers section, use the Tree view or List View to select offers

to add to the list. Move the selected offers to the Included Offers box using the
>> button.

6. Click Save Changes.

Creating smart offer lists
To create a smart offer list, you specify characteristics for the offers to include in
the list. The result is a dynamic list that can resolve to different results each time
the smart list is used.

About this task

Note: Newly created offers can become part of smart offer lists with no action on
your part if they meet the smart offer list query criteria.

Chapter 7. Offer management 141



Procedure
1. Select Campaign > Offers.

2. Click Add a List .
The New Offer List page opens.

3. Enter a name, security policy, and an optional description.
4. Select This is a "Smart" offer list.
5. In the Included Offers section, use existing offer attributes, their values, and

the AND and OR operators to create conditions for including offers in the list.
6. You can use the folder view under Restrict search access (for all users) to limit

the search to selected folders. To include subfolders in search results, select the
Include Subfolders check box.

Note: Any offers that are chosen as a result of this search are available to any
user with access permissions to this offer list, even if they do not normally
have permissions to see or access the offers.

7. Use the lists under Order Matching Offers by to select the offer attribute by
which you want matching orders to be sorted, and specify whether the sort is
in Ascending or Descending order.

8. Indicate whether to limit the search results to the first "X" offers that match. By
default, there is no limit.

9. Click Save Changes.

Editing offer lists
When you change an offer list, the campaigns that use the list use the updated
offer list definition the next time they are run.

Procedure
1. Select Campaign > Offers.
2. Click the hyperlinked name of the offer list that you want to edit.

The Summary tab for the offer list appears.

3. Click Edit .
4. Make your changes.

Offer list names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233.

5. Click Save Changes.

How to retire offer lists
You can retire an offer list at any time to prevent its further use. Retiring an offer
list does not affect the offers contained in that list.

Retired offer lists remain visible in the offer hierarchy, but are grayed out. They are
available for reporting; however, they can no longer be assigned.

Note: After you retire an offer list, you cannot re-enable it. If you need an offer list
with the same details as a retired one, you must manually recreate it.

You retire offer lists by performing the same steps as you do to retire offers, and
you can retire offers and offer lists in the same operation.
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Offer list assignment to cells
You can assign offer lists to cells in contact processes in the same way that you
assign individual offers. You can assign any combination of offers and offer lists to
the same cell.

However, any parameterized attributes in the offers that are in the offer list use
their default values. You cannot assign parameter values for offers that are in the
offer list. In order to change parameterized values, you can do one of the
following:
v Change the default values associated with the existing offer, create a copy of the

offer with the new defaults, and ensure that it is used in the offer list.
v Assign the offer individually, outside of an offer list.

Offer lists in systems that are integrated with Marketing
Operations

If your Campaign environment is integrated with Marketing Operations, you must
use Marketing Operations to assign offers or offer lists to output cells in the target
cell spreadsheet form of a campaign project. For more information, see “Overview
of IBM Marketing Operations integration with IBM Campaign” on page 11.

Offer lists and legacy campaigns

If your Campaign environment is configured to access legacy campaigns, use the
instructions in this guide to assign offers or offer lists to output cells in legacy
campaigns. For legacy campaigns, there are two ways to assign offers to cells: from
the campaign's target cell spreadsheet, or within a process configuration dialog.
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Chapter 8. Target cell management

A cell is a group of people that you want to target, such as high value customers.
A target cell is a cell that has an offer assigned to it.

Cells are created when you configure and then run a data manipulation process
(Select, Merge, Segment, Sample, Audience, or Extract) in a flowchart. For example,
a Select process can generate an output cell that consists of Gold customers. An
output cell can be used as input for other processes in the same flowchart.

You create a target cell by assigning an offer to a cell. You can assign offers by
configuring a contact process (such as a Mail List or Call List) in a flowchart or by
editing the Target Cell Spreadsheet (TCS). Most organizations use only one of the
two approaches:
v Bottom-up: A campaign designer creates offers, then assigns offers by

configuring a Mail List or Call List process in a flowchart.
v Top-down: A marketing manager creates offers, then assigns the offers in a

Target Cell Spreadsheet (TCS). A campaign designer then creates a flowchart to
select recipients for the offers, and links the flowchart cells to cells in the TCS.

Every cell has:
v A system-generated cell name, unique within the current flowchart.
v A system-generated cell code. The cell code has a standard format that is

determined by your system administrator and is unique when generated. Cell
codes are not checked for uniqueness unless the flowchart configuration
parameter AllowDuplicateCellCodes is set to "No." In this case, cell codes are
enforced to be unique only within the current flowchart.
Cell codes and cell code generators are explained in the Campaign Administrator's
Guide. Configuration parameters are explained in the Marketing Platform
Administrator's Guide.

Generating cells in a flowchart
When you run a data manipulation process in a flowchart, the process generates
one or more cells as output. A cell is a list of IDs. The generated output can be
used as input into downstream processes.

Data manipulation processes include Select, Merge, Segment, Sample, Audience,
and Extract. When you run a configured process, one or more cells are created as
the output. The number of cells that is generated depends on the type of process
and its configuration details. For example, you can configure and then run a Select
process to generate an output cell of high-income households. You can use that cell
as input into a Segment process to divide the contacts by age. The resulting output
from the Segment process would be multiple cells, segmented into age groups.

If your organization uses top-down management to define campaigns, you can link
output cells in a flowchart to placeholder target cells that were defined in the
Target Cell Spreadsheet (TCS). In this way, the campaign designer generates output
that meets the goals that are defined in the TCS.
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Limiting the size of output cells
To limit the number of IDs generated by data manipulation processes such as
Audience, Extract, Merge, or Select, use the Cell Size Limit tab of the process
configuration dialog.

The options for limiting output cell size depend on whether the process accepts
input from a cell or a table. In processes that can accept either type of input, the
Cell Size Limit window changes dynamically to present options appropriate to the
input type.
v Processes taking input from an output cell
v Processes taking input from a table

For either type of input, you can also change the random seed. The random seed
represents the starting point that Campaign uses to select IDs randomly.

Processes taking input from an output cell
If a process takes input from an output cell, the Cell Size Limit tab includes the
options described below. Use these options to limit the number of IDs that the
process will output.

Use the following controls to affect the output cell size:
v Unlimited cell size returns all IDs that satisfy the query or selection criteria.

This option is the default.
v Limit output cell size to returns no more than the specified number of unique

IDs, selected randomly from all IDs that meet the query criteria. In the text box,
enter the maximum number of IDs that you want returned. Campaign matches
the deduplicated records that are returned from the database to those of the
input cells, then does a random selection to arrive at the final cell size. The ID
list in cells that are passed from process to process is always unique.

Note: Use the Random option only when it is important for exactly N records to
be returned. This option uses a large amount of temporary space and takes the
most time because all IDs must be retrieved to the Campaign server.

v Limit output cell size based on sizes of input cells: For information about this
option, see “Limiting the output cell size based on the input cell size” on page
147.
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Limiting the output cell size based on the input cell size
In processes that take input from cells, you can use the sizes of cells from
connected incoming processes as attributes for limiting the output cell size, even if
you are not using the actual cell data or IDs.

About this task

For example, if you connect 3 processes that each have one output cell, to a Select
process, you might use only one of the three incoming cells as the actual data
input for the Select process, but you can use the attributes of the other incoming
cells to specify the output cell size for the Select process. A solid line connects the
process whose output cell is actually used by the Select process; dotted lines
connect the processes whose output cells are not used as data input but only have
a temporal relationship with the Select process.

Use the Limit output cell size based on sizes of input cells checkbox to specify
the input cells whose size attributes you want to use for limiting your current
process's output cell size. Some of these options act in conjunction with the Limit
output size to value that you specify.

Procedure
1. Click the Cell Size Limit tab in the process configuration dialog.

You see the Cell Size Limit window.
2. Choose the method by which the limits will be calculated:

v Largest Checked Cell: Specifies that the output cell size should not exceed
the size of the largest selected input cell. For example, if cells A and B are
checked, with sizes of 100 and 200, the size of the output cell for this process
would be limited to 200.

v Maximum Size (Above) Minus Sum of All Checked Cells: Use this option
in conjunction with the Limit output cell size to value specified above. This
option specifies that the output cell size should not exceed N, where N is the
difference between the number specified in the Limit output cell size to field
above, and the sum of all selected input cells. For example, if you entered
1000 as the Limit output cell size to value, and checked input cells A and B
with sizes 100 and 200 respectively, the size of the output cell for this process
would be limited to 1000 – (100+200) = 700.

v Size of Any Checked Cells: Specifies that the output cell size should not
exceed the size of any of the selected input cells. For example, if cells A, B,
and C are checked, with sizes of 100, 200, and 500 respectively, the size of the
output cell for this process would be limited to 100.

v Sum of All Checked Cells: Specifies that the output cell size should not
exceed the total (sum) of all the selected input cells. For example, if cells A,
B, and C are checked, with sizes of 100, 200, and 500, the size of the output
cell for this process would be limited to 800, the sum of all three of the input
cell sizes.

3. In the list of input cells, select the check boxes for the input cells on whose
size(s) you want the output cell size criteria to be based.

Processes taking input from a table
If a process takes input from a table or strategic segment, the Cell Size Limit tab
includes the options described below. Use these options to limit the number of IDs
that are output by the process in production or test runs.
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You can individually control the output size for production runs and test runs.

Specify output cell size limitation

These options affect production runs of the process. The key difference between the
Limit options is their impact on resources and the final number of records when
your data source is non-normalized.
v Unlimited cell size: Returns all IDs that meet the query or selection criteria.

This option is the default.
v Limit output cell size to: Returns no more than the specified number of unique

IDs, selected randomly from all IDs that meet the query criteria. In the text box,
enter the maximum number of IDs that you want returned. Campaign
deduplicates the complete set of IDs before random selection, then retains only
the specified number of records, so that a list of unique IDs is returned even
when duplicates exist on the ID fields. This option uses a large amount of
temporary space and takes the most time because all IDs must be retrieved to
the Campaign server. Use this option only when the data is not normalized on
the ID field and if it is important that exactly N records are returned.

v Limit selection based on: Use this option to limit records that meet your query
criteria. This option reduces the time and memory that are required to select the
final set of records. However, it can result in fewer than the specified number of
unique IDs.
– First N (fastest): Campaign retrieves from the database only the first N

records that meet your query criteria. Campaign then deduplicates these IDs.
If the data is not normalized, then the final result contains fewer than the
requested number of unique records. This method is the fastest because it
takes less time to retrieve data and uses less temporary space.

– Random: Campaign retrieves from the database all records that meet your
query criteria, then randomly selects the number of records requested.
Campaign then deduplicates those IDs. If the data is not normalized, the final
result contains fewer than the requested number of unique records. This
option uses less temporary space because only the randomly selected records
are retrieved and stored by Campaign.

Test Run output cell size limitations
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In some processes, including Audience and Select, you can limit cell size
specifically for test runs. Use these options to control the amount of data returned
and processed during test runs. For information, see “Applying test run output cell
size limitations.”

Applying test run output cell size limitations
In some processes, including Audience and Select, you can limit cell size
specifically for test runs.

Use the options in this section to control the amount of data returned and
subsequently processed during a test run.
v Unlimited cell size: This is the default option. The number of IDs returned from

the query or selection criteria on the Source tab of this process is not changed.
With this option, the test run operates on all the data that it would during a
production run, but offer and contact histories are not populated.

v Limit output cell size to: Returns an exact specified number of IDs, selected
randomly from all IDs that meet your query criteria. In the text box, enter the
number of IDs that you want returned. With this method, Campaign
deduplicates the complete set of IDs prior to random selection, then retains only
the specified number of records, so that a list of unique IDs is returned even
when duplicates exist on the ID fields.

Note: Selecting records with this option uses a large amount of temporary space
and takes the most time, because all IDs must be retrieved to the Campaign server.
Use this option only when the data is not normalized on the ID field, and if it is
important for exactly N records to be returned.

Changing the random seed for record selection
The random seed represents the starting point that Campaign uses to select records
randomly.

About this task

If you are selecting records randomly, there are times when you might want to
change the random seed. For example:
v Your random sample is producing highly skewed results (for example, if all

males in your data fall into one group and all females into another).
v You have the same number of records in the same sequence, and using the same

seed value each time that you run this process results in records being created
into the same samples.

Follow the steps below to generate a different starting point for random record
selection.

Procedure
1. Click the Cell Size Limit tab of a process configuration dialog.
2. Use one of the following methods:

v Enter a numeric value in the Random Seed text box.
v Click the Pick button to randomly select a new seed value.
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Cell names and codes
Cell names and codes are important because they establish the links between
processes that output cells or use cells as input.

Cell codes

Cell codes have a standard format determined by your system administrator, and
are unique when generated. Cell codes can be edited. Therefore, they are not
checked for uniqueness unless the flowchart configuration property
AllowDuplicateCellCodes is False, in which case cell codes are enforced to be
unique only within the current flowchart. There is no checking for uniqueness in
the target cell spreadsheet (TCS). For details about cell codes and cell code
generators, see the Campaign Administrator's Guide.

Cell names

Note: Cell names have specific character restrictions. For details, see Appendix A,
“Special characters in IBM Campaign object names,” on page 233.

By default, cell names are based on the process from which they are generated. For
example, if a cell is generated by a process named "Select1", then the default cell
name is "Select1". You can change the cell name. If you change a process name, the
names of cells generated by that process are automatically changed as well, both in
that process and in any connected downstream processes within the same
flowchart. If you change a cell name, you might also affect the links between that
cell and any downstream processes using that cell as input.

For example, if a Segment process generates two output cells named Segment1 and
Segment2, and these cells are used as input into two Mail List processes (Mail List
1 and Mail List 2), if you change the names of the Segment cells after you have
already connected the Mail List processes, you need to understand how Campaign
handles the new cell names.

The following diagram illustrates a basic example of a Segment process that
outputs two cells, each cell then becoming the input for downstream Mail List
processes.
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Examples: cell renaming scenarios
Scenario 1: All new cell names are different from any of the
original names

If no new cell names overlap with the original default names (that is, in the
example, if you do not use "Segment1" or "Segment2" as the name for either of the
Segment output cells), then Campaign can maintain the original linkages based on
the original "order" of the cells. In this situation, because there is no overlap or
re-use of either of the original cell names, the linkage between the output cells
from the Segment process and the two respective Mail List processes remains
unchanged, as shown in the following diagram.

Scenario 2: The set of new cell names is identical to the original
set of cell names, but re-ordered

If the new names you choose for your cells are exactly the same as the names in
the original set and simply re-ordered, the downstream processes will look for
available output cells by name (that is, the new cell names), and the linkages will
be switched as necessary. In the example, the newly renamed Segment2 output cell
is now the input cell to Mail List 2, and the newly named Segment1 cell is now the
input cell to Mail List 1, as shown in the following diagram.
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The following diagram illustrates the same situation with three output and input
cells.

Scenario 3: The set of new cell names overlaps with some of the
original cell names, and new cell names are introduced

If the new names overlap with some of the original names, and new cell names are
added, any links using names in the original set of cell names can be recognized,
otherwise they are broken. For example, if you rename cell "Segment1" to
"Segment2" and rename cell "Segment2" to "NewSegment", the new "Segment2"
will be hooked up to Mail List2 and Mail List1 will become unconfigured, because
it cannot find an input cell name with the name "Segment1."
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Changing the cell name
By default, the name of a cell created in a process matches the process name. For
processes that create more than one cell, the output cell names are a concatenation
of the process name and the segment name. For example, a Segment process
named "Segment1" creating 3 segments will have output cells whose default names
are "Segment1.Segment1", "Segment1.Segment2", and "Segment1.Segment3."

Cell names are designed to be linked to the name of the process from which they
were created. If you edit a process name, the cell names will automatically change
as well.

However, if you edit the cell names, you remove their link to the process name.
This means that if you subsequently change the process name, the cell name(s) will
no longer automatically change.

To change the name of a cell in a flowchart process
About this task

Note: When you save changes to the output cell name, if Auto Generate is
selected for the cell code, the cell code is regenerated. If you do not want the cell
code to change, uncheck Auto Generate prior to editing the cell name.

Procedure
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to change. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process,

including the process name and the output cell name.
3. Place your cursor in the Output Cell Name field so that the text is selected,

and edit the cell name.
4. Click OK. Your changes are saved. If you have edited the cell name so that it

no longer matches the process name, these names are no longer linked.

Note: Saving a flowchart does not trigger any type of validation. To check that
your flowchart has configured correctly with no errors, you can manually
perform a flowchart validation.
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Resetting the cell name
By default, the name of a cell created in a process matches the process name. For
processes that create more than one cell, the output cell names are a concatenation
of the process name and the segment name. For example, a Segment process
named "Segment1" creating 3 segments will have output cells whose default names
are "Segment1.Segment1", "Segment1.Segment2", and "Segment1.Segment3."

If you rename the process, the cell name(s) will automatically change as well, so
that the cell name and process name remain linked.

However, if you have change the cell name manually so that it is different from the
process name, the cell and process names are no longer linked. You can restore the
link by renaming the cell name to the same as the process name.

To reset the cell name
Procedure
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to reset. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process.
3. The next step varies depending on whether you are editing a process that

outputs a single cell or multiple cells:
v In processes that output a single cell, edit the text in the Output Cell Name

field so that it is identical to the process name displayed in the Process Name
field.

v In processes that output multiple cells, click Reset Cell Names. The cell
names revert to the default format, which is a concatenation of the current
process name and the segment name.

The process and cell names are now relinked. If you now change the process
name, the output cell name will automatically change as well.

4. Click OK. Your changes are saved and the process configuration dialog closes.

Changing the cell code
By default, a cell's code is automatically generated by the system, based on the
format defined for all cell codes by your system administrators. Cell code
uniqueness is enforced across flowcharts and campaigns, but cell codes can be
duplicated within flowcharts if you have the flowchart configuration parameter
AllowDuplicateCellCodes set to "Yes."

For more details about configuration parameters in the central configuration
parameter provided by IBM EMM, see the Marketing Platform Administrator's Guide.

Note: Although you can override the default system-generated cell code, any cell
code you enter manually must still conform to the cell code format. This format is
displayed below the Cell Code field in the process configuration dialog. Code
formats are represented by constants and variables as follows: uppercase letters
represent alphabetical constants, a lowercase "n" represents a numeric character.
For example, a cell code format of "Annn" indicates that the cell code must be 4
characters long, with the first character being uppercase "A", followed by 3
numbers. A sample cell code of this format would be "A454."
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To change the code for a cell in a flowchart process
Procedure
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to change. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process.
3. Clear the Auto Generate checkbox if it is selected. The Cell Code field becomes

editable.
4. In the Cell Code field, edit the cell code. Remember that the modified code

must conform to the cell code format displayed below the Cell Code field.
5. When you have finished editing the cell code, click OK. The process

configuration dialog closes and your changes are saved.

About copying and pasting cell names and codes
In processes that output more than one cell, you can use the copy and paste
feature to edit multiple output cell names and codes in the Output Cells grid.

To copy and paste all cells in the grid
About this task

In processes that output more than one cell, you can use the copy and paste
feature to edit multiple output cell names and codes in the Output Cells grid.

Procedure
1. In a flowchart in Edit mode, double-click the process for which you want to

copy and paste cell names and codes. You see the process configuration dialog
for the process.

2. Click the General tab. You see the general information for the process,
including the Output Cells grid.

3. In the Output Cells grid, click anywhere to select all cells. All cells are always
selected for pasting regardless of the cursor position.

Note: The Cell Code column is not selectable or editable unless you clear the
Auto Generate Cell Codes checkbox.

4. Click Copy. All cells are copied to the clipboard.
5. Click inside the cell that will be at the top left position of where you want to

paste the cells.
6. Click Paste. The contents of your copied cells replaces the original content of a

block of cells the same size as that which was copied.

To paste cell names and codes from an external spreadsheet
Procedure
1. Select and copy cells or text from an external spreadsheet or other application

using that application's copy feature.
2. In Campaign, in a flowchart in Edit mode, double-click the process for which

you want to copy and paste cell names and codes. You see the process
configuration dialog for the process.

3. Click the General tab. You see the general information for the process,
including the Output Cells grid.

Note: The Cell Code column is not selectable or editable unless you clear the
Auto Generate Cell Codes checkbox. If you want to paste content into the Cell
Code column, make sure you clear this checkbox.
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4. Click inside the cell where you want to paste what you have copied. If you are
copying and pasting a rectangular group of cells, click inside the cell that will
be the top left cell of the rectangle.

5. Click Paste. The contents of your copied cell(s) replaces the original contents of
a block of cells the same size.

Target cell spreadsheets
Each marketing campaign has a target cell spreadsheet (TCS), which provides a
visual matrix of segments and offers. The TCS provides the ability to build and
examine relationships between target cells and their associated offers or controls.
(Controls are not contacted with an offer., even though they qualify for the offer.)

Note: To use the target cell spreadsheet, you must have Global Policy permission
to Manage Campaign Target Cells.

The TCS includes one row for each target cell and, if you use control groups, one
row for each corresponding control cell. A target cell is a cell that has an offer
assigned to it. A control cell is qualified for the offer but is excluded from receiving
the offer for analysis purposes. Controls do not receive communications, but are
measured against the target group for comparison.

When you work with the TCS, you can use a top-down or bottom-up management
approach. Most organizations use only one of the following management methods.

Table 13. Top-down and bottom-up TCS management

Top-down This approach typically is used by larger organizations, where one person
creates the TCS and another person designs the flowchart.

The first person creates a TCS that contains target and control cells. For
example, the TCS for a direct mail campaign might include 4 rows: One
row for a cell that gets a 10% offer, one row for a cell that gets a 20% offer,
one row for 10% holdouts, and one row for 20% holdouts.

Then, the flowchart designer creates processes to select IDs that meet the
10% and 20% offer and hold-out criteria. To link the data manipulation
process output to a pre-defined cell in the TCS, the flowchart designer
selects Link to Target Cell in each process configuration dialog box.

Bottom-up Create a flowchart that includes a Mail List or Call List process.

When you save the flowchart, a TCS is generated. The TCS includes one
row for each target cell that provides input to the Mail List or Call List
process.

Bottom-up cells cannot be linked or unlinked. The concept of linking
applies only to top-down management.

When you work with a target cell spreadsheet, keep in mind the following
guidelines:
v Linking is based on cell codes, so avoid changing cell codes after you link cells.
v You can unlink or relink a cell at any time, provided the cell did not write to

Contact History.
v If you unlink a cell that has Contact History, it is "retired". Retired cells cannot

be linked again. They do not appear in the target cell spreadsheet and they
cannot be selected in a process configuration dialog box. (If Campaign is
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integrated with Marketing Operations, retired cells continue to be displayed in
the target cell spreadsheet but cannot be reused.)

Important: Incorrect data might be saved if edits are made to the flowchart and
the TCS by different users at the same time. To avoid conflicts, define business
rules that minimize the possibility of a TCS being edited when its flowchart is
being edited or run. For example, do not edit a flowchart contact process while
another user is changing offer assignments in the TCS.

Note: If Campaign is integrated with Marketing Operations, you must use
Marketing Operations to work with target cell spreadsheets.
Related tasks:
“Linking flowchart cells to targeted offers defined in a TCS” on page 163
“Unlinking flowchart cells from targeted offers defined in a TCS” on page 165
“Using Match & Link to remove an association” on page 165
“Using Match & Link to associate flowchart cells with a TCS” on page 164

Managing target cell spreadsheets
The target cell spreadsheet (TCS) for a marketing campaign provides a visual
matrix of segments and offers. The TCS provides the ability to build and examine
relationships between target cells and their associated offers and hold-outs.

Editing a target cell spreadsheet
You edit a TCS so that it contains target and control cells for the offers you intend
to make.

About this task

For example, the TCS for a direct mail campaign might include four rows: One for
a 10% offer, one for 10% holdouts, one for a 20% offer, and one for 20% holdouts.

Important: Never edit the attributes of cells in the target cell spreadsheet (TCS) at
the same time that any flowcharts in the associated campaign are being edited or
run. Put business practices in place to ensure that users do not edit or run a
flowchart at the same time as the TCS is being edited.

Procedure
1. Open a campaign and click the Target Cells tab.

2. Click the Edit icon .
The spreadsheet opens in Edit mode. Existing cells that are used in flowcharts
are highlighted in color.

3. Click the cell fields that you want to edit, and make your changes. Descriptions
of the most common edits follow.

To Do this

Add one row to the bottom of the
spreadsheet.

Click the Add a Cell icon .
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To Do this

Add several rows to the bottom of the
spreadsheet.

1. Click the Add Many Cells icon .

2. Select N empty rows and enter the
number of rows to add.

3. Click Create Target Cells.

Duplicate one or more rows. 1. Select at least one row.

2. Click the Add Many Cells icon
and select N duplicate rows.

3. Enter the number of rows to add.

4. Click Create Target Cells.

The new rows are added below the selected
row, with the cell code and cell name
already populated. All other column values
except Used in Flowchart are copied from
the selected row.

Search the TCS 1. Enter a search string in the Find
window.

You can enter a partial string to find
matches in any column of the
spreadsheet. For example, "924" finds a
row that contains cell code
"A0000000924" and also finds a row with
"Offer9242013" assigned.

2. Click Find String.

The row that contains the first match is
highlighted.

3. Click Find Next to continue searching.

Paste data from an external source 1. Copy content from another application.

2. Click a cell in the TCS to make it
editable.

3. Use the right-click menu to Paste.

Import target cell data from a .csv file 1. Obtain a comma-separated values file in
the required format. See “Import and
export format for TCS data” on page 159.

2. Click the Import Target Cells icon .

3. In the Import TCS dialog, click Browse
to locate the .CSV file that you want to
import, select the file, and click Open.

4. Click Import.

The contents of the .CSV file is appended
below any existing cells in the TCS.

Move rows up or down, or delete rows

Use the toolbar icons .

4. Click Save or Save and Return.
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What to do next

The flowchart designer can now create processes to select IDs that meet the 10%
and 20% offer and hold-out criteria. To link the data manipulation process output
to a cell in the TCS, the flowchart designer selects Link to Target Cell in the
process configuration dialog box.

Specifying control cells in a TCS
Cells that contain IDs that you purposely exclude for analysis purposes are called
control cells. When you assign offers to cells, you can optionally specify one
control cell for each target cell.

Procedure
1. Open a campaign and click the Target Cells tab.

2. Click the Edit icon .
3. To designate a cell as a control cell: Click in the Control Cell column to make

the field editable, then select Yes.
Cells that are designated as controls cannot be assigned offers.

4. To assign a control cell to a target cell: Click in the Control Cell Code column
to make the field editable. Then, select a control cell (any cell whose Control
Cell column is Yes) for the current target cell.

Important: If you assign a control cell (for example, Cell A) for one or more
target cells, then later change the control cell (Cell A) to a target cell, Cell A is
removed as a control from any target cells that previously used it as a control.

5. Click Save or Save and Return.

Import and export format for TCS data
To import data into a target cell spreadsheet (TCS), the comma-separated values
(.CSV) file that you prepare must match the required format. When you export the
contents of a TCS, this is also the format in which data is exported.
v The file must contain a header row with column names that match the

predefined and custom cell attributes.
v Each row must have the same number of columns as specified in the header

row.
v If there is no data for a given column, leave it blank.
v Values of custom attributes will be converted to the appropriate data type. For

dates, the date string must be in the user's locale format.

Column Name Description Required? Valid Values

CellName Name of the target cell. Yes

CellCode Cell code assigned to this target
cell. If empty, Campaign
generates a cell code, otherwise
the specified value is used.

Yes Cell code must match the defined cell
code format.

IsControl Indicates whether the cell in this
row is a control cell or a regular
target cell.

No Yes | No

ControlCellCode The CellCode of a cell where
IsControl = Yes.

Only if
IsControl = Yes

A valid cell code that exists for a cell
marked IsControl = Yes.
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Column Name Description Required? Valid Values

AssignedOffers A semicolon-delimited set of
offers, offer lists, or a
combination of both.

No Offers can be specified using offer
codes. Offer lists can be specified
using offerlist names.The format is:
OfferName1[OfferCode1];
OfferName2[OfferCode2];
OfferListName1[]; OfferListName2[],
where the offer name is optional, but
the offer code is required, and the offer
list name is required with empty
square brackets.

FlowchartName Name of the associated
flowchart.

No*

CellCount The counts for this cell. No*

LastRunType The type of the last flowchart
run.

No*

LastRunTime The time of the last flowchart
run.

No*

Custom Attr1 Add a column for each custom
cell attribute that you defined for
which you are importing data.

No Valid values as required by the custom
attribute's data type and user
locale/format.

*This column is populated by Campaign. If specified, it is ignored. It is populated for export.

Generating unique cell codes for use in a TCS
Campaign can generate a unique cell code for use in the target cell spreadsheet.
Cell codes have a standard format that is determined by your system
administrators, and are unique when generated.

Procedure
1. Open a campaign and click the Target Cells tab.

2. Click the Edit icon .

3. Click the Generate Cell Code icon .
A window with the generated cell code opens.

4. Select the generated cell code.
5. Copy the cell code into a field in the target cell spreadsheet.
6. Click Save.

Exporting data from a TCS
You can export the contents of a target cell spreadsheet (TCS) in comma-separated
values (.csv) format to a local or network drive. The entire contents of the TCS is
exported; you cannot select a subset of the contents.

Procedure
1. Open a campaign and click the Target Cells tab to open the target cell

spreadsheet for the campaign.

2. Click the Export Target Cells icon .
3. In the File Download dialog, click Save.
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4. In the Save As dialog, specify a file name, navigate to the directory where you
want to save it, and click Save. The File Download dialog indicates that the
download is complete.

5. Click Close to return to the target cell spreadsheet.

Results

The export format is described in “Import and export format for TCS data” on
page 159.

Assigning offers to cells in a TCS
Some organizations create target cells and assign offers in a target cell spreadsheet
(TCS). Then, another person creates a flowchart to select customers to receive the
offers. Follow these instructions if you are using a TCS to assign offers.

About this task

Procedure
1. Open a campaign and click the Target Cells tab to open the target cell

spreadsheet for the campaign.
2. Click the Edit link in the spreadsheet. The TCS opens in edit mode and any

existing cells that are used in flowcharts are highlighted in color.
3. Click the Assigned Offer(s) column in the row for the cell where you want to

assign offers.
4. Click the Select One or More Offers icon in the cell where you want to

assign offers.
5. In the Select Offer(s) window, locate and select one or more offers or offer lists,

or click the Search tab to find an offer by name, description, or code.
6. After you select the offers that you want to assign to the current cell, click

Accept and Close.
The Select Offer(s) window closes, and the Assigned Offer(s) column is
populated with your selected offers.

7. Click Save or Save and Return.

Viewing assigned offers or offer lists in a TCS
You can view any assigned offers or preview the contents of assigned offer lists in
a target cell spreadsheet (TCS).

About this task

Procedure
1. Open a campaign and click the Target Cells tab to open the target cell

spreadsheet for the campaign.
2. Click the Edit link in the spreadsheet. The TCS opens in edit mode and any

existing cells that are used in flowcharts are highlighted in color.
3. Click the Assigned Offer(s) column in the row for the cell where you want to

view assigned offers or offer lists.
4. Click the View Offers icon .

The View/Edit Offer Details window opens with the assigned offers or offer
lists in the Assigned offers section.

5. Select an offer list and click Offer List Preview.
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The Summary page for the selected offer list displays the preview of included
offers.

Unassigning offers from cells in a TCS
You can unassign offers from cells in a target cell spreadsheet.

Procedure
1. Open a campaign and click the Target Cells tab to open the target cell

spreadsheet for the campaign.
2. Click the Edit link in the spreadsheet. The TCS opens in edit mode and any

existing cells that are used in flowcharts are highlighted in color.
3. Click the Assigned Offer(s) column in the row for the cell where you want to

unassign offers.
4. Click the View Offers icon .

The View/Edit Offer Details window opens with the assigned offers or offer
lists in the Assigned offers section.

5. Select the offers or offer lists that you want to remove from the cell, and click
the >> button to move the selected items to the Removed offers section.

6. Click Accept Changes.
The View/Edit Offer Details window closes. The removed offers or offer lists
no longer display in the Assigned Offer(s) column for the cell.

7. Click Save or Save and Return.

Cell status information in the target cell spreadsheet
The target cell spreadsheet in IBM Campaign displays the current status of each
cell, including the cell count, last run type (production or test run of a flowchart,
branch, or process), and the last run time.

The cell count is the number of unique audience IDs for each cell that is linked to
an output cell in a flowchart that has been run. This cell status is the result of the
latest saved production or test run of the corresponding process.

Cell status information displays in the target cell spreadsheet in either Campaign
(stand-alone) or Marketing Operations (when integrated).

Updating the cell counts:

If you make changes to a process configuration, any previous run results are lost
and the Cell Count, Last Run Type and Last Run Time columns appear blank in
the target cell spreadsheet. You must run the flowchart, branch, or process in
production or test mode and subsequently save the flowchart to update the cell
count.

About this task

Note the effect on the cell counts in the TCS for the following types of process
configuration changes.
v Linking a flowchart output cell to a target cell. The cell count remains blank

until the next saved production or test run.
v Unlinking a flowchart output cell from a target cell. Any previous run results

are removed and the cell count is blank.
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Refreshing the cell counts manually:

The cell counts in the target cell spreadsheet are updated automatically when you
run the flowchart, branch, or process in production, or when you save a test run. If
the TCS is open when the run completes, you must refresh the cell counts

manually by clicking the Get Cell Status icon .

Linking flowchart cells to a TCS
Larger organizations often use one person to create a target cell spreadsheet (TCS)
for a campaign, and another person to design flowcharts. The TCS associates offers
with targets and controls. The flowchart designer then configures flowchart
processes that select recipients for the offers. By linking output cells in a flowchart
with the cells and offers that were pre-defined in the TCS, the flowchart designer
completes the association between the flowchart cells and a TCS.

Linking flowchart cells to targeted offers defined in a TCS
If your organization pre-defines targeted offers in a Target Cell Spreadsheet (TCS),
a flowchart designer must then configure processes to select recipients for the
offers. The designer must link the flowchart cells with the predefined cells in the
TCS. This completes the association between the cells in the TCS and the recipients
defined in the flowchart.

Before you begin

Before you begin, someone in your organization must define target cells in a TCS.
Then the flowchart designer can follow the steps below to associate output cells in
a flowchart with the cells that were defined in the TCS.

Note: An alternative method is to use Options > Match & Link Target Cells.

About this task

To associate flowchart cells with pre-defined cells in a TCS:

Procedure
1. In a flowchart in Edit mode, double-click the process whose output cell you

want to link to a cell in the TCS.
2. Click the General tab in the process configuration dialog.
3. To open the Select Target Cell dialog:

v In processes that output a single cell, such as Select, click Link to Target
Cell....

v In processes that output multiple cells, such as Segment, click the Output
Cell Name or Cell Code row for each cell that you want to link. Click the
ellipsis button.

You see the Select Target Cell dialog, which displays the cells that were
predefined in the TCS for the current campaign.

4. In the Select Target Cell dialog, select the row for the cell to which you want to
link the current output cell.

5. Click OK.
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The Select Target Cell dialog closes. The Output Cell Name and Cell Code in
the process configuration dialog are replaced with the name and code from the
TCS. These fields are italicized to indicate that they are obtained from the
spreadsheet.

6. Click OK to save your changes.
7. Save the flowchart. Target cell linkages are not saved in the database until you

save the flowchart. If you cancel changes in the flowchart, cell linkages are not
saved.

Related concepts:
“Target cell spreadsheets” on page 156

Using Match & Link to associate flowchart cells with a TCS
Use the Match & Link Target Cells dialog to associate target cells in a flowchart
with predefined cells in a target cell spreadsheet (TCS). This option is an
alternative to using a flowchart process configuration dialog to establish the link.

Before you begin

Before you begin, someone in your organization must define target cells in a TCS.
Then the flowchart designer can follow the steps below to associate output cells in
a flowchart with the cells that were defined in the TCS.

Note: To use automatching, ensure that the flowchart output cell names match the
TCS cell names or start with at least the same three characters.

Procedure
1. In a flowchart in Edit mode, select Options > Match & Link Target Cells.

The Match and Link Target Cells dialog shows Available Target Cells in the left
pane and flowchart output cells in the right pane.

2. Use one of the following methods to match target cells from the TCS with
flowchart cells.

To automatically match cells based on name Click Automatch.

Successfully automatched cells have a status
of Exact or Best Match, and target cells that
are matched display in red.

To match cells manually Select one or more pairs of target cells and
flowchart output cells, and click Match.

The selected target cells are matched, in
order, with the selected flowchart output
cells. Successfully matched output cells have
a status of Manual. Target cells that are
matched display in red.

3. Click OK. You see a warning that the flowchart run results will be lost.
4. Click OK to continue.
5. Save the flowchart. Target cell linkages are not saved until you save the

flowchart. If you cancel the flowchart changes, cell linkages are not saved.
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Results

The next time that you view the Match & Link Target Cells dialog for this
flowchart, the status of the matched and linked cells is Linked.
Related concepts:
“Target cell spreadsheets” on page 156

Unlinking flowchart cells from targeted offers defined in a TCS
The flowchart designer can remove the association between IDs that were selected
in a flowchart and targeted offers that were predefined in a target cell spreadsheet
(TCS). This procedure pertains only to organizations that define targeted offers
using a TCS.

About this task

If a cell does not have Contact History, you can unlink (and subsequently relink) it
at any time.

Note: If you unlink a cell that has Contact History, it is "retired". Retired cells
cannot be linked again. They do not appear in the TCS and they cannot be selected
in a process configuration dialog box. (If Campaign is integrated with Marketing
Operations, retired cells continue to be displayed in the TCS but cannot be reused.)

Procedure
1. In a flowchart in Edit mode, double-click the process whose output cell you

want to unlink from the TCS.
2. Click the General tab in the process configuration dialog.
3. Open the Select Target Cell window:

v In processes that produce a single cell as output, such as Select, click Link to
Target Cell.

v In processes that produce multiple cells, such as Segment, click the Output
Cell Name or Cell Code row for the cell that you want to unlink. Click the
ellipsis button.

The Select Target Cell window shows the cells that are defined in the TCS for
the current campaign. The currently linked cell is highlighted.

4. Select [Not Linked].
The cell name and code are no longer highlighted.

5. Click OK. The Output Cell Name and Cell Code in the process configuration
dialog are no longer italicized, indicating that they are not linked to the TCS.

Related concepts:
“Target cell spreadsheets” on page 156

Using Match & Link to remove an association
You can use the Match and Link dialog to remove the association between target
cells in a flowchart and cells in the target cell spreadsheet (TCS).
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About this task

If a cell does not have Contact History, you can unlink (and subsequently relink) it
at any time.

Important: If you unlink a cell that has Contact History, it is retired. Retired cells
cannot be linked again. They do not appear in the TCS and cannot be selected in a
process configuration dialog. (If Campaign is integrated with Marketing
Operations, retired cells continue to be displayed in the TCS but cannot be reused.)

Procedure
1. In a flowchart in Edit mode, select Options > Match & Link Target Cells.

Any matched or linked cells are displayed in the right pane, and their status is
indicated in the Status column.

2. To unmatch all matched cell pairs, click Unmatch All.
The unmatched target cells are refreshed in the Available Target Cells pane,
and the output cell Status and Target Cell Name columns are cleared. Linked
pairs of cells are not changed.

3. To unlink all linked cell pairs, click Unlink All.
Previously linked pairs are unlinked, but they remain matched. The target cells
now appear in the Available Target Cells list in red, as matched target cells.

4. Save the flowchart. Target cell linkages are not saved until you save the
flowchart. If you cancel flowchart changes, cell linkages are not saved.

Related concepts:
“Target cell spreadsheets” on page 156
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Chapter 9. Contact history

IBM Campaign maintains contact history to record information about offers that
are sent to contacts. History is also recorded about control cells, to identify
customers who are purposely not sent the offer.

The term "contact history" refers to information that Campaign maintains about:
v what offers were sent
v to which customers (or accounts, or households, depending on audience level)
v by which channel

v on what date.

For example, a list of target customers can be generated as the output of a Call List
or Mail List process in a campaign flowchart. Each target customer belongs to a
cell that is assigned one or more offers. When the Call List or Mail List process is
run in production mode with logging to contact history enabled, details are written
to several tables in the Campaign system database.

Together, those tables comprise the contact history. The contact history records the
specific offer version (including the values of parameterized offer attributes) given
to each ID in each cell at flowchart run time. Contact history also records the
members of control cells, who are purposely withheld from receiving any
communications. Control cells indicate hold-out or no-contact controls, therefore
customers belonging to control cells are not assigned any offers and are not
included in contact process output lists.

Contact history and audience levels overview
Campaign maintains contact history for each audience level, such as Customer and
Household. Contact history provides a historical record of your direct marketing
efforts, including who was contacted, what offers were made, by which channels.

Campaign maintains contact history in the system database tables:
v Base contact history (UA_ContactHistory) is recorded when all members of a cell

are treated the same (when they are all given the same version of an offer).
v Detailed contact history (UA_DtlContactHist) is recorded only when individuals

in the same cell receive different offer versions (offers with different values for
personalized offer attributes) or a different number of offers.
Detailed contact history can quickly grow very large, but it provides complete
data to support detailed response tracking and to analyze targets and controls.

v For every production run, data is recorded in the Treatment tables
(UA_Treatment). Control information for hold-outs is also recorded here.
Hold-outs do not receive communications, but are measured against the target
group for comparison. Treatment history is used together with contact history to
form a complete historical record of offers that were sent.

Contact history and the corresponding response history are maintained for each
audience level.

For example, suppose you have two audience levels, Customer and Household.
The table implementation depends on how your database is configured:
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v Each audience level usually has its own set of contact and response history
tables in the Campaign system database. In other words, the Customer audience
level has a set of tables (contact history, detailed contact history, response
history), and the Household audience level has its own set of tables.

v If your database is configured so that multiple audience levels write to the same
underlying physical tables, then each audience level does not require its own set
of tables. However, the underlying physical tables (contact history, detailed
contact history, response history), must include a key for each audience level.

How the contact history tables are updated
Entries are written to the Campaign contact history tables when a flowchart
contact process (Call List or Mail List) or the Track process runs in production
mode with the history logging options enabled. Test runs do not populate the
contact history tables.

When contact history logging is enabled, the following details are written to
contact history during a production run:
v The date and time of the contact (by default, this is when the contact process

was run);
v The offer versions assigned in the contact process, including parameterized offer

attribute values;
v Exactly which offer versions were given to each ID;
v For target and control cells, the treatment codes for tracking each unique

combination of offer version, cell, and date and time.

The following system tables are involved:
v Base contact history (UA_ContactHistory), if all members of a cell are given the

same version of an offer
v Detailed contact history (UA_DtlContactHist), if individuals in the same cell

receive different offer versions
v Treatment history (UA_Treatment)
v Offer history (multiple system tables which collectively store information about

offers that were used in production)

Treatment history and offer history are used together with contact history to form
a complete historical record of offers that were sent. Controls, who were not
assigned offers, are identified in the Treatment table.

History is updated only if the Log to Contact History Tables option is checked in
the Mail List, Call List, or Track process configuration dialog box.

Note: This does not affect how eMessage and Interact load data into the Campaign
history tables. Those products use their own ETL processes to extract, transform,
and load data into the Campaign contact and response history tables.

Treatment history (UA_Treatment)
Rows are added to the treatment history table (UA_Treatment) each time a
flowchart runs in production mode.

If a flowchart is scheduled to run periodically, each new run generates a new set of
treatments, one for each offer per cell, for both contact and control cells, at

168 IBM Campaign: User's Guide



flowchart run time. Campaign thus provides the most granular tracking possible,
by recording as a separate instance each time a treatment is generated.

Treatment history works together with base contact history to provide a highly
compressed and efficient way to store complete contact history information:
v The base contact history table (UA_ContactHistory) records only the cell

membership information for the appropriate audience.
v The treatment(s) given to each cell are recorded in the treatment history table

(UA_Treatment).

Each treatment instance is identified with a globally unique treatment code. The
treatment code can be used in response tracking to attribute each response to a
specific treatment instance.

How controls are handled in treatment history

A control cell is qualified for an offer but is excluded from receiving the offer for
analysis purposes. If controls are used, treatment history also records control cell
data:
v Rows pertaining to offers that are given to a target cell are called target

treatments.
v Rows pertaining to offers that are assigned to a control cell are called control

treatments.

Target treatments have an associated control treatment if a control cell was
assigned to the target cell in the contact process. Each control treatment is assigned
a unique treatment code, although the codes are not distributed to control
members. Control treatment codes are generated to facilitate custom response
tracking where custom flowchart logic is used to identify a control: control
treatment codes can be looked up and associated with the event so that the
response can be attributed to an exact control treatment instance.

Base contact history (UA_ContactHistory)
One row is written to the base contact history table for each combination of contact
ID, cell, and flowchart run date/time, for target cells as well as control cells.

Mutually exclusive cell membership

If your cells are mutually exclusive, and each ID can belong to only one cell, then
each ID has one row in the contact history table when it is treated within a single
contact process, regardless of the number of offers assigned. For example, this is
the case if you define cells that correspond to "Low," "Medium," and "High" value
segments, and customers can belong only to one of these segments at any given
time. Even if the "High value" segment is given 3 offers in the same contact
process, only one row is written to base contact history, since base contact history
records cell membership.

Non-exclusive cell membership

If individuals can belong to more than one target cell (for example, if each of your
target cells receives offers based on different eligibility rules, and customers might
qualify for none, one, or more than one of the offers), then each individual has the
number of rows in the contact history table corresponding to the number of cells in
which that individual is a member.
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For example, if you define two cells: "Customers who have made purchases within
the last 3 months," and "Customers who have spent at least $500 in the last
quarter," an individual could be a member of one or both of these cells. If the
individual is a member of both cells, two entries are written to the base contact
history for that individual when the contact process is run.

Even if multiple rows are written to the contact history table for an individual
because he or she belongs to more than one target cell, all offers given in the same
contact process are considered to be a single "package" or interruption. A unique
"package ID" in the contact history table groups together the rows written by a
particular run instance of a specific contact process for an individual. Multiple
"interruptions" to a person or household would occur only if the individual or
household belonged to multiple cells in separate contact processes.

Writing additionally tracked fields to contact history
You can create additionally tracked fields and populate them in the base contact
history table. For example, you might want to write out the treatment code from
the treatment table, or an offer attribute, as an additionally tracked field in contact
history.

However, since it is cell membership that is being captured in base contact history,
and each target or control cell writes one row per audience ID, note that if you are
populating additionally tracked fields in base contact history with offer or
treatment data, only the first treatment for each target or control cell is written out.

Example

Cell
Associated control
cell Offer given to cell

TargetCell1 ControlCell1 OfferA, OfferB

TargetCell2 ControlCell1 OfferC

ControlCell1 - -

When the flowchart containing the contact process that assigns the listed offers to
TargetCell1 and TargetCell2 is run in production (with writing to contact history
enabled), a treatment is created for each combination of cell, offer given, and the
run date/time. In other words, six treatments are created in this example:

Treatments Treatment Code

TargetCell1 receiving OfferA Tr001

TargetCell1 receiving OfferB Tr002

ControlCell1 receiving OfferA Tr003

ControlCell1 receiving OfferB Tr004

TargetCell2 receiving OfferC Tr005

ControlCell1 receiving OfferC Tr006

If you added Treatment Code as an additionally tracked field in base contact
history, only the first target or control treatment for each cell is written out. In this
example, therefore, only three rows are written to base contact history, for the first
treatment for each cell:
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Cell Treatment Code

Target Cell1 Tr001

ControlCell1 Tr003

TargetCell2 Tr005

For this reason, capturing offer-level attributes in the base contact history table
may not be a good practice, since it will only provide complete contact information
if:
v only one offer is assigned to any target cell; and
v each control cell is assigned to only one target cell.

In any other instance, only data associated with the first treatment (or control
treatment) is output. An alternative is to use a database view to flatten and
provide access to offer-level information by joining the UA_ContactHistory and
UA_Treatment system tables. You can also output this information to alternate
contact history.

Note: If you output offer attribute information as additionally tracked fields,
complete treatment information can be displayed because detailed contact history
and alternate contact history write a row for each treatment (rather than a row for
each cell).

Detailed contact history (UA_DtlContactHist)
The detailed contact history table is written to only if you are using a scenario
where individuals within the same cell receive different versions of an offer.

For example, members of the same cell might receive the same mortgage offer, but
the offer can be personalized so that Person A receives a 5% rate offer, while
Person B receives a 4% rate offer. Detailed contact history contains one row for
each offer version that an individual receives and one row for each control cell
based on the offer versions they would have received.

Offer history
Offer history is comprised of multiple system tables which collectively store
information about an offer version that has been used in production.

New rows are added to the offer history table only if the combination of
parameterized offer attribute values are unique. Otherwise, existing rows are
referenced.

Updating contact history by doing a production run
When you do a production run, you can update contact history for the current Run
ID. Use the Run History Options window to choose how the new contact history
will be written to the contact history table.

Procedure
1. On a flowchart page in Edit mode, click the process that you want to run.

2. Open the Run menu and select Save and Run Selected Branch.
3. If contact history records exist, you are prompted to choose run history options.
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The Run History Options dialog appears only when you run a branch or
process that previously generated contact history for the current Run ID. You
can either append information to contact history or replace existing contact
history for the Run ID.

Option Description

Create a new run instance Rerun a specific branch or process of the
flowchart using a new Run ID. Append the
results, associated with the new Run ID, to
the contact history table. Existing contact
history remains intact.

Replace the contact history of the previous
run

Reuse the previous Run ID and replace the
contact history previously generated for that
Run ID (only for the process or branch that
is being run). Contact history records that
were previously generated for other
branches or processes of the flowchart
remain intact.

Cancel Cancel the branch or process run and do
nothing to existing contact history. The
flowchart remains open in Edit mode.

Run History Options scenario
In this example, you have a flowchart with two branches and two contact
processes, A and B, both configured to log to contact history.

You run the entire flowchart (from the top, by using the Run Flowchart command)
once. This creates a new Run ID (for example, Run ID = 1) and generates contact
history for this Run ID.

After this first successful run of the entire flowchart, you edit contact process A to
give a follow-up offer to the same individuals who received the first offer.
Therefore, you want to rerun contact process A. The current Run ID is "1" and
contact history exists for process A and Run ID = 1. You want to retain the original
contact history.

When you select contact process A and click Run Process, the Run History Options
window opens. If you choose to leave the Run ID unchanged (Run ID = 1), you
will replace the existing contact history, which is not what you want to do. Instead,
you choose Create a new run instance. This option increments the Run ID to 2,
retains the contact history associated with Run ID = 1, and appends new contact
history to Run ID = 2. In this way, you will not lose the contact history that is
associated with the first offer.

If you now edit and run contact process B, the Run History Options window does
not open, because you are using a new Run ID (Run ID =2), which does not have
any contact history associated with it. When you run only contact process B, you
generate more contact history records for Run ID = 2.

Specifying a database table for contact logging
You can log contact information to a database when you configure a contact
process.
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Procedure
1. In the process configuration dialog box, select New Mapped Table or Database

Table from the Enable Export To or Log To list. This option usually appears at
the bottom of the list, after the list of mapped tables.
The Specify Database Table dialog box opens.

2. Specify the table name.

Note: You can use user variables in the table name. For example, if you specify
MyTableUserVar.a as the table name, and the value of UserVar.a is "ABC" at the
time that the process is run, the output is written to a table named
MyTableABC. You must set the Initial Value and the Current Value of the user
variable before you run the flowchart.

3. Select a database name from the list.
4. Click OK.

The Specify Database Table window closes. The Export/Log to field in the
process configuration dialog displays the name of the database table that you
entered.

5. If a table of the name you specified exists, choose an option for writing the
output data:
v Append to Existing Data: If you choose this option, the existing table must

have a schema compatible with the output data. In other words, field names
and field types must match, and field sizes must allow for the output data to
be written.

v Replace All Records: If you choose this option, existing rows in the table are
replaced with the new output rows.

Specifying an output file for contact logging
You can optionally output contact history to a flat file with a data dictionary or a
delimited file.

Procedure
1. Open a flowchart in Edit mode.
2. In the process configuration dialog box for a contact process, select File from

the Enable Export To or Log To list. The File option usually displays at the
bottom of the list, after the list of mapped tables.
The Specify Output File dialog box opens.

3. Select an output file type:
v Flat file with data dictionary: Create a fixed-width file and a new data

dictionary file.
v Flat file based on existing data dictionary: Create a fixed-width file and

select an existing data dictionary file.
v Delimited File: Create a file in which field values are delimited by a tab,

comma, or other character. If you select Other, enter the character to use as a
delimiter. Check Include Labels in Top Row if you want the first row of the
file to contain a column header for each column of data.

4. Enter the complete path and file name in the File Name field or use Browse to
select an existing file.

Note: You can include user variables in the output file name (Options > User
Variables). For example, if you specify MyFileUserVar.a.txt as the file name,
and the value of UserVar.a is "ABC" at the time that the process is run, the
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output is written to MyFileABC.txt. You must set the Initial Value and the
Current Value of the user variable before running the flowchart.

5. Campaign completes the Data Dictionary field with a .dct file with the same
name and location as the file that you entered. If you want to use a different
data dictionary, or to rename the data dictionary, enter the complete path and
name of the data dictionary file in the Data Dictionary field.

6. Click OK.

Disabling writing to contact history
If you do not want production runs to update the contact history tables, you can
configure the Call List or Mail List process to prevent logging. However, the best
practice is not to disable contact history logging.

About this task

Test runs do not populate the contact history tables, so if you want to run a contact
process without writing to contact history, you can do a test run.

Contact history is updated when a flowchart contact process runs in production
mode with the contact logging options enabled. If you want to prevent a contact
process from writing to contact history, you can configure the process to disable
logging during production runs.

Important: The best practice is not to disable contact history logging. If you run a
campaign in production mode without logging to contact history, you will not be
able to accurately re-generate the contact history at a later date if any of the
underlying data changes.

Procedure
1. Double-click the contact process (Call List or Mail List) for which you want to

disable contact history logging.
2. Click the Log tab.
3. In the window for configuring logging of contact transactions, clear the Log to

Contact History Tables and the Log into Other Destinations checkboxes.

Note: To change the Log to Contact History Tables option, the
OverrideLogToHistory configuration setting must be set to true and you must
have the appropriate permissions.

4. Optionally, click More Options to access the Contact History Logging Options
and select Create Treatments Only. This option generates new treatments in
the Treatments table but does not update the contact history.

5. Click OK.

Results

When you run the contact process, no entries will be written to the contact history
tables or to alternate logging destinations.

Note: This does not affect how eMessage and Interact load data into the Campaign
history tables. Those products use their own ETL processes to extract, transform,
and load data into the Campaign contact and response history tables.
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Clearing contact history and response history
Clearing contact and response history permanently deletes history records from the
system tables. This data is not recoverable.

Before you begin

The following procedure permanently deletes contact and response history. If later
recovery might be required, back up the system table database prior to clearing
any history.

Note: History is also permanently deleted when you delete a campaign. In this
case, you are prompted to continue. If you continue, the entire campaign and all of
its contents, including all contact and response history, is deleted.

About this task

You might want to delete contact or response history records in the following
situations:
v If a production run was executed by mistake.
v If you decide to cancel a campaign after a production run.

You can choose to delete all associated contact and response history records, or
delete only the response history records. Usually, it is best not to delete contact
history for which responses have been recorded. However, you have the option of
doing so.

Referential integrity across Campaign system tables is always preserved. All
contact history tables are written to simultaneously, and any clean up of contact
history is done simultaneously across all contact history tables. For example,
treatment table entries cannot be deleted if there are entries in the base or detailed
contact history tables referencing them.

To permanently delete contact and/or response history for a contact process,
follow the steps below.

Procedure
1. In a flowchart in Edit mode, double-click the contact process whose history you

want to permanently delete.
2. In the process configuration dialog, click the Log tab. You see the window for

configuring logging of contact transactions.
3. Click Clear History.

If no contact history entries exist, a message indicates that there are no entries
to clear.

4. If contact history exists, specify which entries to delete:
v All entries
v All entries within a selected date range
v Specific flowchart runs identified by the run date and time

5. Click OK.
If no response history records exist for the entries that you selected, you see a
confirmation message.

6. If response history records exist for any of the entries that you selected, use the
Clear History Options dialog to select an option:
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v Clear All Associated Contact and Response History Records: Both contact
history and response history are cleared for the entries you specified.

v Clear Associated Response History Records Only: Only response history is
cleared for the entries you specified. Contact history records are retained.

v Cancel: No contact history or response history records are cleared.
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Chapter 10. Campaign response tracking

Use the Response process in a flowchart to track the actions that occur after a
campaign. When you run the Response process, data is recorded in the response
history tables and is available for the Campaign performance reports.

Response tracking helps you to evaluate the effectiveness of your campaigns. You
can determine whether actions taken by individuals are in response to offers that
were given. You can evaluate responders and non-responders who were sent offers.
You can also evaluate controls (individuals who were not sent offers) to see
whether they performed the desired action despite not being contacted.

Campaign saves the response history and uses it in the Campaign performance
reports, so you can easily determine:
v Who responded: The list of audience entities (such as individual customers or

households) whose behavior matched the response types being tracked.
v What they did, and when: Campaign records the actions that were performed

and the date and time of the actions. Examples are a click-through on a website
or the purchase of a specific item. This information depends on the Response
Types that are set up and/or additional data that is captured during response
processing.

v Which offer treatment they responded to: Any Campaign-generated codes
(campaign, offer, cell, or treatment code) and any offer attributes with non-null
values returned by the respondent are matched for response tracking.

v How the response is attributed: Criteria include matching Campaign-generated
codes or non-null values for offer attributes, whether responders were in the
original targeted group or a control group, and whether the response was
received before the expiration date.

v Additional information: The response history tables also record the following
information:
– Whether the response was direct (one or more Campaign-generated codes

were returned) or inferred (no response codes were returned).
– Whether the respondent was in a target cell or control cell
– Whether the response was unique or a duplicate
– Best, fractional, and multiple attribution scores
– The response type (action) attributed to the response
– Whether the response was received before or after the expiration date of the

specific offer version. (This information depends on the following property:
Settings > Configuration > Campaign > partitions > partition[n] > server >
flowchartConfig > AllowResponseNDaysAfterExpiration. The default value
is 90 days.)

How to track responses to a campaign
To perform response tracking, create a flowchart that includes the Response
process. The Response process takes input from a Select or an Extract process and
typically uses an action table as the source data.
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Using an action table as input to the Response process

An action table is an optional database table or file containing response data that is
collected after offers are presented to customers. There is usually one action table
per audience level.

An action table usually serves as the source data of the input cell for the Response
process. An action table is not required for response processing, but is considered a
best practice.

An action table includes data such as customer identification, response codes, and
attributes of interest. Depending on how responses are tracked in your
organization, the responses could be directly related to transactional data, such as
purchases or contracts and subscriptions.

When you use an action table as input to a Response process, the actions or events
in the table are evaluated to see whether they should be attributed as responses to
contact or control treatments. Campaign reads from the action table, and if a match
is found between the relevant attributes and/or response codes, Campaign
populates the response history tables for response tracking.

The Campaign system tables include a sample action table for the Customer
audience level, called UA_ActionCustomer. Administrators can customize the table
as needed.

Important: Administrators must ensure that any action table that is used for
response tracking is locked during response processing. Administrators must also
clear rows after each Response process run to ensure that responses are not
credited multiple times. For example, Campaign can be configured to run SQL
after the Response process to purge the action table.

For important information about action tables, see the Campaign Administrator's
Guide.

How the Response process works

You configure the Response process in a flowchart to evaluate and output the IDs
that you consider to be responses to your offer. The evaluation is done by
matching some combination of response codes or other standard or custom offer
attributes from the action table.

The response processing logic uses response codes of interest and response
attributes of interest to determine direct and inferred responses:
v Response codes of interest: Any Campaign-generated codes (campaign, offer, cell

or treatment code) that are mapped in the Response process are considered to be
"response codes of interest."

v Response attributes of interest: Any other offer attributes, whether standard or
custom, that are mapped in the Response process are considered to be "response
attributes of interest." For example, you can use the "Relevant Products" field as
an offer attribute to track inferred responses.

Those responses are written to the response history system table
(UA_ResponseHistory, or its equivalent for each audience level) when you run the
Response process. There is one response history system table for each audience
level that you are tracking.
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The response history data is then available for use and analysis by the Campaign
performance reports.

The following example shows a simple flowchart that tracks responses to direct
mail, email, and telephone offers.

Related tasks:
“Updating response history” on page 106
Related reference:
“Performance reports for IBM Campaign” on page 228

Using multiple response tracking flowcharts
Many organizations choose to use multiple response tracking flowcharts, for
various reasons.

It is possible to have a single response tracking flowchart for all of the campaigns
in your corporation. If a single action table is used, your system administrator will
typically set up session flowcharts to write data to the action table for processing.

However, your implementation of Campaign might use one or more action tables
for convenience, each related to a separate response tracking flowchart.

The following sections describe why you might use multiple response tracking
flowcharts.

You are tracking responses for different audience levels

(Required) You need one response tracking flowchart for each audience level for
which you receive and track responses. The Response process operates at the
audience level of the incoming cell, and automatically writes to the appropriate
reponse history table for that audience level. To track responses for two different
audience levels, for example, customer and household, you need two different
Response processes, most likely in two separate response tracking flowcharts.

You have real-time vs. batch processing requirements

(Required) Most of your response tracking sessions will be batch flowcharts,
periodically processing events populated into an action table (for example, nightly
processing of customer purchases). The frequency of response tracking runs will
depend on the availability of the transaction data used to populate the action table.
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For example, if you process responses from different channels (such as web vs.
direct mail), you might need separate response processing sessions because the
frequency of availability of incoming transaction data will be different for each
channel.

You want to avoid duplicating large volumes of data

(Optional) If you have large transaction volumes (such as millions of sales
transactions per day) that must be evaluated, you might want to build a response
tracking flowchart to map directly against the source data, rather than ETL (extract,
transform, load) it into an action table.

For example, you can build a response tracking flowchart in which an Extract
process pulls transactions directly from an e-commerce system's purchase
transaction history table (based on a particular date range), and a Response process
that maps directly to columns in this table from this extract.

You want to hard-code specific data for different situations

(Optional) You might want to hard-code specific data (such as response types) for
different situations, such as different channels. For example, if you are interested
specifically in tracking a specific response type (such as "inquiry") that is specific to
a channel (such as "call center"), you can create a derived field to filter these
responses, and use it in a response processing flowchart to pull all inquiries from
the call center database. It might be more convenient to create the data necessary
for response tracking using derived fields, and pull the data directly from the
source, than to write the data to a single action table.

You need custom response processing logic

(Optional). If you need to write your own rules for attributing responses, you can
create a separate response tracking flowchart to implement custom
response-tracking logic. For example, if you need to identify responders to a "Buy
3 Get 1 Free" offer, you need to look at multiple transactions to determine whether
an individual qualifies as a responder. Upon finding qualifying individuals, you
can then input them into a Response process to record the responses using the
treatment code and appropriate response type.

You want a response flowchart for each product or product
group that was promoted

(Optional) You can create a separate response flowchart for each product or
product group that was promoted through the offers. In this way, you can easily
analyze response per product.

You want one response flowchart per campaign

(Optional) In this scenario, you have one or more flowcharts that generate output
but only one flowchart per campaign that tracks responders. If the data is available
on a per campaign basis, this is a convenient way to set up response processing.

180 IBM Campaign: User's Guide



Response tracking using multi-part offer codes
You can track responses using a derived field that consists of a multi-part offer
code (that is, an offer code that consists of two or more codes). All parts of the
offer code must be concatenated using the partition-wide offerCodeDelimiter
configuration property. The following example creates a derived field called
MultipleOfferCode consisting of two parts concatenated using the default delimiter
"-":

MultipleOfferCode = string_concat(OfferCode1, string_concat("-",
OfferCode2))

When configuring the Response process to use the derived field as a Candidate
Action Field, you must match the derived field to the offer/treatment attribute of
each offer code in the multi-part code.

Date scope for response tracking
In addition to recording whether responses were made within the valid offer time
period (that is, after the effective date and on or before the expiration date),
response tracking also records whether the response was outside a valid date range
for all offers. Campaign tracks late responses for all offers based on a configurable
time period after an offer's expiration date to provide data on how often your
offers are redeemed after their official end dates.

The date scope for response tracking in Campaign is set globally, and is applied to
all campaign offers. Your system administrator sets the number of days past the
offer expiration date that responses will be tracked.

This date setting automatically limits the possible treatment instances that can
match an event. The smaller the date scope, the more performance is improved
because fewer instances from the treatment table are returned for possible matches.

For details about setting the date scope, see "Setting the number of days after a
campaign ends to record responses" in the Campaign Adminstrator's Guide.

Response tracking for controls
Control group responses are tracked simultaneously with offer responses, using the
Response process.

Control cell responses are handled in the same way as inferred responses, except
that any response codes are first discarded. For any responses from control cell
members, any response tracking codes are ignored and any attributes of interest
(for example, relevant products) are checked for matches against control treatment
instances. Campaign uses an internal, globally-unique treatment code that is
generated for all control treatments; however, control treatment codes are not given
out, as control treatments are always no-contact, hold-out controls.

It is possible for the same event to credit both target treatment instances and
control treatment instances. For example, if a particular customer is targeted with
an offer for 10% of any purchase in the women's department, and that customer is
also a member of a hold-out control group monitoring for any purchase from the
store, if that customer makes a purchase using the coupon, that event would be
associated with both the target treatment instance (using the coupon's treatment
code) and the control treatment instance. Control treatment instances are also
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marked within the valid date range or after the expiration date, in the the same
manner as target treatment instances - this provides a valid control comparison for
late activity in the target cell.

Best or fractional attribution is not used for control cell responses - multiple
attribution is always used. In other words, if a respondent is in a control cell for an
offer and her action qualifies as an inferred response for multiple control
treatments, all of these matching control treatments are credited for the response.

Response tracking for personalized offers
If you have used data-driven, personalized, or derived or parameterized offer
fields to generate different offer versions, for responses to these personalized offers
to be correctly attributed, your action table must contain fields representing the
parameterized offer attribute fields. When these fields are mapped in a Response
process as attributes of interest and populated, they can be used to match
responses back to the offer version or treatment instance. Responses with values
for these "attributes of interest" must exactly match the values recorded for that
individual in offer version history, for attribution to that treatment.

For example, if you had flight offers which were personalized with an origin
airport and a destination airport, then your action table should contain fields for
"Origin Airport" and "Destination Airport." Each flight purchase transaction would
contain these values, and response tracking would be able to match the specific
flight purchased by an individual to the offer version(s) that were promoted to him
or her. These fields also would be used to track inferred responses for members of
the control group, to see if they purchased any flights that would have been
promoted to them.

Response types
Response types are the specific actions that you are tracking, such as click-through,
inquiry, purchase, activation, use, and so on. Each response type is represented by
a unique response code. Response types and codes are defined globally in the
Campaign Response Type system table, and are available for all offers, although
not all response types are relevant for all offers. For example, you would not
expect to see a click-through response type for a direct mail offer.

When events are written to the action table, each event row can have only one
response type. If the response type field is empty (null) for an action, it will be
tracked as the default response type ("unknown").

If a single event needs to be associated with multiple response types, multiple
rows must be written to the action table, one for each response type. For example,
if a financial institution is tracking the purchase usage level of a new credit card
during the first month after activation with response types of "Purch100,"
"Purch500," and "Purch1000," a purchase of $500 might need to generate an event
with response types of both "Purch100" and "Purch500," because the purchase
meets both of these conditions.

If you need to detect complex sequences of separate transactions that will together
constitute a response event, you will need a separate monitoring session that looks
for the qualifying transactions and, when these are found, then submits an event to
the action table. For example, if a retailer's promotion rewards customers who
purchase any three DVDs during the month of December, you can build a
flowchart to compute the number of DVD purchases for each customer, select the
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customers who have made three or more purchases, and write these customers to
the action table with a special response type (such as "Purch3DVDs").

For more details about response types, see the Campaign Administrator's Guide.

Response categories
Responses in Campaign fall into two categories:
v Direct response - one or more Campaign-generated tracking codes sent out with

the offer were returned, and any returned attributes of interest must match.
v Inferred response - no tracking codes were returned, but at least one offer

attribute used for response tracking was returned and matched. Responses from
hold-out control groups are always inferred responses.

Direct responses
A response is considered to be a direct response if:
v The respondent returned at least one Campaign-generated code (campaign, cell,

offer, or treatment code) that exactly matches one or more of the possible target
treatment instances generated by Campaign.

AND
v Any "attributes of interest" (that is, any offer attribute, standard or custom, that

was mapped in the Response process for tracking) returned must have a value
exactly matching the value of attribute in the treatment.

For example, if treatment code is a response code of interest and "Response
Channel" is an attribute of interest, an incoming response with the values of
"XXX123" for treatment code and "retail store" for Response Channel will not be
considered a direct match for a treatment with the respective values of "XXX123"
and "Web."

A response with a null value for an attribute of interest cannot match a treatment
that has that offer attribute. For example, a response that is missing a value for
"interest rate" cannot match any offer created from an offer template that contains
interest rate as an offer attribute.

However, a response with a value for an attribute of interest that does not exist in
a treatment does not prevent a match. For example, if a Free Shipping offer was
created from an offer template without an "interest rate" offer attribute, and
"interest rate" is an attribute of interest, the value of the "interest rate" attribute for
an incoming response does not matter when Campaign considers possible matches
against treatments associated with the Free Shipping offer.

Response tracking considers whether the response was made within the valid offer
time period (that is, after the effective date and on or before the expiration date),
or whether the response was outside the valid date range. Campaign tracks late
responses for a configurable time period after an offer's expiration date.

Response tracking also identifies whether a direct response was from a respondent
that was in the originally contacted group, that is, the target cell.
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Note: If a direct response was not from the originally targeted group, then the
response is considered a "viral" response or a "pass-along," meaning that the
responder somehow obtained a valid response code although they did not
originally receive the offer.

It can be valuable to understand how many of your responses came from your
target group, especially if you are trying to cultivate high-value customers. These
values can be broken out in performance reports to see how many direct responses
came from the original target group and how many were viral responses.

Direct responses can be exact or inexact matches.
Related tasks:
“Updating response history” on page 106
Related reference:
“Performance reports for IBM Campaign” on page 228

Direct exact matches
A response is considered to be a direct exact match if Campaign can uniquely
identify a single target treatment instance to credit.

Note: It is a best practice to use Campaign-generated treatment codes for tracking,
because Campaign can always uniquely identify a treatment instance to credit if
the treatment code is returned.

For example, if you used the treatment codes generated from a contact flowchart
as coupon codes in an offer, and a treatment code is returned by a respondent in
one of the offer's target cells, then the response is a direct exact match to that offer.

If multiple tracking codes or attributes of interest are received, all codes and
attribute values must match exactly for the treatment instance to be counted. In
other words, if a respondent provides an offer code, a treatment code, and an offer
attribute with a non-null value, all must exactly match the codes and offer attribute
values in the treatment.

Direct inexact matches
A response is considered to be a direct inexact match if Campaign cannot uniquely
identify a treatment instance to credit, but the returned tracking code(s) match
multiple possible target treatment instances.

To narrow down target treatment instances that will receive credit for this
response, if any target treatment instance contacted the responder, Campaign then
discards any treatment instances that did not contact the responder. If no target
treatment instances contacted the responder, all are kept, and all will receive credit
for a viral response.

For example, if a customer in the high-value segment received an offer from a
campaign which was given to both high and low-value customers and returned the
offer code, this would initially match two target treatment instances (one for the
high-value cell and one for the low-value cell). Applying this response tracking
rule, since the treatment instance for the high-value cell actually targeted this
responder but the treatment instance for the low-value cell did not, the latter is
discarded. Only the treatment instance associated with the high-value customer
group is credited for this response.
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In addition, if the response date was within any of the remaining treatment
instances' valid date range, any treatment instances not within their effective and
expiration dates are discarded.

For example, if a customer was contacted in both the January and February
instances of the same campaign, and the offer code was returned, it would match
two target treatment instances (one from January and one from February). If each
offer version expired at the end of the month in which it was issued, a response in
February would cause the January treatment instance to be discarded because it
had expired. Only the February treatment instance would be credited for this
response.

After response tracking rules are applied and all invalid target treatment instances
are discarded, Campaign uses different attribution methods to calculate the credit
to give to any remaining treatment instances.

Inferred responses
A response is considered to be inferred when the following conditions are met:
v no Campaign-generated tracking codes (campaign, cell, offer, or treatment code)

are returned
v the responder belongs to either a target cell or a control cell
v at least one offer attribute used for response tracking was returned
v all returned offer attributes match.

A response with a null value for an attribute of interest cannot match a treatment
that has that offer attribute. For example, a response that is missing a value for
"interest rate" cannot match any offer created from an offer template that contains
interest rate as an offer attribute.

However, a response with a value for an attribute of interest that does not exist in
a treatment does not preclude a match. For example, if a Free Shipping offer was
created from an offer template without an "interest rate" offer attribute, and
"interest rate" is an attribute of interest, the value of the "interest rate" attribute for
an incoming response does not matter when Campaign considers possible matches
against treatments associated with the Free Shipping offer.

In addition, the respondent must have been contacted (that is, they must have been
in the target cell, or in a group that was contacted), for their response to be
counted as inferred.

For example, if a customer was sent a coupon for $1 off laundry detergent and that
customer purchased laundry detergent (even if they did not redeem the coupon),
Campaign infers a positive response to that target treatment instance.

Inferred responses from control groups
All responses from members of control groups (which are always hold-out controls
in Campaign ) are inferred responses. Matching inferred responses is the only
mechanism for crediting responses from holdout control group members.

Since members of a control group did not receive any communication, they cannot
have any tracking codes to return.

Response tracking monitors members of control groups to see if they take a
desired action without having received any offer. For example, a campaign might
target a group of customers who do not have checking accounts with a checking
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account offer. Members of the control group are tracked to see if they open a
checking account within the same time period as the checking account offer.

All incoming events are evaluated to see if they are possible inferred responses for
control treatment instances. Any response codes are discarded and remaining
attributes of interest are evaluated against control treatment instances for possible
response credit.

Attribution methods
Campaign supports three methods by which responses are credited to offers:
v Best match
v Fractional match
v Multiple match

All three of these response attribution methods are used simultaneously and
recorded as part of response history. You can choose to use one, a combination, or
all of these in the various performance reports to evaluate your campaign and offer
performance.

Response attribution is performed on target treatment instances that remain after
invalid responses are discarded (either because the treatment instance did not
contact the responder, or because the target instance is expired).

For example, a respondent in a target cell that was given three offers returns a cell
code; an exact treatment instance cannot be identified. Best match attribution
would choose one of the three offers to receive full credit; fractional match
attribution would give each of the three offers 1/3 credit each, and multiple match
attribution would give all three offers full credit for the response.
Related tasks:
“Updating response history” on page 106
Related reference:
“Performance reports for IBM Campaign” on page 228

Best match
With best match attribution, only a single target treatment instance receives full
credit for a response; and any other matching treatment instances receive zero
credit. When multiple treatment instances match for a response, Campaign chooses
the treatment instance with the most recent contact date as the best match. If there
are multiple treatment instances with the same contact date and time, Campaign
credits one of them arbitrarily.

Note: In the case of multiple treatment instances with the same contact date and
time, the same instance will be credited each time, but you should not expect
Campaign to select a specific treatment instance.

Fractional match
With fractional match attribution, all n matching treatment instances get 1/n credit
for the response, so that the sum of all attributed scores sum is 1.
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Multiple match
With multiple match attribution, all n matching treatment instances receive full
credit for the response. This can lead to over-crediting of treatments and should be
used with caution. Control groups are always tracked using multiple attribution:
every response from a member of a control group receives full credit.
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Chapter 11. Stored objects

If there are campaign components that you use frequently, you can save them as
stored objects. Reusing stored objects across flowcharts and campaigns saves time
and ensures consistency.

The types of stored objects in IBM Campaign are:
v “Derived fields”
v “User variables” on page 194
v “Custom macros” on page 195
v “Templates” on page 200
v “Stored table catalogs” on page 201

Note: For related information, read about sessions and strategic segments, which
can be reused across campaigns.

Derived fields
Derived fields are variables that do not exist in a data source and are created from
one or more existing fields, even across different data sources.

In many processes, the configuration window includes a Derived Fields button
that you can use to create a new variable for querying, segmenting, sorting,
calculating, or providing output to a table.

You can make derived fields that you create explicitly available to a subsequent
process by enabling the Make Persistent option when you create it.

Derived fields that are available to a process are listed in the Derived Fields folder.
Derived fields are available only for the process in which they were created. If you
have not created any derived fields in a process, no Derived Fields folder appears
in the list.

To use a derived field in another non-subsequent process, store the derived field
expression in the Stored Derived Fields list so it is available for all processes and
all flowcharts.

Naming restrictions for derived fields
Derived field names have the following restrictions:
v They cannot be the same as either of the following types of names:

– A database keyword (such as INSERT, UPDATE, DELETE, or WHERE)
– A field in a mapped database table

v They cannot use the words Yes or No.

If you do not follow these naming restrictions, database errors and disconnects
may result when these derived fields are called.

Note: Derived field names also have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233
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Creating derived fields
You can create fields from one or more existing fields, even across different data
sources.

Procedure
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field window opens.

2. All derived fields that were previously created in this process appear in the
Field Name list. To create a new derived field, enter a different name.

3. Select the Make Persistent check box if you want to store and pass on the
calculated values for this field. This option makes the derived field available to
a subsequent process.

4. Define the derived field directly in the Expressions area or use the Formula
Helper. You can double-click an available field to add it to the Expressions area.
Only fields from tables that are selected in the process configuration dialog can
be used in a derived field expression. If a desired table does not appear, make
sure it is selected as a source table.
A derived field can be a null value. Use NULL to return a null value for a
snapshot. Use NULL_STRING to return a null value with a string data type if
you want the derived field to be used with a Campaign macro.
You can enter a string in a derived field as a constant. If you use a string, it
must be surrounded by double quotation marks. For example, "my string".
Quotation marks are not required for numeric strings.

5. (Optional) Click Stored Derived Fields if you want to be able to use the
derived field in another process or flowchart. You can also use this option to
load an existing derived field or to organize the list of stored derived fields.

6. Click Check Syntax to detect any errors.
7. Click OK to save the derived field.

Creating a derived field from an existing one
You can create a new derived field by basing it on an existing derived field, then
changing the expression.

About this task

Only fields from tables that are selected in the process configuration dialog can be
used in a derived field expression. If a desired table does not appear, make sure it
is selected as a source table.

Procedure
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field dialog opens.

2. From the Field Name list, select an existing derived field.
The expression for the selected field appears in the Expression area.

3. Change the name of the existing derived field to the name that you want to use
for the new derived field.

Important: You cannot use the words "Yes" or "No" as names for derived fields.
Doing so results in database disconnects when these derived fields are called.

190 IBM Campaign: User's Guide



4. Edit the derived field expression.
5. Click OK.

Creating a derived field based on a macro
You can create a derived field by basing it on a macro.

Procedure
1. From the configuration dialog of a process that supports derived fields, click

Derived Fields.
2. In the Create Derived Field dialog, click Formula Helper.
3. Select a macro from the list by double-clicking it.

The macro's declaration and description display, and the macro is inserted in
the Formula Helper.

4. Select the appropriate fields from the Fields available for expression list to
complete your expression.

5. Click OK.

Making derived fields persistent
When you make a derived field persistent, you instruct Campaign to store its
calculated values and make them available to subsequent processes. This saves
time and resources because Campaign does not have to recalculate these values
downstream in the flowchart.

Procedure
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field window appears.

2. Select the Make Persistent checkbox to store and pass on the calculated values
for this field.

Example: Persistent derived field
You might have a Select process configured to choose IDs based on a constraint on
a derived field, connected to a Snapshot process to output the selected records that
include that derived field. If you mark the derived field to be persistent, the
calculated value is passed from the Select process to the Snapshot process.

Another use of persistent derived fields is with any aggregate-type derived field
(for example, AVG or GROUPBY). These aggregated fields are calculated based on
the multiple rows of data within the current cell, so the value of these aggregated
fields changes as the contents of the cell change. With persistent derived fields, you
can choose to keep the original calculated value, then carry that to other processes.
If you choose to recalculate the derived field instead, you get a calculated value
based on the remaining records in the current cell.

When a process takes multiple inputs, such as a Snapshot process working with
the input from two Select processes, all persistent derived fields are available to
the downstream process.

If a persistent derived field is not available across all incoming Select processes,
and it is included in the output for a Snapshot process, then the Snapshot process
displays a NULL value for that persistent derived field in all the output rows from
the Select processes that did not have that persistent derived field.
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If a persistent derived field is not available across all incoming Select processes,
and you use it to define a Segment process, then the Segment process has empty
segments for the Select processes that did not have that persistent derived field.

The Segment process remains unconfigured if you try to define a segment with an
expression using more than one persistent derived field not available across all the
Select processes.

The following guidelines apply to persistent derived fields (PDFs):
v PDFs attach to an inbound cell (vector)
v PDFs are calculated before query execution
v Multiple PDFs are available in the following processes:

– Snapshot: If a PDF is not defined for a cell, its value = NULL. If a single ID is
greater than one cell, one row is output for each cell.

– Segment: PDFs are not available for segmentation by field when multiple
input cells are selected. PDFs must exist in all selected input cells for use in a
segment by query.

v PDFs keep only a single value (selected at random) per ID value, regardless of
the number of times an ID value occurs in the data. Thus, when the output
includes no table fields (and includes an IBM ID), there will be only one record
per ID value.
However, when you use a derived field based on a table field, the output
includes a table field indirectly. Thus, there will be a record for each instance of
an ID value. (In other words, if the ID value occurs seven times in the data,
there will be seven records output.)

Persistent derived fields only store a single value for each audience ID, which is
randomly selected from the available values. This means that when working with
unnormalized data, you must use a GROUPBY macro function to achieve the
desired behavior.

For example, say you want to find from the purchase transaction table, the highest
dollar amount in a single transaction a customer has made and save this as a
persistent derived field for downstream processing. You could write a derived field
(and then persist it as a persistent derived field) as follows:
Highest_purchase_amount = groupby(CID, maxof, Purch_Amt)

Against unnormalized purchase transaction data such as the following, this would
compute as follows:

CID DATE PURCH_AMT HIGHEST_PURCHASE_AMOUNT

A 1/1/2007 $200 $300

A 3/15/2007 $100 $300

A 4/30/2007 $300 $300

When the derived field is persisted, it choose (randomly) any value (which are all
$300) and persists the value $300 for customer A.

A second less obvious example might be to select a predictive model score from a
scoring table for a specific model X. Here the derived field might look like this:
ModelX_score = groupby(CID, maxof, if(Model = ’X’, 1, 0), Score)
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And the data might look like:

CID MODEL SCORE MODELX_SCORE

A A 57 80

A B 72 80

A X 80 80

Persisting the derived field, ModelX_Score, gives the desired result of the score
value of 80. It is incorrect to create a derived field:
Bad_ModelX_score = if(Model = ’X’, Score, NULL)

This would result in the following:

CID MODEL SCORE BAD_MODELX_SCORE

A A 57 NULL

A B 72 NULL

A X 80 80

Then when you persist the derived field Bad_ModelX_score, the persisted value
could be NULL or 80. If you are working with unnormalized data and the derived
field values are not all the same, persisting that derived field could result in any of
the values being returned. For example, defining Derived_field_Score = SCORE
and persisting it could result in the value 57, 72, or 80 for customer A. To ensure
desired behavior, you must use the GROUPBY macro over the customer ID and
guarantee the derived field value is the same for all data for that customer.

Storing derived fields
Store a derived field if you want to be able to use it in another process in the same
or a different flowchart.

About this task

Derived fields are variables that do not exist in a data source; they are created
from one or more existing fields, even across different data sources. A derived field
is available only within the process where it was created. It is not available in any
other process (except an immediately following process if Make Persistent is
enabled).

If you want to store a derived field definition so that you can use it in other
processes and flowcharts, follow the procedure below.

Procedure
1. From the configuration window of a process that supports derived fields, click

Derived Fields and create the derived field that you want to store. For
example, define an expression such as (Balance / Credit_limit) * 100.

2. In the Create Derived Field dialog, open the Stored Derived Fields list and
select Save Current Expression to Stored List.

3. Use the Save Derived Field Expression dialog to specify whether to save the
expression in a folder. You can assign a security policy and optionally change
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the expression and assign it a different name. The expression that you save will
be stored in a list that you can access when you configure other processes and
flowcharts.

4. Click Save.

Using and managing stored derived fields
A derived field that was stored can be used in another flowchart. A derived field
consists of an expression, such as AccountType='gold'. Derived fields are variables
that do not exist in a data source and are created from one or more existing fields,
even across different data sources.

Procedure
1. To use a saved expression in a flowchart process:

a. Open the configuration dialog of a process that supports derived fields, and
click Derived Fields.

b. Open the Stored Derived Fields menu and select Retrieve Expression from
Stored List.

c. Select an expression from the list and click Use Expression.
2. To create, edit, move, or delete stored expressions:

a. Open the Options menu and select Stored Derived Fields.
b. Use the Stored Derived Field Expressions dialog to create or edit

expressions, delete expressions, or move an expression to a different folder.

User variables
Campaign supports user variables, which can be used during process configuration
when creating queries and expressions.

Guidelines for using user variables

The following guidelines apply to user variables:
v User variables are local to the flowchart in which they are defined and used, but

have global scope within that flowchart.
v User variables use the following syntax: UserVar.UserVarName
v User variables have Initial Values, which is the value assigned when a user

variable is initially defined in the User Variables dialog. The Initial Value is
only used to set the Current Value before executing a flowchart run. It is the
Current Value that Campaign uses during a flowchart run.

Note: If the Current Value for a user variable is not set and you execute a
process run or a branch run, Campaign will not be able to resolve the user
variable. Campaign only sets the Current Value of a user variable to the Initial
Value before a flowchart run.

v You can change the Current Value of a user variable in the Derived Field
window of a Select process.

v User variables can be set to constants or to expressions, such as UserVar.myVar
= Avg(UserTable.Age).

Note: If you use an expression that returns multiple values (such as
UserTable.Age+3, which will return one value for each record in the table), the
user variable is set to the first value returned.
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v When using user variables within SQL statements, do not enclose user variables
in quotation marks, either single or double.

v If you pass object names to your database (for example, if you use a user
variable that contains a flowchart name), you must ensure that the object name
contains only characters supported by your particular database. Otherwise, you
will receive a database error.

v The values of user variables can be passed in on process execution.
v User variables are supported in outbound triggers.
v User variables are supported for use in custom macros.

Creating user variables
You can define variables for use in the processes that you add to a flowchart.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select User Variables.
The User Variables dialog opens.

3. In the Variable Name column, enter a name for the new user variable: Click
the <Click here to add new item> hotspot.

4. In the Data Type column, select a data type from the list. If you do not select a
data type, the application selects None when you click OK.
The None data type can produce unpredictable results, so it is best to specify
the correct data type.

5. In the Initial Value column, enter a starting value. You can also profile fields
for available values by clicking the ellipsis button(...) that becomes available
when you click inside the column.

6. In the Current Value column, enter a current value for the user variable. You
can also profile fields for available values by clicking the ellipsis button (...) that
becomes available when you click inside the column.

7. Repeat these steps for each user variable that you want to create.
8. Click OK.

The application stores the new user variables. You can access them later when
you configure processes.

Results

After a flowchart runs, the Current Value of each user variable displays in the
Current Value section for each user variable. If the current value is different from
the initial value, you can restore the initial value by clicking Restore Defaults.

Note: If the Current Value of a user variable is redefined in a Select process,
resetting the Current Value to the Initial Value manually has no effect on the
value of the user variable during a flowchart, branch, or process run.

Custom macros
A custom macro is a query that you create using an IBM Expression, raw SQL, or
raw SQL that includes a value. Custom macros support the use of variables.

You can save a custom macro so it is available when configuring processes in a
flowchart and defining derived fields.
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Support for raw SQL improves performance, allowing complex transactions to be
carried out in the database rather than having the raw data filtered and
manipulated in the application server.

Campaign supports the following types of custom macros, which in turn support
an unlimited number of variables:
v Custom macros that use a IBM Expression
v Custom macros that use raw SQL
v Custom macros that use raw SQL and include a specified value

Important: Since non-technical users are able to use custom macros, when you
create a custom macro you should describe how it works very carefully, place
similar kinds of macros in special folders, and so on. This approach can help
reduce the possibility that someone might use a custom macro incorrectly and
retrieve data that they were not expecting.

Creating custom macros
Custom macros that you create can be used in flowchart processes and in
definitions for derived fields.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select Custom Macros.
3. In the Custom Macros dialog, click New Item.
4. From the Save Under list, select the folder where you want to save the macro.

If no folders have been created, use the default, None.
5. In the Name field, enter a name and declaration for the macro so that it can

be referenced.
Use the following syntax: MacroName(var1,var2,...)
For example: GenGroupBy(id,val1,table,val2)
The MacroName must be unique and alphanumeric. It can include underscores
(_) but not spaces.

Note: If a custom macro has the same name as a built-in macro, the custom
macro takes precedence. To avoid confusion, do not name custom macros with
operator names or names that are the same as the built-in macros. The
exception would be if you specifically want the new custom macro to always
be used instead of the built-in macro.

Important: The variable names must match the variable names in the custom
macro definition in the Expression window, and they must be expressed as a
comma-separated list in parentheses.

6. From the Security Policy list, select a security policy for the new custom
macro.

7. Use the Note field to explain what the custom macro is designed to do and
what each variable represents.

8. From the Expression Type list, select the type of custom macro that you are
creating:
v If you select Raw SQL Selecting ID List, you must select a database from

the Database field.

196 IBM Campaign: User's Guide



v If you select Raw SQL Selecting ID + Value, you must select a database
from the Database field and select a Value Type. Be sure to select the
correct value type. Otherwise, when you later attempt to profile this query,
a "Mismatched Type" error results.

v If you select Text as the value type, specify the width of the value type in
bytes in the Width (# Bytes) field. You can obtain this information from the
database. If you do not have access to the database or are unable to obtain
the information, enter 256, the maximum width.

9. Click in the Expression field to open the Specify Selection Criteria dialog.
10. Create your query expression. You can use as many variables as you like.

Variable syntax is alphanumeric, and the variable must be enclosed in angle
brackets (< >). Operands (values and strings) and operators might be
variables.

Important: Do not use flowchart user variables in custom macro definitions,
since custom macros are global and flowchart user variables are not.
The following example shows a new custom macro definition.

11. Click Save.
The custom macro is saved in the Items List.

Results

The macro can now be accessed by name for use in flowchart processes and in
definitions for derived fields.

Guidelines for using custom macros
Keep the following guidelines in mind when creating or using a custom macro:

Chapter 11. Stored objects 197



v The name of a custom macro must be alphanumeric. You cannot use spaces in
the name string, but you can use underscores (_).

v If a data source has been configured with the property
ENABLE_SELECT_SORT_BY = TRUE, then you must write raw SQL custom
macros with an ORDER BY clause in order to sort the returned records by the
audience key fields of the audience level under which you are working.
Otherwise, if the sort order is not as expected, an error will be generated when
the custom macro is used in a derived field in a Snapshot process.

v If you do not compare a returned value from a custom macro, if the value is
numeric, non-zero values are treated as TRUE (and therefore IDs associated with
them are selected) and zero values are treated as FALSE. String values are
always treated as FALSE.

v When creating a custom macro that uses raw SQL, using a temp table can
greatly speed up the performance of the raw SQL by scoping the amount of data
it needs to work with.
When a custom macro uses temp tables in its underlying logic, a temp table will
be forced up to the database so that the logic does not fail.
However, if a custom macro is used in a top level SELECT, then there is no
history for Campaign to use to force a temp table up to the database, and the
logic fails.
Thus, when creating a custom macro that uses raw SQL, you might need to
create two versions of the same custom macro - one that uses temp table tokens
and one that does not.
The custom macro without temp table tokens can be used at the top of a tree
(for example, in the first SELECT). The one with temp table tokens can be used
anywhere else in the tree when there might be a temp table to take advantage
of.

v Self-joins might occur when combining values returned from custom macros
when querying against unnormalized data, which is not likely to be the desired
behavior.
For example, if you a use a custom macro based on raw SQL that returns a
value and (in a Snapshot process, for example) you output the custom macro
and another field from the table that the custom macro is based on, Campaign
performs a self join on that table. If the table is non-normalized, you will end up
with a Cartesian product (that is, the number of records displayed is more than
you would expect).

v Custom macros are now automatically by reference, because the definition of the
custom macro is not copied into the current process.
At execution time, a custom macro is resolved by looking up its definition in the
UA_CustomMacros system table (where definitions are stored) and then
used/executed.

v Unlike stored queries, custom macro names must be unique, independent of the
folder path. In releases prior to 5.0, you could have a stored query named A, for
example, in both folder F1 and F2.
Campaign supports stored queries from earlier releases. However, references to
non-unique stored queries must use the old syntax:
storedquery(<query name>)

v When resolving user variables in custom macros, Campaign uses the current
value of the user variable when checking syntax. If the current value is left
blank, Campaign generates an error.

v The temp table token is provided as a performance optimization advanced
feature that scopes the amount of data pulled down from the database by the set
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of audience IDs in the temp table available for use by the current process. This
temp table list of IDs might be a superset of the IDs in the current cell.
Therefore, aggregate functions performed over the temp table (for example,
average or sum) are not supported and might generate incorrect results.

v If you intend to use the custom macro across several different databases, you
might want to use a IBM expression rather than raw SQL, since raw SQL can be
specific to a particular database.

v If a custom macro contains raw SQL and another custom macro, the custom
macro is resolved, executed and its value returned before the raw SQL is
executed.

v Campaign treats a comma as a parameter separator. If you are using commas as
literal characters in a parameter, enclose the text in open and close brackets ({}),
as in the following example:
TestCM( {STRING_CONCAT(UserVar.Test1, UserVar.Test2) } )

v Campaign supports simple substitution for parameters in custom macros using
raw SQL code. For example, if you set up a Select process box on a flowchart
containing this query:
exec dbms_stats.gather_table_stats(tabname=> <temptable>,ownname=>
'autodcc')

Campaign would successfully substitute the actual temp table in place of the
<temptable> token. Note that the single quotes around the table name are
required.

The following tables show how Campaign treats custom macros in queries and
derived fields.

Custom macros in queries and derived fields (Select, Segment, and Audience
Processes)

Type of custom macro How it is used

Raw SQL: IDs Runs as a separate query. The ID list is merged with other
results.

If a custom macro contains other custom macros plus raw
SQL, the custom macros are resolved and executed and
then the raw SQL is executed.

Raw SQL: IDs + Value Expects that the returned value will be used in an
expression or as a comparison.

If the value is not used this way, Campaign treats a
non-zero value as TRUE for ID selection and a zero value
and string as FALSE.

IBM Expression The expression is resolved and a syntax check is
performed. One query per table is supported, and the IDs
are match/merged.

In a Raw SQL Query (Select, Segment, and Audience Processes)

Type of custom macro How it is used

Raw SQL: IDs Custom macro is resolved and then the query is executed.

Raw SQL: IDs + Value Not supported.
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Type of custom macro How it is used

IBM Expression The expression is resolved, but no syntax check is
performed. If the expression is incorrect, it is detected by
the database server when executed.

Organizing and editing custom macros
You can create a folder structure to organize your custom macros. You can move
custom macros from one folder to another. You can change the macro name,
description, and expression.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select Custom Macros.
The Custom Macros dialog opens.

3. Select a macro in the Items List.
The Info area shows detailed information for the selected macro.

4. Click Edit/Move to edit or move the selected macro.
The Edit/Move Custom Macros dialog opens.

5. You can change the name of the macro, edit the note, change the
folder/location where the macro is stored, or click Edit to edit the expression.

6. Click Save to save your changes.
7. Click Close.

Templates
A template is a group of selected and saved processes from flowcharts.

Templates allow you to design and configure one or more processes only once, and
save them in the Template Library. Templates save process configurations and table
mappings, and are available for any session or campaign.

Copying a template to the Template Library
You can add templates to the template library by copying them.

About this task

Procedure
1. Open a flowchart in Edit mode.
2. Select the processes that you want to save as a template. Use Ctrl+Click to

select multiple processes. Use Ctrl+A to select all processes in the flowchart.
3. Right-click any selected process and select Copy to Template Library.

The Save Template window appears.
4. Enter a name for the template in the Name field.

You cannot use spaces in the name. Stored templates are identified by names,
which must be unique in the folder in which it is stored.

5. (Optional) Enter a description in the Note field.
6. (Optional) Use the Save Under list to select a folder for the template, or use

New Folder to create a new folder. You can create any number of folders
(including nesting folders in a hierarchy) to organize and store your templates.
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7. Click Save.

Pasting a template from the Template Library
You can paste a template from the Template Library into a flowchart you are
building.

Procedure

1. On a flowchart page in Edit mode, click Options and select Stored
Templates.
The Stored Templates dialog opens.

2. Select a template from the Items list.
3. Click Paste Template.

Results

The selected template is pasted onto the flowchart workspace.

Note: The inserted processes can appear on top of other process already in the
flowchart. All inserted processes are initially selected to make them easy to move
as a group.

Templates can be accessed by any other session or campaign through the Template
Library. If a template is pasted into a flowchart that has different table mappings,
the subsequent mapping is augmented but not replaced by the new mapping,
unless the table name(s) are the same.

Organizing and editing templates
You can create new folders, edit, move, and remove stored templates.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select Stored Templates.
3. From the Items List, select the template that you want to edit or move.
4. Click Edit/Move.

The Edit/Move Stored Templates dialog opens.
5. In the Save Under field, specify a new location for the template.
6. You can also change the name of the stored template, or edit the note that is

associated with it.
7. Click Save.
8. Click Close.

Stored table catalogs
A table catalog is a collection of mapped user tables.

Table catalogs store metadata information about user table mappings for re-use
across flowcharts. By default, table catalogs are stored in a binary format with the
extension .cat.

For information on creating and working with table catalogs, see the Campaign
Administrator's Guide
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Accessing stored table catalogs
You access stored table catalogs from within a flowchart. A table catalog is a
collection of mapped user tables.

About this task

Note: If you have administrator permissions, you can also access stored catalogs
from the Campaign Settings page. For more information, see the Campaign
Administrator's Guide.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select Stored Table Catalogs. The Stored Table
Catalogs window opens.

Editing table catalogs
Within a flowchart, you can edit the name or description of a table catalog, or
move the table catalog to a different location.

Procedure
1. Open a flowchart in Edit mode.

2. Click Options and select Stored Table Catalogs.
The Stored Table Catalogs window opens.

3. Select a table catalog in the Items List.
The Info area shows the detailed information for the selected table catalog,
including the table catalog name and file path.

4. Click Edit/Move.
5. You can change the name of the stored table catalog, edit the table catalog

description, or change the folder/location where the table catalog is stored.
6. Click Save.
7. Click Close.

Deleting table catalogs
You can permanently remove a table catalog so that it is no longer available to any
flowcharts in any campaigns.

About this task

Removing a table catalog deletes the .cat file, which points to database tables and
possibly flat files. Removing a table catalog does not affect the underlying tables in
the database. However, it does permanently remove the catalog file.

Important: Only use the Campaign interface to remove table catalogs or perform
table operations. If you remove tables or change table catalogs directly in the file
system, Campaign cannot guarantee data integrity.

Procedure
1. Open a flowchart in Edit mode.

2. Click the Options icon and select Stored Table Catalogs.
The Stored Table Catalogs window opens.
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3. Select a table catalog in the Items List.
The Info area shows the detailed information for the selected table catalog,
including the table catalog name and file path.

4. Click Remove.
You see a confirmation message asking you to confirm removal of the selected
table catalog.

5. Click OK.
6. Click Close.

Results

The catalog is removed from the Items List and is no longer available to any
flowcharts in any campaigns.
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Chapter 12. Session flowcharts

Sessions provide a way to create persistent, global "data artifacts" for use in all
campaigns. Each session contains one or more flowcharts. Running a session
flowchart makes the outcome of the session (the data artifacts) available globally to
all campaigns.

Session flowcharts are not intended to be used in marketing campaigns. They do
not have associated offers or start and end dates.

To work with sessions, use the Sessions menu. Advanced users can create session
flowcharts to perform computations outside of a campaign and to perform ETL
tasks that are not associated with any specific marketing initiative or program.

Often, a session flowchart starts with a Schedule process, to ensure that the data is
refreshed on a regular basis.

When you run a session flowchart, the data artifacts that are created are then
available for use in any number of campaign flowcharts.

Some typical examples follow:
v Use the Create Seg process in a session flowchart to create strategic segments,

which are segments that can be used in multiple campaigns.
For example, start with a Schedule process, then a Select process, then a
CreateSeg process to generate strategic segments for opt-ins, opt-outs, or global
suppressions. The Schedule process periodically updates the segment, which is
written out as a static member list. The resulting segment is then available for
selection in campaign flowcharts.

v Perform data preparation of large complex tables. A session flowchart can
snapshot the data into smaller data chunks for reuse in Campaign.

v Set up periodic modeling tasks to score data or create derived fields for
ETL/rollups. For example, if a session flowchart creates and writes out model
scores that are then mapped in a table catalog/mapping, those model scores can
be used in campaign flowcharts for selection and targeting.

Note: When you design flowcharts, be careful not to create cyclical dependencies
among processes. For example, if a Select process provides input to a CreateSeg
process, do not use a segment created by that CreateSeg process as input to the
Select process. This situation will result in an error when you try to run the
process.

Sessions overview
Each session contains one or more flowcharts. Run a session flowchart to make the
outcome of the session (the data artifacts) available globally to all campaigns. You
can create, view, edit, move, and delete sessions, and you can organize sessions in
folders. To work with sessions, you must have the appropriate permissions.

You do not copy sessions, but rather the flowcharts within sessions.

You do not run a session; you run each of its flowcharts individually.
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Creating sessions
Create a session if you plan to create one or more session flowcharts.

Procedure
1. Select Campaign > Sessions.

The All Sessions page displays the folder structure that is used to organize
your company's sessions.

2. Navigate through the folder structure until you see the contents of the folder
where you want to add your session.

3. Click the Add a Session icon .
The New Session page appears.

4. Enter a name, security policy and description.

Note: Session names have character restrictions. For details, see Appendix A,
“Special characters in IBM Campaign object names,” on page 233.

5. Click Save Changes.

Note: You can also click Save and Add a Flowchart to immediately start
creating a session flowchart.

Adding flowcharts to sessions
A session can contain one or more flowcharts. You create a session flowchart the
same way that you create a campaign flowchart, except that you start by opening a
session.

Procedure
1. Select Campaign > Sessions.
2. Click the name of a session.

3. Click Add a Flowchart .
4. Create the flowchart as you normally would.

Editing session flowcharts
To edit a session flowchart, use the Sessions menu.

Procedure
1. Select Campaign > Sessions.

The All Sessions page opens.
2. Click Edit a tab next to the name of the session whose flowcharts you want

to edit.
3. From the menu, click the name of the flowchart that you want to edit.
4. Make your changes to the flowchart:

v Use the palette and workspace to add and change process configurations.

v To change the flowchart name or description, click the Properties icon in
the flowchart window toolbar.

5. When you are done, click Save or Save and Exit to close the flowchart window.
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Organizing sessions in folders
Choose Campaign > Sessions, then use the All Sessions page to create folders for
sessions and move sessions from one folder to another.

About this task

You can complete the following operations after you select Campaign > Sessions.

Task Description

Add a session folder Select an existing folder, then click the Add

a Subfolder icon . To add a folder at
the top level, click the icon without selecting
an existing folder.

Enter a name, security policy, and
description.
Note: Folder names have specific character
restrictions. For details, see Appendix A,
“Special characters in IBM Campaign object
names,” on page 233.

Edit a session folder name or description Select a folder, then click the Rename icon

.

Move a session folder and all of its contents Important: If someone is editing a flowchart
in the session you plan to move, flowchart
results or the entire flowchart might be lost
when you move the session. Be sure that
none of the flowcharts in the session are
open for editing when you move the
session.

1. Select the folder that contains the
subfolder that you want to move.

2. Select the check box next to the folder or
folders that you want to move.

3. Click the Move icon .

4. Double-click a destination folder, or open
a destination folder and then click
Accept this Location.

Delete a session folder You can delete empty session folders and all
of its empty subfolders. (If you have
permission to delete a folder, you can also
delete any of its subfolders.)

1. If necessary, move or delete the contents
of the session folder.

2. Open the folder that contains the
subfolder that you want to delete.

3. Check the box next to the folder or
folders that you want to delete.

4. Click the Delete Selected icon ,
then confirm the deletion.
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Moving sessions
You can move sessions from folder to folder for organizational purposes.

About this task

Note: If someone is editing a flowchart in the session that you plan to move, the
flowchart might be lost when you move the session. You must make sure that none
of the flowcharts in the session are open for editing when you move the session.

Procedure
1. Select Campaign > Sessions.

The All Sessions page opens.
2. Open the folder that contains the session you want to move.
3. Select the check box next to the session that you want to move. You can select

multiple sessions.

4. Click the Move icon .
The Move Items To window opens.

5. Select a destination folder and click Accept this Location, or double-click the
folder to select and accept in one step.

Results

The session is moved to the destination folder.

Viewing sessions
Open a session in Read-Only mode to access its associated flowcharts.

Procedure
1. Select Campaign > Sessions.
2. When All Sessions page appears, use one of the following methods:

v Click a session name to display its Summary tab and also any flowchart tabs.
v Click View a tab next to the name of the session that you want to view,

then select Summary or a flowchart from the menu.

Editing sessions
You can change the name, security policy, or description of a session.

Procedure
1. Select Campaign > Sessions.
2. Click the name of a session.

3. On the session Summary tab, click the Edit Summary icon .
4. Change the session name, security policy, or description.

Note: Session names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233.

5. Click Save Changes.
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Deleting sessions
When you delete a session, the session and all of its flowchart files are deleted. If
there are portions of your session that you want to retain for reuse, save them as
stored objects before you delete the session.

Procedure
1. Select Campaign > Sessions.
2. Open the folder that contains the session that you want to delete.
3. Select the checkbox next to one or more sessions that you want to delete.
4. Click the Delete Selected icon.
5. Click OK to confirm.

About strategic segments
A strategic segment is a globally persistent list of IDs, which is available for use in
multiple campaigns. A strategic segment is a static list of IDs until the flowchart
that created it originally is re-run.

Strategic segments are created using the Create Seg process in a session flowchart.
A strategic segment is no different from segments created by a Segment process in
a flowchart except that a strategic segment is available globally. Availability
depends on the security policy that is applied to the folder in which the strategic
segment is stored.

Campaign supports multiple strategic segments. The ID list that is created for each
strategic segment and audience level is stored in the Campaign system tables. You
can associate any number of strategic segments with a campaign.

Strategic segments can be used for global suppression. A global suppression
segment defines the list of IDs that are automatically excluded from cells in
flowcharts for a particular audience level.

Strategic segments are also used in cubes. A cube can be created from any list of
IDs, but cubes that are based on strategic segments are global and can be analyzed
by the various segment reports.

Strategic segments can optionally specify one or more IBM data sources in which
that strategic segment will be cached (stored in the database so that uploading the
strategic segment IDs is not required for each flowchart that uses the segment).
This can provide significant performance improvements. Cached strategic segments
are stored in temporary tables, which are assigned the SegmentTempTablePrefix
configuration parameter.

Note: Working with strategic segments requires the appropriate permissions. For
information on permissions, see the Campaign Administrator's Guide.
Related tasks:
“Creating segments for global use in multiple campaigns” on page 95

Improving performance of strategic segments
By default, the Create Seg process creates a binary file on the application server,
which can take a long time for a large strategic segment. When Campaign updates
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the binary file, it drops and then inserts the rows again into a cached table; the
entire file is rewritten for sorting. For extremely large strategic segments (for
example, 400 million IDs), it takes a long time to rewrite the entire file, even when
most of the IDs have not changed.

To improve performance, set the doNotCreateServerBinFile property on the
Configuration page to TRUE. A value of TRUE specifies that strategic segments create
a temp table in the data source instead of creating a binary file on the application
server. When this property is set to TRUE, at least one valid data source must be
specified on the Define Segments tab of the CreateSeg process configuration.

Other performance optimizations, such as creating indexes and generating
statistics, which cannot be applied to cached segment tables, can be used with
segment temp tables. The PostSegmentTableCreateRunScript,
SegmentTablePostExecutionSQL, and SuffixOnSegmentTableCreation properties on
the Configuration page support these performance optimizations.

For details about properties on the Configuration page, see the Campaign
Administrator's Guide.

Prerequisites for creating strategic segments
Before you create a strategic segment, you should do the following:
v Determine how your strategic segments will be organized, the folder hierarchy

and naming conventions you will use.
v Determine exactly what strategic segments are important to you.
v Determine the logic behind your strategic segments.
v Identify the relationship between different strategic segments.
v Identify the audience levels appropriate to your strategic segments.
v Determine how often the strategic segments should be refreshed.
v Determine what level of detail is defined in each strategic segment. For example,

should a segment include all suppressions?
v Determine if you want to keep historical strategic segments in an archive folder.
v Consider the size of the strategic segments you want to create and their

potential impact on performance. See “Improving performance of strategic
segments” on page 209.

Creating strategic segments
A strategic segment is one that is available for use in multiple campaigns. Create
strategic segments in a session flowchart, run the flowchart in production mode,
and save the flowchart. The resulting segments can then be used in marketing
campaigns.

Before you begin

The saveRunResults configuration property
(Campaign|partitions|partition[n]|server|flowchartRun) must be set to TRUE.

Also, you must have the appropriate permissions to work with strategic segments.

Procedure
1. Create a session, or open an existing session for editing.
2. Create a flowchart whose final output process is the CreateSeg process.
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For instructions, see “Creating segments for global use in multiple campaigns”
on page 95.

3. Run the flowchart in production mode and click Save and Exit. Running the
process in test mode does not create a strategic segment or update an existing
one. You must run the process in production mode in a session flowchart.
The flowchart is saved.

Results

The strategic segments are listed on the All Segments page and are available for
use in all campaigns.

Example: Session flowchart creating strategic segments
In a flowchart in the Sessions area of Campaign, add two Select processes, one to
select all records from a particular field in a mapped table in your datamart, and
the other to select all records from the same datamart that have been classified as
opt-outs and thus need to be removed from the total list of IDs.

Next, use a Merge process whose input consists of the output cells of the two
Select processes to eliminate the OptOut IDs and produce an output cell of eligible
IDs.

Then, add a Segment process to which the eligible IDs from the Merge process are
passed, where they are divided into three discrete groups of IDs.

Finally, add a Create Seg process to output the three segments as a globally
persistent list of audience IDs.

Run the flowchart in production mode to create the strategic segment and make it
available for use in multiple campaigns.

Viewing strategic segments
You can view information about strategic segments that were created with the
Create Seg process in a session flowchart. The session flowchart must run in
production mode in order to generate the segments, which are then globally
available.

Procedure

Use one of the following methods:
v Go to the Summary page of any campaign that uses strategic segments, then

click the segment name in the Relevant Segments list.
v Select Campaign > Segments, then click the name of the segment that you want

to view.

Results

The Summary page provides information about the segment.

Element Description

Description The description of the segment provided in
the Create Seg process.

Source Flowchart The name of the session flowchart where the
segment was defined.
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Element Description

Audience Level The audience level for the segment.

Current Count The number of IDs in this segment and the
date that the segment last ran.

Used in the Following Campaign(s) A list of the campaigns that use the segment,
with links to those campaigns.

To edit a segment's Summary details
Procedure
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the name of the segment whose summary details you want to edit.

The segment opens to its Summary tab.
3. Make your desired edits to the name or description of the segment.

Note: Segment names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233.

4. When you have finished making your changes, click Save Changes.
Your changes are saved and the segment closes.

To edit a strategic segment's source flowchart
Procedure
1. Select Camaign > Segments.

The All Segments page appears.
2. Click the name of the segment whose flowchart you want to edit.

The segment's Summary page appears.
3. Under Source Flowchart, click the link to the flowchart.

The flowchart page opens in Read Only mode.
4. Click Edit to open the flowchart in Edit mode.
5. Make the desired changes to the flowchart.
6. When you have finished making your changes, click Save or Save and Exit.

Results

Important: The existing strategic segment is not updated until you re-run the
updated flowchart in production mode.

Running strategic segments
You should re-generate strategic segments if the contents of your datamart have
changed. To re-generate a strategic segment, you run the flowchart in which that
segment was created, in production mode. The Enable Output setting in Test Run
mode has no effect; strategic segments are output only in production mode.

Note: When a Create Seg process is re-run in production mode, the existing
strategic segment created by that process is deleted. This means that any users of
the existing strategic segment (including global suppressions) might see an "invalid
segment" error if the new Create Seg process run fails to complete successfully, or
while it is still running.
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Organizing strategic segments
You can organize your strategic segments by creating a folder or series of folders.
You can then move strategic segments from one folder to another within the folder
structure you have created.

Note: The folder in which a strategic segment resides specifies the security policy
applying to the strategic segment, determining who can access, edit, or delete it.

Adding a segment folder
You can add, move, and delete folders to organize your segments. You can also
edit a folder's name and description.

Procedure
1. Select Campaign > Segments.

The All Segments page opens.
2. Click the folder where you want to add the subfolder.

3. Click the Add a Subfolder icon .
The Add a Subfolder page opens.

4. Enter a name, the security policy, and description for the folder.

Note: Folder names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233.

5. Click Save Changes.
You are returned to the All Segments page. The new folder or subfolder you
created is displayed.

To edit a segment folder's name and description
Procedure
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the folder you want to rename.
3. Click Rename.

The Rename a Subfolder page appears.
4. Edit the name and description of the folder.

Note: Folder names have specific character restrictions. For details, see
Appendix A, “Special characters in IBM Campaign object names,” on page 233.

5. Click Save Changes.
You are returned to the All Segments page. The folder or subfolder is renamed.

Moving a segment folder
You can organize your strategic segments by creating folders for them, and then
moving the folders into a hierarchical structure.

Before you begin

Important: If someone is editing the source flowchart for any segment you plan to
move, that entire flowchart might be lost when you move the segment. Make sure
that none of the source flowcharts are open for editing when you move the
subfolder.
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Procedure
1. Select Campaign > Segments.

The All Segments page opens.
2. Open the folder that contains the subfolder you want to move.

Navigate through the folder structure by clicking a folder name to open it,
clicking All Segments to return to the All Segments page, or clicking a folder
name to open folders in the tree.

3. Select the check box next to the folder you want to move. You can select
multiple folders to move to the same location at one time.

4. Click the Move icon .
The Move Items To window opens.

5. Click the folder where you want to move the subfolder.
Navigate through the list by clicking the + sign next to a folder to open it.

6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.
The subfolder and all its contents are moved into the destination folder.

Deleting a segment folder
You must move or delete the contents of a folder before you can delete it. If you
have the permissions that are required to delete a folder, you can also delete any of
the subfolders in that folder.

Procedure
1. Select Campaign > Segments.

The All Segments page opens.
2. Open the folder that contains the subfolder you want to delete.

Navigate through the folder structure by clicking a folder name to open it,
clicking All Segments to return to the All Segments page, or clicking a folder
name to open folders in the tree.

3. Select the check box next to the folder you want to delete. You can select
multiple folders to delete at one time.

4. Click the Delete Selected icon .
5. Click OK on the confirmation window.

The folder and all its empty subfolders are deleted.

Moving a segment
You can move strategic segments from folder to folder for organizational purposes.

About this task

Important: If a source flowchart for the segment you plan to move is open for
editing, the entire flowchart may be lost when you move the segment. Make sure
that none of the source flowcharts are open for editing before you move the
subfolder.
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Procedure
1. Select Campaign > Segments.

The All Segments page opens.
2. Open the folder that contains the segment you want to move.
3. Select the check box next to the segment you want to move. You can select

multiple segments to move to the same location at one time.

4. Click the Move icon .
The Move Items To window opens.

5. Click the folder where you want to move the segment.
Navigate through the list by clicking the + sign next to a folder to open it.

6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.
The segment is moved into the destination folder.

Deleting strategic segments
Strategic segments can be deleted in the following ways:
v By deleting the strategic segment itself from its folder location on the All

Segments page. Strategic segments that you delete by this method will be
re-created if the Create Seg processes that generated them originally are re-run
in production mode.

v By deleting the Create Seg process that created the strategic segment. The
strategic segment is deleted only when the flowchart is saved. Strategic
segments deleted in this way cannot be recovered. For details, read about
deleting processes in flowcharts.

v By deleting the flowchart containing the Create Seg process that created the
strategic segment. Strategic segments deleted in this way cannot be recovered.
For details, read about deleting flowcharts.

Deleting a segment
Use the following procedure to delete a strategic segment directly from the All
Segments page.

About this task

Use the following procedure to delete a strategic segment directly from the All
Segments page.

Note: Strategic segments that you delete by this method are re-created if the
Create Seg processes that generated them originally are rerun in production mode.

Procedure
1. Select Campaign > Segments.

The All Segments page opens.
2. Open the folder that contains the segment you want to delete.
3. Select the check box next to the segment you want to delete. You can select

multiple segments to delete at one time.

4. Click the Delete Selected icon .
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5. Click OK on the confirmation window.
The segment is deleted.

Note: If there are still active flowcharts that contain the segment, the segment
can be re-created when those flowcharts are run. If a flowchart that contains the
segment was open for editing when you deleted the segment, it also is
re-created.

About global suppressions and global suppression segments
Use global suppression to exclude a list of IDs in a single audience level from all
cells in all Campaign flowcharts.

To define global suppression, an administrator creates a list of unique IDs as a
strategic segment in a session flowchart and runs the session flowchart. Then
campaign designers can specify that segment as a global suppression segment for a
specific audience level in a campaign flowchart. Only one global suppression
segment can be configured for each audience level.

If a global suppression segment is configured for an audience level, all top-level
Select, Extract, or Audience processes associated with that audience level
automatically exclude the IDs from their output results, unless global suppression
is disabled for a specific flowchart. By default, all flowcharts (except session
flowcharts) have global suppression enabled.

Note: Specifying and managing global suppression segments requires the "Manage
Global Suppressions" permission and is usually performed by a Campaign
administrator. For details, see the IBM Campaign Administrator's Guide.

Applying global suppressions
If a global suppression segment has been defined for an audience level, all
top-level Select, Extract, or Audience processes associated with that audience level
automatically exclude the IDs in the global suppression segment from their output
cells (unless the global suppression is explicitly disabled for a specific flowchart).
By default, flowcharts have global suppression enabled so that no action needs to
be taken for any configured global suppression to be applied.

An exception to the default of global suppression being enabled is the flowchart
containing the CreateSeg process that created the global strategic segment itself. In
this case, the global suppression is always disabled (only for the audience level for
which the global suppression segment is being created).

Note: Also note that performing Test Query in Select, Extract or Audience
processes does not take into account any global suppressions.

Switching audiences with global suppressions

If you are switching from Audience 1 to Audience 2 in a flowchart, and have one
global suppression defined for each of these audience levels, the global
suppression segment for Audience 1 is applied to the input table, and the global
suppression segment for Audience 2 is applied to the output table.
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Disabling global suppressions
You can disable global suppressions for individual flowcharts only if you have the
appropriate permissions. If you do not have the appropriate permissions, you
cannot change the setting and must run the flowchart with the existing setting.

An administrator might grant global suppression override permissions to specific
users so that they can design and execute special campaigns that are allowed to
contact normally suppressed IDs, for example, IDs in a universal holdout group.

Disabling global suppressions for a flowchart
By default, flowcharts have global suppression enabled. You can disable this
feature.

Procedure
1. Open the flowchart for editing.

2. Click the Admin icon and select Advanced Settings.
3. In the Advanced Settings window, select the Disable Global Suppressions for

this Flowchart checkbox.
4. Click OK.

About dimension hierarchies
A dimension hierarchy is a set of SQL selection queries that can be applied to any
list of IDs. Like strategic segments, dimension hierarchies can be made available
globally in a Select process or used as the basis for constructing cubes.

Among the most commonly specified dimensions are time, geography, product,
department, and distribution channel. However, you can create any kind of
dimension that best relates to your business or campaign.

As the building blocks of cubes, dimensions become the basis for a variety of
reports (total sales across all products at increasing aggregation levels, cross-tabular
analysis of expenses versus sales by geography, and so on). Dimensions are not
limited to a single cube; they can be used in many cubes.

A dimension hierarchy is made up of various levels, which in turn are comprised of
dimension elements, or elements for short.

You can have dimensions that are comprised of an infinite number of levels and
elements, as well as:
v Data points built as input to customer analytic reporting and visual selection
v Roll ups into unlimited number of categories to support drill-down capability.

(Dimensions must roll up cleanly across boundaries, so elements must be
mutually exclusive and not overlap.)

Related tasks:
“Creating a multi-dimensional cube of attributes” on page 94

Examples: Dimension hierarchies
The following two examples illustrate a basic dimension hierarchy that would be
created in your datamart and then mapped into Campaign.
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Example: Age Dimension Hierarchy

Lowest level: (21-25), (26-30), (31-35), (36-45), (45-59), (60+)

Rollups: Young (18-35), Middle (35-59), Older (60+)

Example: Income Dimension Hierarchy

Lowest level: >$100,000, $80,000-$100,000, $60,000-$80,000, $40,000-$60,000

Rollups: High (> $100,000), Middle ($60,000-$100,000), Low (< $60,000) (> $100,000),
($60,000-$100,000), (< $60,000)

Creating dimension hierarchies
To use dimensions in Campaign, you must do the following:
v Define and create a hierarchical dimension in a table or delimited flat file in

your data mart
v Map this hierarchical dimension table or flat file to a dimension in Campaign

Note: A hierarchical dimension is created in the data mart either by the Campaign
system administrator or by members of your IBM consulting team, and is an
operation external to Campaign. Also note that the lowest level of the hierarchical
dimension must use either raw SQL or a pureIBM Expression (no custom macros,
strategic segments, or derived fields) to define the individual elements.

When this hierarchical dimension is then mapped into Campaign, Campaign
executes this code to perform the various roll-ups.

Mapping a hierarchical dimension to a Campaign dimension
To map dimensions, you create the dimension in Campaign and then specify the
file or table that contains the hierarchical dimension. The hierarchical dimension
must exist in your data mart before you can complete this task.

Before you begin

Note: Since in almost all cases dimensions are used to create cubes, you may want
to create dimensions from a flowchart in the Sessions area of the application.

Procedure
1. Open the Dimension Hierarchies window in one of these ways.

v In a flowchart in Edit mode, click the Admin icon and select
Dimension Hierarchies.

v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window opens.

2. Click New Dimension.
The Edit Dimension window opens.

3. Enter the following information about the dimension you are creating:
v Dimension Name.
v Description.
v The number of levels in the dimension. (In most cases, this number

corresponds to the levels in the hierarchical dimension in the data mart to
which you are mapping this dimension.)
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v If you are using this dimension as the basis for a cube, ensure that the
Elements are Mutually Exclusive check box is selected (Campaign checks
this option by default). Otherwise, when you use this dimension to create a
cube an error results, since the values in elements cannot overlap in a cube.

4. Click Map Table.
The Edit Table Definition window opens.

5. Select one of the following options:
v Map to Existing File.
v Map to Existing Table in Selected Database.
Proceed with the steps for mapping a table. For details, see the Campaign
Administrator's Guide.

Note: When mapping tables for dimension hierarchies, the field names
"Level1_Name," "Level2_Name," etc. must exist in the table for mapping to
succeed.
When you finish mapping the table for the dimension, the Edit Dimension
window opens with the dimension information for the new dimension.

6. Click OK.
The Dimensions Hierarchies window opens with the newly mapped dimension
visible.

7. To store a dimension hierarchy so that it is available for future use and does
not need to be re-created, click Save on the Dimension Hierarchies window.

Updating a dimension hierarchy
Campaign does not support automatic updates of dimension hierarchies. If the
underlying data changes, you must update the dimension hierarchies manually.

About this task

Note: Cubes consist of dimensions that are based on strategic segments, therefore
you must update dimensions whenever strategic segments are updated.

Procedure
1. Open the Dimension Hierarchies window in one of these ways.

v In a flowchart in Edit mode, click the Admin icon and select
Dimension Hierarchies.

v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window opens.

2. Click Update All.
Alternatively, to update an individual dimension, select the dimension and then
click Update.

Loading a stored dimension hierarchy
After you define a dimension hierarchy, you make it accessible in Campaign by
loading it.

Procedure
1. Open the Dimension Hierarchies window in one of these ways.

v In a flowchart in Edit mode, click the Admin icon and select
Dimension Hierarchies.
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v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window opens.

2. Highlight the dimension hierarchies that you want to load and click Load.

About cubes
A cube is the simultaneous segmentation of a list of IDs (most often a strategic
segment) by the queries provided by a number of dimension hierarchies. After the
cube is created, you can view segment cross-tab reports that drill into two
dimensions of the cube at any given time.

Before you can create a cube, you must perform the following preliminary tasks:
v Create a strategic segment
v Create dimensions that are based on the strategic segment
v The following guidelines apply to cubes:
v Cube metrics can be defined as any Campaign expression with the following

restrictions:
– You can specify an unlimited number of additional NUMERIC metrics and

Campaign will calculate min, max, sum, average for them. Selected metrics
can be derived fields or persistent derived fields.

– The aggregation function on cell count (min, max, avg, % of total no, and so
on) is calculated automatically.

– The aggregation function on an attribute value (for example, avg(age) )
automatically calculates min, max, sum, and average.

– Expressions that contain multiple attribute values (for example, (attribute1 +
attribute2) ) are supported in derived fields.

– The Cube process supports derived fields and persistent derived fields.
– Groupby expressions (for example, (groupby_where (ID, balance, avg,

balance, (trxn_date > reference_date))) ) are supported in derived fields.
– Expressions involving user variables (defined in same flowchart as cube

process AND exposed to Distributed Marketing) are supported in derived
and persistent derived fields. (For more information about Distributed
Marketing, see the Distributed Marketing User's Guide.)

– Expressions that use raw SQL are supported in a derived field that uses a raw
SQL custom macro

– Expressions that use a custom macro are supported in a derived field.
v Although cubes are composed of up to three dimensions, metrics can be

displayed for only two dimensions at a time. The undisplayed third dimension
is still computed and stored on the server, but is not used in visual
selection/reporting for that particular report.

v Cubes can be built on cells as well as segments (which, for example, can be
created at the transaction level). However, if a cube is built on a cell, the cube is
available only in that flowchart. For that reason, you may want to base cubes on
strategic segments.

v Unless your tables are normalized, defining dimensions with a many-to-many
relationship with the audience level could produce unexpected results. The cube
algorithm relies on normalized tables. Before you select and build a cube,
normalize data by rolling it up (to the customer level through a data prep
session for example).
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Note: If you build a cube on non-normalized dimensions, the sum counts will
be wrong in the crosstab reports, owing to the way that Campaign processes the
dimension IDs. If you must use non-normalized dimensions, build cubes with
only two dimensions and use transactions as the lowest level metric of the
nonnormalized dimensions, rather than customer IDs, since the transaction sum
will be correct.

v When creating a cube dimension, you must give the dimension a name,
audience level, and a table to correspond to the dimension. Later, when working
in a session or a campaign flowchart, you map this dimension the same as if
you were mapping a database table.

v Cubes should be built when users are not accessing them, typically after
business hours and on weekends.

Related tasks:
“Creating a multi-dimensional cube of attributes” on page 94
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Chapter 13. IBM Campaign reports overview

IBM Campaign provides reports to aid in campaign and offer management.

Some reports are intended to be used during the flowchart design phase. Other
reports help you to analyze contact responses and campaign effectiveness after a
campaign is deployed.

IBM Campaign reports provide several different types of information:
v Object-specific reports analyze a specific campaign, offer, cell, or segment. To

access these reports, click the Analysis tab for a campaign or offer.
v System-wide reports provide analysis across multiple campaigns, offers, cells, or

segments. To access these reports, choose Analytics > Campaign Analytics.
v Cell reports provide information about customers or prospects who are being

targeted or used as controls. Cell reports are useful when creating campaign

flowcharts. To access these reports, click the Reports icon while editing a
flowchart.

The reports that are available depend on several factors:
v Your permissions, which are set by your IBM Campaign administrator.
v Some reports are available only if you installed the IBM Campaign Reports Pack

and integrated IBM Campaign with Cognos. For information, see the IBM EMM
Reports Installation and Configuration Guide. Also see the IBM Campaign Report
Specifications, which are provided as a compressed file with the reports pack.

v Cognos report packs for eMessage, Interact, and Distributed Marketing are also
available, if you have licenses for those additional products. You can access the
reports from the Analytics page for each product or from the campaign or offer
Analysis tab. For more information, see the documentation for those products.

Related tasks:
“Using reports to analyze campaigns and offers” on page 224
“Using reports during flowchart development”
Related reference:
“List of IBM Campaign reports” on page 225

Using reports during flowchart development
IBM Campaign provides cell reports for use during flowchart development. A cell
is a list of identifiers that a data manipulation process (Select, Merge, Segment,
Sample, Audience, or Extract) generates as output. Cell reports provide information
about customers or prospects who are being targeted or used as controls.

Before you begin

Access to flowchart cell reports depends on your permissions. For example, you
must have permission to edit or review flowcharts and to view or export cell
reports. See the Campaign Administrator's Guide for information about cell report
permissions for the system-defined Administrative Role.
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Procedure
1. Open a flowchart in Edit mode.

2. Click the Reports icon in the flowchart window toolbar.
The Cell Specific Reports window opens. By default, the Cell List report is
displayed.

3. Use the Report to View list to select a different report.
4. Use the controls at the top of the report to print, export, or perform other

operations specific to that report.
For descriptions of the reports and their available controls, see “Analyzing the
quality of your flowchart selections” on page 37.

Related concepts:
Chapter 13, “IBM Campaign reports overview,” on page 223
Related reference:
“List of IBM Campaign reports” on page 225

Using reports to analyze campaigns and offers
IBM Campaign provides reports to help you analyze information about your
campaigns and offers. Some reports can be run during campaign development as
part of your planning process. Other reports show campaign results, so you can
analyze and fine-tune your offers and campaign strategy.

Before you begin

Before you run a campaign, use the IBM Campaign flowchart cell reports to
analyze your selections. To use the cell reports, open a flowchart in Edit mode and
click the Reports link at the top of the page. For more information, see “Using
reports during flowchart development” on page 223.

About this task

IBM Campaign reports provide detailed information about offers, segments, and
campaigns. By viewing reports, you can analyze campaign offers, response rates,
revenue, profit per responder, and other data to calculate your total and
incremental revenue, profit, and ROI.

Procedure
1. To analyze an individual campaign, offer, or segment, use the Analysis tab:

a. Open the Campaign menu and choose Campaigns, Offers, or Segments.
b. Click the name of a campaign, offer, or segment.
c. Click the Analysis tab.
d. Select a report from the Report Type list at the top right of the page. The

report displays in the same window.
2. To analyze results across multiple campaigns, offers, cells, or segments, use the

Campaign Analytics page:
a. Select Analytics > Campaign Analytics.
b. Click one of the report folders.
c. Click a report link.
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If the report allows filtering, the Report Parameter window opens.
d. Select one or more objects on which to filter the report. Use Ctrl+click to

select multiple objects. Your permissions determine which objects appear.
e. Click Generate the Report.

The report displays in the same window. The report generation date and
time are displayed at the bottom of the page. If the report spans more than
one page, use the provided controls to move to the top or bottom of the
report or to page up and down.

Results

The Reports toolbar is displayed for reports generated by Cognos. It is not
available for the calendar or segment reports or for flowchart cell reports.

You can the Reports toolbar to perform the following tasks:
v Keep this version: Send the report by email
v Drill Down/Drill Up: Used for reports that support dimensional drilling.
v Related links: Used for reports that support dimensional drilling.
v View format: The default viewing format for reports is HTML. You can choose

other viewing formats from the list. The icon changes to indicate the selected
view option.

Note: Not all reports can be viewed in all formats. For example, reports that use
multiple queries cannot be viewed in CSV or XML.
– View in HTML Format: After the page refreshes, you can use the Report

controls to navigate through the report, if it spans more than one page.
– View in PDF Format: You can save or print the report by using the PDF

reader controls.
– View in Excel Options: You can view the report as a single page in Excel

format. To view the report without saving it, click Open. To save the report,
click Save and follow the prompts.

– View in CSV Format: To view the report as a comma-separated values file,
choose View in CSV Format from the View in Excel Options. To view the
report without saving it, click Open. The report displays as a single page in a
spreadsheet format. To save the report, click Save, then enter a name when
prompted. By default, the file is saved as an .xls file.

– View in XML Format: The report is displayed as XML in the same window.
Related concepts:
Chapter 13, “IBM Campaign reports overview,” on page 223
Related reference:
“List of IBM Campaign reports”

List of IBM Campaign reports
IBM Campaign reports are intended to help you design effective marketing
campaigns and analyze campaign results.
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Standard reports

Campaign administrators and designers use the following reports to plan and
analyze campaigns.

Table 14. Standard reports for campaign development

Report Description How to Access

Segment Crosstab
Analysis

Campaign administrators use this report to drill into cells and
create a Select process for use in a campaign or session
flowchart.

This report calculates detailed information about any two
dimensions in a cube and displays the results in tabular
format. Only strategic segments or cells that are part of a cube
can be analyzed in this report.

Use the campaign Analysis
tab.

Segment Profile
Analysis

Campaign administrators use this report to build strategic
segments and construct cubes for use in multiple campaigns.

This report calculates and displays the count for a strategic
segment's dimensions. The information is displayed in both
tabular and graphical views. Only strategic segments that are
part of a cube can be analyzed in this report.

Use the campaign Analysis
tab.

Campaign
Flowchart Status
Summary

Campaign designers use this report after doing a test or
production run to determine if there were any errors in the
flowchart run.

Use the campaign Analysis
tab.

Calendar of
Campaigns

Campaign designers use the calendar reports when planning
and running campaigns.

These reports display campaigns and offers on a calendar
based on the Effective and Expiration Dates defined in the
campaign. Double arrows indicate the start (>>) and end (<<)
dates of a campaign.

Choose Analytics > Campaign
Analytics.

Flowchart cell reports

Use the flowchart cell reports when designing campaign flowcharts, to help
identify the intended targets of a marketing campaign. A cell is a list of identifiers
that a data manipulation process (Select, Merge, Segment, Sample, Audience, or

Extract) generates as output. To access the cell reports, click the Reports icon
when editing a flowchart.

Table 15. Campaign flowchart cell reports

Report Description

Cell List Display information about all of the cells that are in the current flowchart. Each cell
represents a potential target group.

For more information: See “Displaying information about all cells in a flowchart (Cell
List report)” on page 38.

Cell Variable Profile Display demographic information to identify potential targets for your campaign. You
can display data for one variable of a cell. For example, you can display the age range
of clients with gold credit cards.

For more information: See “Profiling one characteristic of a cell (Cell Variable Profile
report)” on page 38.
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Table 15. Campaign flowchart cell reports (continued)

Report Description

Cell Variable Crosstab Display demographic information to identify potential targets for your campaign. You
can display data for two variables of a cell. For example, using Age and Amount for the
"Gold" credit cards cell, you can visually identify which age groups spent the most
money.

For more information: See “Profiling two characteristics of a cell simultaneously (Cell
Variable Crosstab report)” on page 39.

Cell Content Display details about the records in a cell. For example, you can see email addresses,
phone numbers, and other demographic data for each customer in a cell. Use this report
to verify the results of runs and confirm that you are selecting the intended set of
contacts.

For more information: See “Displaying the contents of cells (Cell Content report)” on
page 40.

Cell Waterfall Analyze the falloff of audience members as cells are processed, so you can refine your
selections and identify possible errors. For example, you can see how many IDs are
initially selected, then see what happens when you use a Merge process to exclude
opt-outs.

For more information: See “Analyzing cell waterfall in downstream processes (Cell
Waterfall report)” on page 41.

Cognos reports

The Cognos reports are supplied with the IBM Campaign Reports Pack. Use the
Cognos reports to plan, adjust, and analyze campaigns. These reports are examples
that you can customize for your own use. To access these reports, you must
integrate IBM Campaign with IBM Cognos. For instructions, see the IBM EMM
Reports Installation and Configuration Guide.

Table 16. Cognos reports

Report Description How to access

Campaign
Summary

Campaign designers use this report when creating and running
campaigns.

This report displays information about all campaigns that have
been created. It lists the campaign code, creation date, start and
end dates, last run date, initiative and objective of each
campaign.

For more information: See the IBM Campaign Report
Specifications provided with the reports pack.

Choose Analytics > Campaign
Analytics.

Offer Campaign
Listings

Campaign designers use this report when planning offers or
creating and running campaigns.

This report shows which offers were provided with various
campaigns; it lists campaigns grouped by offers. It lists the
campaign code, initiative, start and end dates and last run date.

For more information: See the IBM Campaign Report
Specifications provided with the reports pack.

Choose Analytics > Campaign
Analytics.
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Table 16. Cognos reports (continued)

Report Description How to access

Performance
reports

Campaign designers and marketing managers use the "What If"
Offer Financial Summary report when planning offers and
campaigns.

They use the other performance reports after deploying a
campaign and obtaining response data. These reports analyze
campaign results by looking at contact and response data across
campaigns, offers, cells, or segments.

For more information: See “Performance reports for IBM
Campaign.”

Choose Analytics > Campaign
Analytics > Performance
Reports to analyze results
across one or more campaigns,
offers, cells, or segments.

To analyze results for a
specific campaign, open the
Analysis tab of the campaign
or offer.

Related concepts:
Chapter 13, “IBM Campaign reports overview,” on page 223
Related tasks:
“Using reports to analyze campaigns and offers” on page 224
“Using reports during flowchart development” on page 223

Performance reports for IBM Campaign
Performance reports are provided with the IBM Campaign Reports Pack. The
performance reports are example reports that you can modify to analyze contact
and response data across one or more campaigns, offers, cells, or segments.

To use these reports, you must integrate IBM Campaign with IBM Cognos. For
more information, see:
v IBM EMM Reports Installation and Configuration Guide.
v IBM Campaign Report Specifications, which is a compressed file with the reports

pack. The specification provides examples of output from the performance
reports.

The performance reports are available in the following ways:
v From the Analysis tab of a campaign or offer.
v By choosing Analytics > Campaign Analytics > Performance Reports to analyze

results across one or more campaigns, offers, cells, or segments.

Use the "What If" Offer Financial Summary report when planning offers and
campaigns. Use the other performance reports after deploying a campaign and
obtaining response data.
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Table 17. Performance reports

Report Description

"What If" Offer Financial
Summary

This report calculates the hypothetical financial performance of an offer based on your
input. You specify parameters for evaluating different response rate scenarios. The report
calculates financial performance for six scenarios, incrementing upward based on your
specified response rate and the response rate increment. For example, if you specify a
response rate of 2% and an increment of 0.25%, the report will return performance data
for six scenarios with response rates ranging from 2% to 3.25%.

You can optionally change parameters in this report, such as cost per contact, offer
fulfillment fixed cost and revenue per response.

Campaign Detailed Offer
Response Breakout

The Campaign Detailed Offer Response Breakout report provides campaign performance
data for offer response types. It lists all offers that are associated with a campaign and
indicates the number of responses for each response type across all channels.

If eMessage offer integration is configured, this report includes information about the
eMessage Link Click response type. Landing Page and SMS Reply Message are not
currently supported. Columns that exist for those response types are not populated by
the ETL process at this time.

Campaign Financial
Summary by Offer
(Actual)

The Campaign Financial Summary by Offer (Actual) report provides financial data for
offers in campaigns. It includes data such as contact costs, gross revenue, net profit, and
ROI.

Campaign Offer
Performance by Month

The Campaign Offer Performance by Month report shows campaign performance for a
specified month with performance data for each offer within the campaign. It lists the
number of offers given, number of response transactions, and response rate for the
specified month.

Campaign Performance
Comparison

The Campaign Performance Comparison report compares the financial performance of
campaigns. It includes data such as response transactions and response rate, number of
unique responders and responder rate. It also includes lift over control group
information, which shows the increase in response compared to the control group.

Campaign Performance
Comparison (with
Revenue)

The Campaign Performance Comparison (with Revenue) report compares the financial
performance of selected campaigns. It includes data such as response transactions,
response rate, number of unique responders, responder rate and actual revenue. It also
includes optional lift over control group information, which shows the increase in
response compared to the control group.

Campaign Performance
Comparison by Initiative

The Campaign Performance Comparison by Initiative report compares the financial
performance of selected campaigns grouped by their initiatives. It includes data such as
response transactions and response rate, number of unique responders and responder
rate. It also includes optional lift over control group information, which shows the
increase in response compared to the control group.

Campaign Performance
Summary by Cell

The Campaign Performance Summary by Cell report provides performance data for
campaigns with cells grouped by the corresponding campaigns. It includes data such as
the number of offers given, number of response transactions, response rate, number of
unique responders and responder rate. It also includes lift over control group
information, which shows the increase in response compared to the control group.

Campaign Performance
Summary by Cell (with
Revenue)

The Campaign Performance Summary by Cell (with Revenue) report provides
performance data for selected campaigns with cells grouped by the corresponding
campaigns. It includes data such as number of offers given, number of response
transactions, response rate, number of unique responders, responder rate and actual
revenue. It also includes optional lift over control group information, which shows the
increase in response compared to the control group.

Note: This report requires the additionally tracked field Revenue in the response history
table.
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Table 17. Performance reports (continued)

Report Description

Campaign Performance
Summary by Cell and
Initiative

The Campaign Performance Summary by Cell and Initiative report provides performance
data for selected campaigns with cells grouped by the corresponding campaigns and
initiatives. It includes data such as number of offers given, number of response
transactions, response rate, number of unique responders and responder rate. It also
includes optional lift over control group information, which shows the increase in
response compared to the control group.

Campaign Performance
Summary by Cell and
Offer

The Campaign Performance Summary by Cell and Offer report provides a way to see
campaign performance by both offer and cell in the same report. Each campaign is listed,
along with each cell and the associated offer names. For each combination of cell and
offer, the report shows the number of offers given, number of response transactions,
response rate, number of unique recipients and responders and responder rate. It also
includes lift over control group information, which shows the increase in response
compared to the control group.

Campaign Performance
Summary by Cell and
Offer (with Revenue)

The Campaign Performance Summary by Cell and Offer (with Revenue) report provides
a way to see campaign performance by both offer and cell in the same report, along with
revenue information. Each campaign is listed, along with each cell and the associated
offer names. For each combination of cell and offer, the report shows the number of
offers given, number of response transactions, response rate, number of unique recipients
and responders and responder rate, plus revenue. It also includes lift over control group
information, which shows the increase in response compared to the control group.

Note: This report requires the additionally tracked field Revenue in the response history
table.

Campaign Performance
Summary by Offer

The Campaign Performance Summary by Offer report provides a summary of campaign
and offer performance with selected offers grouped by the corresponding campaigns. It
includes data such as number of offers given, number of response transactions, response
rate, number of unique responders, and responder rate. It also includes lift over control
group information, which shows the increase in response compared to the control group.

Campaign Performance
Summary by Offer (with
Revenue)

The Campaign Performance Summary by Offer (with Revenue) report provides a
summary of offer performance for selected campaigns. It includes data such as number
of offers given, number of response transactions, response rate, number of unique
responders, responder rate and actual revenue. It also includes optional lift over control
group information, which shows the increase in response compared to the control group.

Offer Performance by
Day

The Offer Performance by Day report shows offer performance for a specified date or
date range. It lists the number of offers given, number of response transactions, and the
response rate during the specified date or date range.

Offer Performance
Comparison

The Offer Performance Comparison report compares the performance of selected offers.
It includes data such as the number of offers given, number of response transactions,
response rate, number of unique responders, and responder rate. It also includes lift over
control group information, which shows the increase in response compared to the control
group.

Offer Performance
Metrics

The Offer Performance Metrics report compares the performance of selected offers based
on various response attributions, such as Best Match, Fractional Match and Multiple
Match. It also includes optional lift over control group information and percentage
differences between various attribution rates.

Offer Performance
Summary by Campaign

The Offer Performance Summary by Campaign report provides a summary of the
performance of selected offers by campaign. It includes data such as number of offers
given, number of response transactions, response rate, number of unique responders, and
responder rate. It also includes lift over control group information, which shows the
increase in response compared to the control group.

Related concepts:
“How to track responses to a campaign” on page 177
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“The Response process” on page 105
“Direct responses” on page 183
“Attribution methods” on page 186
Related tasks:
“Updating response history” on page 106

IBM Cognos report portlets for Campaign
The IBM Cognos report portlets are provided with the Campaign reports package.
Use the report portlets to analyze response rates and campaign effectiveness.

You can enable and then add pre-defined dashboard portlets to any dashboard that
you create. To manage your dashboards and add portlets to them, click Dashboard
> Create Dashboard.

Table 18. IBM Cognos report portlets for Campaign

Report Description

Campaign Return on
Investment
Comparison

An IBM Cognos report that compares, at a high level, the ROI of
campaigns created or updated by the user viewing the report.

Campaign Response
Rate Comparison

An IBM Cognos report that compares the response rates of one or
more campaigns created or updated by the user viewing the report.

Campaign Revenue
Comparison by Offer

An IBM Cognos report that compares the revenue received to date
per campaign containing offers created or updated by the user
viewing the report.

Offer Responses for
Last 7 Days

An IBM Cognos report that compares the number of responses that
were received over the last 7 days based on each offer created or
updated by the user viewing the report.

Offer Response Rate
Comparison

An IBM Cognos report that compares the response rate by offer
created or updated by the user viewing the report.

Offer Response
Breakout

An IBM Cognos report that shows the active offers created or
updated by the user viewing the report, broken out by status.

Campaign list portlets
The standard Campaign list portlets are available for use on dashboards even if the
reports package for Campaign is not installed.

Table 19. Campaign list portlets

Report Description

My Custom
Bookmarks

A list of links to websites or files created by the user viewing the
report.

My Recent
Campaigns

A list of the most recent campaigns created by the user viewing the
report.

My Recent Sessions A list of the most recent sessions created by the user viewing the
report.

Campaign Monitor
Portlet

A list of the campaigns that have run or are currently running that
were created by the user viewing the report.
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Sending reports by email
If your SMTP server is configured to work with Cognos, you can email a report
directly from Campaign.

Before you begin

If you acquired your Cognos license with your IBM products, the option to include
a link to the report is not supported. To use this feature, you must purchase a full
license for Cognos.

Procedure
1. After the report has finished running, click Keep this version in the Reports

toolbar and select Email Report from the list. You see the Set the email options
page, where you specify the recipients and optional message text.

2. To send the report as an attachment in the email message, select the Attach the
report checkbox and clear the Include a link to the report checkbox.

3. Click OK. The request is sent to your email server.

Re-running reports
Reports are generated against the data source so that they reflect the latest data. If
you believe that the data has changed since the report you want to view was last
run and want to view an up-to-date version, you can re-run the report.
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Appendix A. Special characters in IBM Campaign object
names

Some special characters are not supported in any IBM Campaign object names. In
addition, some objects have specific naming restrictions.

Note: If you pass object names to your database (for example, if you use a user
variable that contains a flowchart name), you must ensure that the object name
contains only characters supported by your particular database. Otherwise, you
will receive a database error.
Related concepts:
“Flowchart workspace overview” on page 25
Related tasks:
“Creating flowcharts” on page 28
Related reference:
“List of Campaign processes” on page 47

Special characters not supported
The following special characters are not supported in the names of campaigns,
flowcharts, folders, offers, offer lists, segments, or sessions.

Table 20. Special characters not supported

Character Description

% Percent

* Asterisk

? Question mark

| Pipe (vertical bar)

: Colon

, Comma

< Less than symbol

> Greater than symbol

& Ampersand

\ Backward slash

/ Forward slash

" Double quotation mark

Tab Tab

Objects with no naming restrictions
The following objects in Campaign have no restrictions for characters used in their
names:
v audience levels (audience level field names have naming restrictions)
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v custom attribute display names (custom attribute internal names have naming
restrictions)

v offer templates

Objects with specific naming restrictions
The following objects in Campaign have specific restrictions on their names:
v Custom attribute internal names (custom attribute display names have no naming

restrictions)
v Audience level field names (audience level names have no naming restrictions)
v Cells
v Derived fields
v User table and field names

For these objects, names must:
v Contain only alphabetic or numeric characters, or the underscore (_) character
v Start with an alphabetic character

For non-Latin-based languages, Campaign supports all the characters that are
supported by the string encoding configured.

Note: Derived field names have additional restrictions. For details, see “Naming
restrictions for derived fields” on page 189.
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Appendix B. Packaging flowchart files for troubleshooting

If you need help from IBM to troubleshoot a flowchart, you can automatically
collect relevant data to send to IBM Technical Support.

Before you begin

Only a user with permissions to edit or run a flowchart can perform this
procedure. If you do not have "View logs" permission, you cannot select the
log-related entries in the selection window.

About this task

Perform this task to package flowchart data files so you can send them to IBM
Technical Support. You can specify which items to include and indicate date ranges
to limit data. The data is written to the folder you choose, and the contents can be
compressed and sent to IBM Technical Support.

Procedure
1. Open a flowchart in Edit mode.
2. Select Admin > Collect Flowchart Data.
3. In the Create Data Package for Troubleshooting window, type a name for the

package or leave the default name. The package name will be used to create a
subfolder in which the selected data items will be written.

4. Click Browse and select the folder where the data package will be saved.
5. Select the items that you want to include in the package or check Select default

items to select all data that is commonly required. Some items, when selected,
may allow additional information to be entered.
For more information, see “Options for packaging flowchart data” on page 236.

6. Click OK to create the package.
7. Send the data package to IBM Technical Support by email or use the method

recommended by your support representative. IBM Technical Support accepts
uncompressed data (the entire package subdirectory), but you may optionally
compress, encrypt, and package the files into a single file before sending them.

Results

In addition to the data items you select, Campaign creates a summary file that
identifies:
v Current date and time
v Version and build numbers of the software
v Your user name
v The selections that you included in the package
v Campaign name and ID
v Flowchart name and ID
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Options for packaging flowchart data
Select Admin > Collect Flowchart Data to package flowchart files to send to IBM
Technical Support. When prompted, specify the options described in this topic.

Table 21. Options for packaging flowchart data

Item Description of what is included Additional specifications you may set

Select Default Items
check box

All data commonly required for
troubleshooting flowcharts, including all of
the listed items except log files and the
contents of the user table and contact history
table.

Flowchart The flowchart .ses file. Include run results? Optionally include or
exclude the runtime data files, also called the
"underscore" files.

Flowchart Log The flowchart .log file. Optionally set start and end time stamps. If
you do not set them, the default is the entire
log file.

Listener Log The unica_aclsnr.log file. Optionally set start and end time stamps. If
you do not set them, the default is the entire
log file.

Startup Log The AC_sess.log file. Optionally set start and end time stamps. If
you do not set them, the default is the entire
log file.

Web Message Log The AC_web.log file. Optionally set start and end time stamps. If
you do not set them, the default is the entire
log file.

Campaign
Configuration

The .config file, which lists configuration
properties and settings from your Campaign
environment to assist in troubleshooting the
flowchart.

Campaign Custom
Attributes

The customcampaignattributes.dat file,
which lists attribute name and value pairs
for Campaign custom attributes. Only entries
related to the current campaign are included.

Cell Custom
Attributes

The customcellattributes.dat file, which
lists attribute name and value pairs for
Campaign cell custom attributes. Only
entries related to the current campaign are
included.

Offer Definitions All rows are included for each of the
following offer-related system
tables:UA_AttributeDef.dat, UA_Folder.dat,
UA_Offer.dat, UA_OfferAttribute.dat,
UA_OfferList.dat, UA_OfferListMember.dat,
UA_OfferTemplate.dat,
UA_OfferTemplAttr.dat,
UA_OfferToProduct.dat, UA_Product.dat,
UA_ProductIndex.dat

Target Cell
Spreadsheet Data

The targetcellspreadsheet.dat file, which
includes data from UA_TargetCells for the
entire target cell spreadsheet. Includes data
for the current campaign, in
column/row-delimited text format.
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Table 21. Options for packaging flowchart data (continued)

Item Description of what is included Additional specifications you may set

Custom Macro
Definitions

The custommacros.dat file, which includes
the following fields from UA_CustomMacros,
in column/row format: Name, FolderID,
Description, Expression, ExpressionType,
DataScrName, DataVarType, DataVarNBytes,
CreateDate, CreatedBy, UpdateDate,
UPdateBy, PolicyIS, ACLID

System Table
Mapping

The systablemapping.xml file. Includes all
system table mappings, including the data
source.

+ Include System
Table Contents

When you select this option, it expands to
list all system tables.

Select each system table to include. The
entire table will be included (all rows and all
columns).

If you do not select any sub-options, the
package will not include any system tables.

+ Include Contact
History Tables

When you select this option, it expands to
show the contact history and detailed
contact history tables for each audience level.

For each set you select, the package will
include the contact history and detailed
contact history records for that audience
level.

You can optionally set start and end time
stamps. If you do not set them, the default is
all records.

If you do not select a suboption, the package
will not contain any contact history table
information.

+ Include Response
History Tables

When you select this option, it expands to
show response history tables for all audience
levels.

For each table you select, the package will
include the response history records for that
audience level.

For each table you select, you can optionally
set start and end time stamps. If you do not
set them, the default is all records.

If you do not select a table, the package will
not contain any response history table
information.

+ Include User Table
Contents

When you select this option, it expands to
show the user table contents that you can
select for the package.

Select the user tables from the flowchart to
include.

If you do not select any, the package will not
include any user table contents.

For each user table that you select, you can
optionally set maximum number of rows to
include. If you do not set a maximum
number of rows, the package will include
the entire table.

+ Include Strategic
Segments

When you select this option, it expands to
show all the strategic segments that you can
select for the package.

Select the segment data for each strategic
segment from the flowchart that you want to
include.
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Table 21. Options for packaging flowchart data (continued)

Item Description of what is included Additional specifications you may set

+ Include Stack Trace
Files

Option available for Unix versions only.
When you select this option, it expands to
show the list of stack trace files (*.stack) in
the same directory as unica_aclsnr.log.

Select the stack trace files that you want to
include in the package. If you do not select
any suboptions, the package will not include
any stack trace files.
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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